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Welcome to
Exact Globe Next!

This guide provides the information you need to work effectively with Exact Globe Next.
Itis part of the series of user guides for Exact Globe Next. The goal of this documentation
is to help you to get quickly acquainted with the product and the possibilities it offers. It
will help all users, especially those without much experience with our software, to get
started with and benefit from the product straightaway. Exact Globe Next is an integrated
software solution; its modules of related business processes function together in an
integrated manner. Besides the user guides, there are several information sources, related
to the software, available to you. You can access online help documents on Exact Globe
Next functionalities while working with the software by just pressing the F1 key. The list
of help documentalso contains release notes related to the product. They inform you of the
improvements and functional additions in the various releases of the product.

You can also access the help documents, release notes and other related documents online
through the Exact Customer Portal on www.exact.com. The Customer Portal is a protected
part of the Exact Software internet site, which has been specially developed to provide you
with information and to help you get the maximum yield from your software. This portal
informs you about our contacts, downloads, FAQs, and the latest product news. We invite
you to use the portal as often as you wish!

Thank you for using Exact Globe Next and this user guide!




Introduction

Exact Globe Next enables you to direct the production process centrally. The information system monitors
planning, production, and stock regardless of whether you make to order, contract out subprocesses, or work
with various Bills of Materials and production scenarios. Information is stored and linked in a single central
database - from purchasing and logistics to cost price calculation and MRP. Orders are automatically processed
in your logistics and financial accounts. Reports are based on current, complete information.

The Master Production Planning is based on real-time company information and shows the machines,
methods, employees, materials, and means you need on a project-by-project basis. A single screen contains
information on resource availability and reservations. From the planning, you can click directly through to
underlying information.

Bills of Materials (BOM) and price management give you control over product versions. A BOM also contains
an active link between all information and underlying entities, such as delivery times, price lists for raw
materials and semi-finished products, and price agreements with suppliers.

Stock management provides real-time insight into your stock levels, with direct updates on purchases and
sales. Linking it to the Master Production Planning allows your purchasing staff to see which materials and raw
materials are required in order to guarantee continuity at any given moment.

This user manual will cover the following chapters:
—  Chapter 1: Setting Up

—  Chapter 2: Cost Calculation

—  Chapter 3: Materials Management

—  Chapter 4: Planning

—  Chapter 5: Production Management

—  Chapter 6: Management Information
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1 SettingUp

Setting up is a must prior to using Exact Globe Next. Before you can actually process any information, you
must first define the relevant settings and master data which will serve as the backbone for your business
processes. The settings and master data in your administration reflect the policies, work procedures, products,
and businesses of your company, its internal and external legislations, and the methods of your company’s
business processes. It is important that a one-time setting up is done with careful selections in your central
administration as this will standardize the entire business process for all users within your company.
Setting up administrative configurations and master data enables users to use Exact Globe Next effectively. The
following are the system settings and master data relevant to Manufacturing:

- Manufacturing settings

—  Numbers settings

— Documents settings

- General ledger settings

—  Projectsettings

- Creating and maintaining items

- Creating and maintaining labor hour items

- Creating and maintaining machine hour items

-  Creating and maintaining extra charges items

- Creating and maintaining outsourced items

- Creating and maintaining operations

-  Creating and maintaining BOMs (Bills of Materials)

- Creating and maintaining scenarios

—  Creating and maintaining reason codes




1.1  Manufacturing Settings

Before using the Manufacturing module, you must first define the manufacturing settings to standardize the
business processes involved in the manufacturing environment. To define the settings, go to System > General
> Settings, and then click Manufacturing settings.

Manufacturing settings
[ Gonere!
[Default wip method
Use production result =2
GL for extra material issue | Production waste |- |
Production order
s
Use authorise = Release: Required I~
Print: Required I Use finish I~
. Print
Receipt labels - Use multiple layouts N
Backflush
v
Items I~ Machine hours W
Labour hours I By-products r
Planning Person | Hour planning |
ﬂ Material: Allocation
Allocate: on | None |+ |
Automatic allocation method | Allocation |v |
Allocation: Copy project -
Operations
s
Operations =
Percentage complete calculation basis | Hours realized |v |
Remaining hours calculation basis | Estimates |v |
Recalculate APP
s
Receipts: Recalculate APP Il
Engi ing change
s
Use engineering change management = Generate project r
Engineering change for new BOM -
[ - x

General section

Default WIP method

Select the work in progress (WIP) method you want to use in the manufacturing environment for production
costing. Select one of the following:

—  Production — Select this option to use the WIP method in production costing. This means the WIP
general ledger account will be used to record actual issues or receive financial transactions during the
production process.

- No: WIP — Select this option if you do not want to use the WIP method in production costing. This
means all the actual issues or financial transactions received will be recorded directly in the production cost
general ledger account.
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Use production result

Select this check box to use the production result general ledger account to book the balance of the production
cost, revenue, and waste general ledger accounts. If this check box is not selected, the production result general
ledger account will not be used when the production is completed. Therefore, the balance of the production
cost, revenue, and waste general ledger accounts will remain in the three accounts.

GL for extra material issue

Select Production cost to book the extra issue of material costs to the production cost G/L account or
Production waste to book the extra issue of material costs to the production waste G/L account.

Production order status section

Use authorise

Select this check box to enable the authorization of production orders before the orders are released and
printed. When this check box is selected, the authorization of production orders is mandatory in the
production order process. If this check box is not selected, the production orders can be released and printed
withoutauthorization.

Print: Required

Select this check box to ensure that every production order is printed after it has been released. When this
check box is selected, the printing of production orders is mandatory in the production order process. If this
check box is not selected, the printing of production orders is not required.

Release: Required

Select this check box to enable the release of production orders before the orders can be printed. When this
check box is selected, the release of production orders is mandatory in the production order process. If this
check box is not selected, the production orders can be printed without being released.

Use finish
Select this check box to require production orders to be set to the Finished status before they can be
completed.

Print section

Receipt labels
Select this check box to print labels after receiving production items.




Use multiple layouts

Select this check box to enable the printing of production orders in multiple layouts. For example, you can
print production orders with different layouts for the production floor, production planning, and warehouse.
In addition to this, you can also print more than one copy of the same layout.

If you enable this function, you can maintain the multiple layouts linked to specific collective layouts via
System—>Logistics = Layouts - Multiple layouts for production sheets. This menu path will not be available if
this check box is not selected.

When this check box is selected, the Collective layout field will be available for you to specify a multiple
layout in the Print: Production order screen during the printing or processing of the production orders.

Backflush section

Backflushing is defined as an automatic issuance or realization of components, parts, and hours used to produce
an end product. Thus, manual realization is not necessary when making extra receipts of the end product.

Items

Select this check box to enable backflushing of items during extra receipts of finished goods. This will set the
standard items to backflush automatically in the BOM maintenance for an end product (manufactured or make
item).

Machine hours

Select this check box to enable backflushing of machine hours during extra receipts of finished goods. This
will set the machine hour items to backflush automatically in the BOM maintenance for an end product
(manufactured or make item).

Labor hours

Select this check box to enable backflushing of labor hours during extra receipts of finished goods. This will set
the labor hour items to backflush automatically in the BOM maintenance for an end product (manufactured or
make item).

By-products

Select this to enable the selection of check boxes in both the Backflush and By-product columns under the
BOM tab in the BOMs maintenance screen and the Production orders entry screen.

Planning section

Planning Person
This is the default phantom person used to perform unlimited labor hour planning and realization in projects
and manufacturing. By default, the ID of the phantom person is set to “-3”.
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Material: Allocation section
Allocate: on

Select one of the following options to perform the automatic allocation of materials for production orders:

- None — Select this option if you do not wish to perform the allocation of materials automatically.

- Authorised — Select this option to automatically allocate materials when the production order is
authorised.

- Released — Select this option to automatically allocate materials when the production order is released.

Automatic allocation method
Select one of the following methods to perform the automatic allocation of materials for production orders:

- Allocation — Select this option to perform automatic stock allocation only. By default, this option is

selected.
-  Enrichment — Select this option to perform automatic stock allocation together with the automatic
enrichment method.

The automatic stock enrichment functionality is enabled only when you select Enrichment at Automatic
allocation method, and when you select the Check stock check box in the Fulfillment section under Order
settings. With automatic enrichment, the serial or batch numbers, as well as warehouse locations, will be
assigned during the authorization or issuance of production orders based on the option selected at

Allocate: on.

Operations section

Operations

Select this check box to enable the Operations functionality within the Manufacturing module. If this
function is enabled, you can create and maintain the operations that are used to produce the finished goods at
Manufacturing - Setup - Operations. This menu path will not be available if this check box is not selected. By
selecting the Operations check box, the Manufacturing - Entries - Operations menu path will be enabled.

Percentage complete calculation basis
Select Manually, Hours realized, or Operation quantity completed to define how the percentages of
completion for operations are calculated. This field is enabled only if the Operations check box is selected.

Remaining hours calculation basis
Select Estimates or Actuals to define how the remaining set up and labor hours for operations are calculated.
This field is enabled only if the Operations check box is selected.




Recalculate APP section

Receipts: Recalculate APP
Select this check box to enable recalculation of the average purchase price of the end product by dividing the
total stock value with the total quantity of the stock at the completion of a production order.

€ngineering change section

Use engineering change management

Select this check box to enable the engineering change management (ECM) functionality within the
Manufacturing module. This will enable the Manufacturing - Entries > Engineering change menu path.
With this function enabled, any changes to the existing BOM will create an ECM activity workflow. This
workflow will need to be approved or rejected. In addition, a Microsoft Excel report will be created to record the
changes in the BOM. The BOM which is undergoing changes and pending for approval cannot be used to create
a production order.

Engineering change for new BOM
Select this check box to use the ECM function via Manufacturing - Entries - Engineering change to create a
BOM. This check box is enabled when you select the Use engineering change management check box.

Generate project
Select this check box to generate an internal project whenever there is an engineering change in the BOM.
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1.2  Numbers Settings

You can define default numbers for various orders created in Exact Globe Next under Numbers settings. You
can configure a pattern of numbers as a starting sequence number for the various applications, such as financial
journals, financial accounts, and logistics orders such as quotations, sales orders, delivery notes, interbranch
transfers, invoices, purchase orders, production orders, RMA, and RTV orders.

Before using the Manufacturing module, you must define a starting sequence number, which will be used by
default when you are creating production orders. You can still create production orders without defining the
default sequence number, but you will then be required to type in the production order numbers manually
whilst creating the production orders.

You can define the numbers for production orders in the Logistics section at System = General - Settings,
under Numbers settings.

Numbers settings
ﬂ General
|Use external numbering |7|
ﬂ Financial
First Free Last Qty. free
General/Cash/Bank journal /10000001 | | 10000788 | | 10010001 | | 9214 | g
Purchase journal | 20000001 | | 20000034 | | 20010001 | | 9968 | g
ﬂ Accounts
Range: Start | |
Range: End | |
ﬂ Logistics
Quotation number | 40007 | [T ©Order number
Sales order number | 20066 |
Recurring sales arder number | 29001 |
Delivery note number | 10034 |
Interbranch transfer number | 15004 | [T Delivery note number
Invoice number | 1 |
Purchase order number | 50033 |
Blanket purchase order number | 55001 |
Blanket sales order number 25001
» Production order number PROD | | 1
» Kanban order number KANB | | 1
RMA order number 22002
RTV order number | 52003 |
Group internal use number | 27000 |
Allow change entry number ¥




Production order number
Type the default prefix for production orders in the first box using up to four alphanumeric characters. Type the

starting number for the production order sequence number in the second box using up to eight digits. When
creating a production order, the running sequence number will start from this number.

Kanban order number

Type the default prefix for kanban orders in the first box using up to four alphanumeric characters. Type the
starting number for the kanban order sequence number in the second box using up to eight digits. When
creating a kanban order, the running sequence number will start from this number.
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1.3  Documents Settings

Whenever a process is executed, there will be documents printed as an output of the process. Printouts are

a form of acknowledgement that the process has taken place and that the content details have been verified.
Printouts also serve the purpose of confirming various requests and transactions. These printouts are kept for
black and white distribution or filed for future reference.

In manufacturing, a production order confirmation document will be printed out upon processing the
production order, which takes place after the authorization. It is important that this production order
confirmation document contains all relevant and important information so that a valid acknowledgement and
confirmation can take place amongstall parties involved.

When operations are specified within a BOM for a make item and a production order is quoted for that
particular make item, you can record the progressive status of every operation which is taking place within the
production order. You can also print the operation slips for the production order which contain instructions
for each process step, hours, and materials involved for each operation. The operation slips serve as information
to the production floor personnel who are coordinating the production process for each operation.

You can define layouts and select a default document layout for the production order confirmation documents
and the operation slip documents at System - General>Settings, under Documents settings. Therefore,
every time you process a production order or print an operation slip for a production order, the selected
default document layout, which contains all relevant data fields for the contents of the production order or the
operation slip, will be used when printing and processing.

Doc settings |
0] s ot
[store attachment as FOF [+ Item labels | ttem labels | &
PDF generator Purchase order | Bestelbon ‘ = gj
Covering letter (Format) Blanket SO | ‘ =
B Financial Blanket PO | | &
Receipt | ‘ A
Reminder | Debiteur herinnering layout 1 | ) T | Recipobel ‘ a
Debtor labels | Debtor labels | & =
= Returns: Supplier | Return ‘ A
Creditor labels | Creditor labels | A R S o | e ‘ A
Debtor statements | | A .
IBT delivery note | Interbranch Transfer Note ‘ A
B Cash flow Confirmation | orderbevestiging | & 5
RMA order confirmation | Confirmation ‘ A
Payment | | A . -
Payment specification | Payment specification | @l L_ﬂ Pieking st | Pk it ‘ £
. Collective picking list | Collective pick list \ A
Recelps | | £ Ifill Ifill
R | | a Fulfillment IFu illment } A
Delivery note Pakbon A %I
ﬂ CRM Invoice | Factuur layout ‘ A %I
Quotations | Offerte | A FirEE Az | ‘ a
Letter P Credit note [ =]
Direct credit note | ‘ A
B HRM
POS | Pos | &8
Payroll slips | Layout 5 | & %  POS (Receints) [ | &8
Jaaropgaven | | A Giro collection slips | Giro collection slip ‘ A
Arbeidsovereenkomst | | A Returns: Customer | Return ‘ A
People labels | Resource label | A Production order | Production order ‘ A
Letter & Operation | Operation Slip ‘ A
u PR Receipt labels: Production | ‘ A
Service slips Service order | A




Production order
click & to display the Layout screen. Select an appropriate document layout for the production order and click
Select.

Operation
Click @ to display the Layout screen. Select an appropriate document layout for the operation slip and click
Select.

Receipt labels: Production
Click \“% to display the Layout screen. Select an appropriate document layout for the receipt labels and click
Select.

1.4  General Ledger Settings

Before using Exact Globe Next, you must configure the settings for the financial and logistics entries, and

assign the relevant general ledgers and journals to various financial and logistics transactions according to your
company’s conduct of business (internal requirements), and also according to the country’s legislation (external
requirements).

To use the Manufacturing module effectively, you must take into account the various transactions that take
place during the production of an end product, such as the production cost, production revenue, production
results or profit, production waste, production scrap, and costs incurred during work in progress. To do this,
you need to assign the relevant general ledger accounts and journals to the settings for production at System >
General > Settings, under General ledger settings.

When you are processing the production order, issuing items to the production order, recording the work in
progress for the production order, receiving the end products from the production order, and finally completing
the production order, the amount incurred will be recorded in the journals and general ledger accounts which
you have configured in General ledger settings.

Later, when you make inquiries on the production order reports, production order actuals reports, pegging
reports, and others, the amount recorded in these general ledger accounts and journals will be reflected in the
reports. Therefore, you can distinguish the information in relation to the planning, actual, costs, revenue,
profit, waste, scrap, and work in progress percentages.




Chapter 1| Setting Up

General ledger section

General led settings

B G | ledger
Payment differences W Landed costs | @l ‘
Calculation differences W Bank costs | 9300 @lﬂankknaen ‘
» Accruals and prepayments \ 9300 @|Banklmsten \ 1 Production : Costs | 7510 @|onst of pmduain(
» Euro calc dif (Debit) \ 9300 &, R ion : [ 500 [ [Revenue :Produc
» Invoices / items to be received \ 9300 (3] [Bankkosten | J Production : Waste [ 7520 (@ [waste |
» Suspense account : Logistics \ 012 (3] [EPF | 1 Praduction : Results [ 9500 (3] [Production Resulf
[Production : wIP [ &l |
Production: Scrap | @l ‘
B Journal
» Sales invoice \ 70 (3 |Verkoopboek | Project (Realizations) [ 50 [ |General journal |
» Cash journal (POS/Direct invoices) 10 (3 |Kasbosk | 1 Depreciation [ 50 [ |General journal |
» Itemn transactions ‘ 90 @lMemnaal ‘ | work in progress | 50 @lGeneml journal ‘
Purchase journal (Electronic invoicing) ‘ @l ‘ |

o |_sole | e |

Production : Costs
Type or select a general ledger account of type Profit & Loss to record the production cost, such as the cost of
materials and hours which incur when issuing materials to the production order.

Production: Revenue
Type or select a general ledger account of type Profit & Loss to record the production revenue when receiving
the finished goods from the production order.

Production : Waste
Type or select a general ledger account of type Profit & Loss to record the cost of production waste when items
are rejected in the production order.

Production : Results

Type or select a general ledger account of type Profit & Loss to record the final results of the production order
whereby it balances the Production : Costs, Production : Revenue, and Production : Waste accounts when
the production order is completed.

Production: WIP

Type or select a general ledger account of type Profit & Loss to record the production cost and production
revenue when the production order is in progress. Upon completion of the production order, the recorded
production cost and production revenue will be transferred to the Production : Costs general ledger account
and Production : Revenue general ledger account.

Production: Scrap

Type or select a general ledger account of type Profit & Loss to record the cost of production scrap which
incurs during the production process. Scrap is a form of waste material which is not planned for in the
production order.




Journal section

Work in progress

Type or select ajournal to record the financial entries when you generate work in progress amount for the
production order project.

1.5 Project Settings

Project settings allow you to define the settings for the Projects module. In relation to the Manufacturing
module, the Work In Progress (WIP) method determines how cost is recorded for the production

orders, provided the production orders are treated as projects within Exact Globe Next. If you select the
Generate project check box in the Engineering change section at System - General -> Settings, under
Manufacturing settings, then a production project will be created in the Projects module every time a
production order is created. This production project will serve to monitor and manage the production order.

In this case, you can opt to register the work in progress amount for production orders by selecting the
appropriate option at Default WIP method in the General section, at System > General - Settings, under
Manufacturing settings. If you select Production at Default WIP method, you have to determine whether
to consume the revenue or cost of budgets, actuals, or forecasts for the production orders by selecting the
appropriate method in Project settings. The WIP method you choose in Projects settings will be the default
WIP method used to record the progressive work of production orders by including or excluding certain figures
of amount of the production orders using a certain formula and calculation.

To record the work in progress amount for production orders, select a default WIP method at WIP method in
the WIP method section at System > General - Settings, under Project settings.

WIP method section

Select one of the following WIP methods:

- Percentage of completion cost recognition (POCCR) — Select this method if the production
project is by the order of third parties and remains active for several financial periods. The profit is
calculated proportionate to the actual realization of work. In order to take into account the WP for
several production projects for a specific period of time and to determine the changes to the WIP, you
must determine the percentage of completion based on the cost of actual realization and forecast for the
production project.

- Percentage of completion revenue recognition (POCRR) — This method is similar to POCCR except
that the WIP is based on the revenue of the production project. You must determine the percentage of
completion based on the revenue of actual realization and forecast for the production project.
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Completed contract method — This method is also known as the zero profit method. Select this
method if the production projectis executed by order of third parties. The profitis determined once the
production project is completed. In order to take into account the WP for several production projects

in a specific period of time, the revenue should be recognized to the extent of recoverable expenses. The
outcome of some production projects cannot be estimated reliably but it is possible to expect the overall
project to be profitable. If the production project is not completed, the profit and loss amount will not be
included in the financial results. Upon generating the WIP using this method, the profit and loss statement
for the production project should show zero results. When the production projectis completed, the

WIP and the project results will be released. The percentage of completion in this method is based on the
revenue of actual realization and forecast. However, the forecast value is not used in the WIP calculation.
No : WIP — Select this method if you do not want to use any WIP method to calculate the profit of the
project. By selecting this, the corresponding production projects will not be listed in the Projects module
at Projects - Projects » Work in progress.

To be invoiced — Select this method if the production project often has changes in pricing. Selecting
this method allows you to register the differences in pricing whenever there is a change of price for the
production project. The new WIP entry will provide the outstanding billable amount to the customer
and an overview of the amount that has to be invoiced. The WIP calculation is based on the realized hours
that are Authorised but yet to be invoiced (invoice not processed), and multiplied by a sales rate. The
percentage of completion is not applicable and forecast value is not used in this method. The rates used are
based on the project rate structure.

Percentage of completion cost recognition (budget) (POCCR budget) — This method is similar

to POCCR but the percentage of completion is based on the actual and budgeted cost of the production
project.

Percentage of completion revenue recognition (budget) (POCRR budget) — This method is
similar to POCRR but the percentage of completion is based on the actual and budgeted revenue of the
production project.

WIP cost and revenue transfer — Select this method to book the WIP revenue and WIP cost to the
balance sheet accounts. When the project has completed, the WIP revenue and WIP cost can be released as
generated WIP revenue and WIP cost to the profit & loss accounts.

WIP cost and revenue — Unlike WIP cost and revenue transfer, this method does not transfer costs
and revenues to the WIP accounts. Instead, the original cost and revenue general ledgers will be adjusted.
This allows you to have an insight to the work in progress position based on the original cost and revenue
accounts.

Note: The POCCR budget and POCRR budget WIP methods are available only if you have
the SE1050 E-Budget license in Exact Globe Next. If you select any WIP method other
than POCCR or POCRR, you will see Percentage complete next to Status in the
MRP section. Type the percentage of completion of the production project at Percentage
complete. You can type a numeric value from “0.00” to “100.00”.




1.6 Creating and Maintaining Items

Items are used extensively in Exact Globe Next. Items can be raw materials, products, or services thata company
produces, sells, or purchases. You must define all the standard tangible items ranging from raw materials to end
products that are involved in the manufacturing process.

You can create items by recording basic details of items or services produced, sold, serviced, or purchased.
Information such as cost, sales prices, and linkage of general ledger accounts that record the transactions of
the items when the items are produced, sold, serviced, or purchased can be defined. You can also indicate the
attributes of an item whether the item is for sales, purchase, service, or production.

The following topics are relevant to this section:
— Creating, editing, deleting, and copying items
— Updating item details in batches

— Adding, editing, and deleting suppliers

— Selecting main suppliers

— Adding, editing, and deleting warehouses

— Selecting main warehouses

— Viewing warehouse maintenance

— Transferring items within warehouses

— Viewing item transactions

— Creating and editing serial or batch numbers
— Deleting BOMs and selecting main BOMS

— Editing where-used BOMs

— Replacing where-used items in BOMs

1.6.1 Creatingitems

In order to use the Manufacturing module effectively, you must register the items, such as raw materials, part
items, accessories, subassembly items, and finished products accordingly. To register these various items which
are used in the Manufacturing module, you can create these items and define basic and detailed information
about these items at Manufacturing = Setup = Items, and then by clicking New. Creating items via this

menu path is a must and because this serves as the foundation in order to register these items not only in the
production order but also in the structure of a finished product, such as the Bill of Materials (BOM), which
serves as the primary planning of components in producing an end product.
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#° 001 Ttems - Exact =10ix
File Edit Actions Help

DpE2 400> 8=

Item code | CY01-009 ‘ Type | Standard |+ |
» Description | monitor \ Status |Amve \v|
Search code | CY01-009 \ From | 13/03/2012 E| to | E|

@ Basics |§‘ Purchase/ Sales |lﬂ7 Financial |@mivty |ﬂ Inventory |@5eriaubamh |'1: Manufacturing ||g Doc. |®Ana|ysis |?'g Extra ||;]Lug |

» Sls. unit, Price - & 850.000 |[EUR Picture =
Classification ESL Goods |- Extra description B
Sales VAT code 1 A |BTW 6% exdl. |
Cost price 0.000 |EUR/ -
Markup %
Purchase price 0.000 | EUR / -
Attributes
[fricie ] e I~ oivisise
Market Segment = Text
Target Group B =
Internal products B
Assortiment & B =
Deseription AE

Created:13/3/2012 By:Jeffrey M.andrew  Modified:13/3/2012 By:Jeffrey M.andrew
N N T T L - T x

Item code
Type the code of the item. This box allows up to 30 alphanumeric characters to be filled. This is mandatory.

Description

Type the description of the item. This box allows up to 50 alphanumeric characters to be filled. This is
mandatory.

Search code
Type a search code for the item. This code can be used in the search criteria at Manufacturing - Setup > Items
to search for the item. By default, the search code is automatically defined after the item code is defined.

Type

Select the item type:
—  Standard - Select this type for physical goods or service that can be purchased, sold, or used for service.
— Bulkissue - Select this type for items that are purchased and issued in production in mass volumes.




Status

You can define the status of the item by selecting one of the following options:

—  Active — This option refers to items which can be sold, purchased, manufactured, received, and delivered.
This is the default status.

- Blocked — This option refers to items which can only be used in stock counts, sales, creating BOMs,
budget scenarios, and sales orders but not in fulfilling the sales orders.

- Discontinued — This option refers to items which can be used in stock counts, sales, creating BOMs, and
budget scenarios but not in purchase.

- Inactive — This option refers to items which can only be used in stock counts.

—  Future — This option refers to items which are not yet active.

From, to

Type or select the dates in the From and to fields to define when the status of the item is activated. For example,
if the status of Item A is Active from January 1, 2008 to December 31, 2008, this indicates that [tem A is

active only during the specified period. The to date does not have to be defined unless the validity period of the
inactive, blocked, or discontinued date of the item is known. By default, the From date is based on the current
date.

Basics tab

Sls. unit, Price

Type or select the unit of measurement of the item at Sls. unit, which refers to the sales unit. The unit of
measurement can be created and modified at System - Logistics = Unit. Type the sales price of the item at
Price. The default currency will be shown next to it. The default currency, defined at Default currency in the
Standard section at System > General - Settings, under General settings, cannot be changed once it has
been defined.

Sales VAT code

Type or select the value-added tax (VAT) code if tax is applicable to the item. If the item is not taxable, you can
create a tax code with zero percentage. This is mandatory. You can create and maintain tax codes at System —>
General > Countries = Tax codes.

Cost price
Type the standard cost price of the item. A cost price is usually lower than a sales price so that you have a
positive profit margin.

Markup/Margin

With only the E-Invoice license, Markup will be automatically displayed. The amount in this box will be
automatically calculated by using the markup calculation (gross profit divided by the cost price) and displayed.
This information cannot be edited. If you have the E-Sales Order license, Markup is replaced by Margin if
you have selected Margin at Profit calculation at System = General > Settings, under Order settings. If you
have both the E-Sales Order and E-Invoice licenses, then Markup is displayed.

Purchase price
The amount displayed is derived from the price specified in the Purchase section when you edit the
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information of the item by supplier in the Purchase/ Sales tab. However, if you have last purchased this item
ata price different than the amount stated at Price, the new amount will be displayed. This information cannot
be edited from this box.

Picture

To insert a picture of the item, click [ﬁ Insert. Click [¥ Delete to delete an existing picture. You can only
insert picture with abmp (Bitmap), jpg/jpeg (Joint Photographic Experts Group), or gif (Graphics Interchange
Format) extension.

Extra description

To fill in extra description of the item, click =l Extra description. Every description created is linked to the
Extra item description code. This code can then be linked to a debtor. An extra description is useful if you
want to use a different item description for each debtor. When an invoice is printed for the particular debtor,
the description printed on the invoice will follow the extra description linked for that debtor.

Assortments section

Assortment 1/2/3

Select the assortment(s) that the item is linked to. You can use this function to group or categorize different
types of items that have certain properties in common. With this, you can sort and update groups of items
based on the various assortments assigned.

Attributes section
Text
Select this check box to allow the text entered in the Text section to be displayed under the Long description

column when the item is selected in the invoice. The text will then be printed in quotations, orders, or invoices.

Divisible
Select this check box to allow the entry of the quantity of this item in decimals.



Text section

If you have additional text description for the item, you can type the text description in the box to be displayed
in the Long description column in quotations, orders, or invoices. This additional text will also be printed

in quotations, orders, or invoices (replacing the text entered at Description for the item at Invoice - Items >
Maintain) if the Text check box is selected.

Description NL/FR

Type the description of the item in other languages in the respective boxes, if required. You can type the
description of the item in up to four languages other than the description at Description. For example, you
would type the item description in Dutch at Description NL, and French at Description FR.

Purchase/ Sales tab

Attributes: Sales section

Sales
Select this check box to allow the item to be used in the sales and invoice entries.

No discount
Select this check box if you do not want to give a discount on the item while recording sales and invoices.

Explode - Fulfillment

If the Make check box under the Manufacturing tab is selected, then Explode - Fulfillment represents
the partitems or components registered in the BOM of the main item instead of the item itself at sales order
fulfillment. This attribute activates the possibility to add conditions to the fulfillment of the item. Instead
of having each assembled item on stock, the individual parts are gathered or assembled at the moment of
fulfillment. The individual parts and delivery conditions for the item can be registered in the BOM.




Chapter 1| Setting Up

Service
Select this check box to enable the use of the item in the Service module. This determines whether the item
can be selected in the Service module.

From stock

Select this check box to prohibit users from quoting a higher order quantity than the available quantity in stock

in the sales order entry. Selecting this check box also indicates that the item is not a back-to-back order item and
you will not be allowed to generate sub-orders for an existing production order. If this check box is not selected,
then you can generate sub-orders for the production order and generate back-to-back orders for the production

order.

Sales prices
Click [l sales prices to define the price details of an item, such as the sales price and quantity discount.

Repl. items
Click &' Replacement items to specify replacement item(s) for the particular item and add priorities for the
replacement(s).

Variant
Click ¥ Variant to define the variant item(s) for the particular item and define the relation type for each of the
variant item.

This allows structuring additional accessories to an item that enables the user to select or remove additional
accessories or complimentary items when making entries to a request or activity. For instance, in the sales
order functionality, quoting an item with variants triggers the selection of additional or complimentary items
based on the defined variant structure and conditions.

Attributes: Purchase section

Buy

This check box is automatically selected if you have specified a supplier in the Suppliers section under the
Purchase/ Sales tab. This check box must be selected in order to allow the item to be purchased. If there is no
supplier specified, this check box is not selected and disabled.

Requires approved supplier

Select this check box to allow purchases of the item to be done only from a supplier that has been linked in

the Suppliers section under the Purchase/ Sales tab and has been approved. To approve a supplier, select

a supplier that has been linked to the item, and then click Edit. The Items by supplier screen will then be
displayed. Select the Approved supplier check box and click Save. A green check mark will be displayed under
the Approved supplier column for the approved supplier.

Purchase prices

Click Purchase prices to define the price agreements per supplier, such as the percentage discount and amount
discount. The supplier will automatically be linked and displayed under the Suppliers section in the Purchase/
Sales tab if the supplier selected has not been linked to the item.




Suppliers section

Suppliers linked to the item will be displayed in the Suppliers section. You can link one supplier or more

to the item created and specify a supplier as the main supplier. This function is available when you have the
E-Purchase license. It is also possible to make changes to the details of the items by the supplier such as
changing the supplier, purchase price of the item, and time of delivery for the item by the supplier. Besides this,
you can also remove the supplier linkage from the item. For procedures related to the Suppliers section, see
1.6.6 Related procedures - Suppliers section.

Financial tab
Financial section

Item group

Type or select the item group of the item. Item groups are used to group items for ease of identifying and
managing items, and can be created at System > Logistics = Item groups. When creating an item group, it is
mandatory to specify the revenue and stock accounts for a particular item group. Thus, when an item group is
selected, the Revenue and Stock boxes will be automatically filled in according to the respective general ledger
accounts specified. However, you can select a different general ledger account other than the one indicated.

Revenue

Type or select the general ledger account where the sales revenue will be automatically credited when the
invoice with this item listed is processed. By default, the revenue account specified when creating the item
group selected will be automatically filled in.

Stock

Type or select the general ledger account where the stock will automatically be credited when the item is sold
or fulfilled, and automatically debited when the item is purchased or received. By default, the stock account
specified when creating the item group selected will be automatically filled in.

Cost of goods sold

Type or select the general ledger account where the sales transactions will automatically be debited when the
item is sold or fulfilled, and automatically credited when the item is purchased or received. By default, the cost
of goods sold account specified when creating the item group, which is selected here, will be automatically filled
in.

Assetaccount
Type or select the general ledger account where the logistic transactions for an asset are recorded.

Discount account
Type or select the general ledger account to register the sales discounts provided.




Chapter 1| Setting Up

Valuation method

To define the valuation method for the item, select one of the following options:

- Standard cost price — This method calculates the standard cost price based on the accumulation of
estimated purchase price, estimated direct purchase cost, and certain percentage of indirect purchase
cost. The period differences between the SCP (Standard Cost Price) and the estimated purchase price
development will be booked in the price difference general ledger account.

- Standard cost price (Classic) — This method calculates the cost price of the item by booking the
price differences in the WIP or cost ledger accounts when the manual cost price is used in the BOM and
production order entry cost calculations.

- Average purchase price — This method recalculates the cost price to find the average price between the
purchase price of the received goods and goods on stock.

—  LIFO — This method calculates the cost price based on the accounting principal that the latest received
goods will be delivered first.

—  FIFO — This method calculates the cost price based on the accounting principal that the first received
goods will be delivered first.

- Actual costing — This method calculates the cost of item by obtaining the original purchase price of
the serial or batch item. This option is available only if you select the Serial or Batch check box in the
Attributes section under the Inventory tab of the item maintenance screen.

Attributes section

Assets
This check box is not enabled. However, this check box is automatically selected if the item has asset-related
transactions.

Activity tab

Transactions section
The transaction(s) that matches the defined criteria will be displayed in the Transactions section after you
have clicked Refresh.

Type

Select the type of transactions to display the documents that the item is listed in. The following options are
available:

- Quotation — This option refers to quotations that have been Authorised but not processed.

- Sales order — This option refers to sales orders that have been Authorised or processed.

- Invoices — This option refers to invoices that have been generated, but not processed.

- Sales order history — This option refers to sales orders that have been completed.

- Invoice history — This option refers to invoices that have been processed.




- Production orders —This option refers to production orders that are open, Authorised, released, printed
or processed, and completed.

—  Transfer — This option refers to transfers that have been fulfilled and processed.

- Fulfillment —This option refers to sales orders that have or have not been fulfilled.

- Counts — This option refers to the number of items for each item count entry and warehouse.

—  Purchase order — This option refers to purchase orders that have been Authorised, processed, received,
paid, and completed.

—  Blanket PO — This option refers to blanket purchase orders that have been Authorised, processed,
received, paid, and completed.

—  Blanket order — This option refers to blanket sales orders that have been Authorised or processed.

Status
Select Open or All to display the type of transactions with the selected status.

Warehouse
Click Select and the Warehouses screen will be displayed. Select the relevant warehouse(s), click Select, and
then click Close. The transactions that belong to the selected warehouse(s) will be displayed.

Date : From, to
Type or select a date or a date range to display the transaction(s) created on the selected date(s).

Refresh
Click Refresh to display the results based on the defined criteria.

[ Details
Click [4 Details to view the sales invoices or invoice history depending on the type of transaction selected at

Type.

Inventory tab

Attributes section

Total stock(On hand)
This cannot be edited. Total quantity of stock is automatically displayed by accumulation of stocks from all the
linked warehouses.
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Warehouses section

h

B, - Centraal magazijn ﬂ
]
CH]|
&
@ of

The warehouses which are linked to the item (the warehouses where the item is fulfilled and received) are
displayed in this section. You can also link one warehouse or more to the item and specify one warehouse as the
main warehouse. It is possible to make changes to the items by changing the warehouse information, such as
changing the default location, minimum and maximum stock quantity, counting cycle, order policy code, time
of delivery, and the planner for the item. For procedures related to the Warehouses section, see 1.6.6 Related
procedures - Warehouses section.

Serial/batch tab
The Serial/batch tab is enabled when you select the Serial or Batch check box in the Inventory tab.

Batch/Serial numbers
Select All to display all existing serial or batch numbers for the item. Select Available to display the serial or
batch numbers that are only available in stock.

From, to
Type or select a range of serial numbers to display the serial or batch numbers within the specified range.

Lot number: From, to
Type or select a range of lot numbers to display the serial or batch numbers within the specified range of lot
numbers.

Warehouse
Select a warehouse to display the serial or batch numbers that belong to the selected warehouse. Select All to
display the serial or batch numbers that belong to all warehouses.

Refresh
Click this to display the serial or batch numbers that match the selected criteria.




Serial/batch numbers section

Serial numbers ]

[Warehouse Lot number |[Description  Received [Used |[Reserved avallable |unit |
1] 0 0 0 -
o o o

OFF-551-#005 1 Office Equipment
OFF-554-#007 1 Office Telephanes

1/1/2012  1/12/2012 Active Fixed assets -
0 - 1/1/2012  1/2/2012  Active Fixed assets

You can define serial or batch numbers for the item. You can also make changes to the information of the serial
or batch number which is linked to the item.

For procedures related to the Serial/batch numbers section, see 1.6.6 Related procedures - Serial/batch
numbers section.

Manufacturing tab
Attributes section

Make
Select this check box to indicate that the item is a make item. Hence, the item can be selected as the main item in
the BOM. This can be an end product which is produced and entered in the production order as the main item.

Part

Select this check box to indicate that the item is a part item. Hence, the item can be selected as a component in
the BOM.

Level

This information cannot be edited. By default, this level is set to the highest level of BOM for the item that is
being used in any other BOM. If the item does not have a BOM, then the level is set to “0” by default. If the item
is used in the first level of the BOM, then the level is set to “1”.

BOM section

BOM |

g2 i g
31 23/3/2005 1.00000000 7.000 Active
41 23/3/2005 10.00000000 150.000 Active

B & 6RO

|

All existing BOMs for the item will be displayed in this section. It is possible to create a BOM for the item in this
section. You can also make changes or delete an existing BOM from this section. Besides this, you can seta BOM
as the main BOM for the item, whereby the main BOM will be selected by default in the production order.

For procedures related to the BOM section, see 1.6.6 Related procedures - BOM section.
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Where-used section

The information where the BOM is used is also automatically shown in this tab. The information is basically
the listing of BOMs in which the item has been used as a component. You can edit the other BOMs in which
the item has been used as a component in this section. Besides this, you can also replace the current item in the
other BOMs with a different item in this section.

For procedures related to the Where-used section, see 1.6.6 Related procedures - Where-used section.

Doc. tab
Documents section
The documents created and attached to the item will be displayed in the Documents section.

Group by
Group the documents by None, Type, or Date.

Q- New

Click "= New to attach new documents to the item.

=L Edit
Click = Edit to modify the details of the document or to replace the existing document.

5% Delete
Click =* Delete to delete the selected document.



2 Zoom
Click **% Zoom to zoom in on the underlying document.

Analysis tab

Financial year
By default, the current year is selected to display the logistics information for 12 periods of the selected year.
However, you can select another year to display the logistics information of the selected year.

Extra tab
Extra section

Person
Type or select the ID of the person that handles or uses the item. By default, the person displayed is the person
that created the item.

Free values section

Freevalue 1,2
Two free value boxes are available for additional information (numerical values only) of the item. These values
are mainly used in layouts defined by users.

Free fields section

You can fill in additional information of the item in the free fields defined. The descriptions of free fields can be
changed according to your needs. For example, you can label the field as “Maintenance charges” and fill in the
maintenance cost of the item.
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Log tab
Log section

This section keeps a log of all changes made to the item in the item maintenance, such as the person who
modified the details of the item, the date and time when the modifications were made, and its old and new
values, or details of the item.

1.6.2 Editingitems

Once items have been created, it is possible to make changes to the information of the items, such as changing
the cost or sales prices of the items, adding or removing pictures to or from the items, and other modifications
at the item maintenance.

To edit items:

Go to Manufacturing - Setup > Items.

Select the item to be edited, and then click Open.

In the Items screen, make the necessary changes to the item.
Click Save.

Click Close to exit.

A .

1.6.3 Deletingitems

Itis possible to delete items that have been created. When you do this, the items will be deleted permanently
and cannot be retrieved from the system. [tems that are in use in invoices that have been created or Authorised
cannot be deleted.

To delete items:

1. Go to Manufacturing - Setup = Items.

2. Select the item to be deleted, and then click Delete.

3. Inthe Maintain screen, click Yes to confirm the deletion.
4.

Click Close to exit.




1.6.4 Copyingitems

To create an item which will contain the same details as an existing item, it is possible to copy the details of the
existing item to the new item. This process makes creating an item faster and easier as it saves you time from
filling in the same information all over again.

r; Copy item

>|New; Item code | FRBO0D3 |
» Description | Celsus Max Havelaar fresh brew |
» Search code | FRBMAX |

Supp. item code | FRBO0O3 |
Copy

Attachments -

Extra description |

Suppliers W & Main Al

Warehouse ¥ % Main " all

BOM |

FEN
To copy items:

1. Go to Manufacturing - Setup = Items.

2. Select the item to be copied, and then click Copy.

3. Inthe Copy item screen, type the item code and description of the new item at New: Item code and
Description respectively. These are mandatory. Once the item code is defined, the codes at Search code
and Supp. item code will be automatically defined. Type a new search code if required. The Supp. item
code field is enabled only if the Main supplier check box in the Copy section is selected.

4. Click OK to save the new item code.

In the Items screen, make the necessary changes and click Save.

6. Click Close to exit.

v
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1.6.5 Updating item details in batches

I[tem details can be updated in batches, whereby the details of more than one item can be updated at the same
time. However, this function is used only if you want to update the items with the same details.

(" Stock data (™ Items by supplier
Range
Item code [ @] tof A P al
Attributes I” sales [” Stock [~ Make [~ Buy
[T Part [ Batch [~ Serial
Item group @ to @ ¥ Al
Main warshouse al to El M all
Last sale @| to @| Al
Main supplier &l
Status Active [+ Type Al |~
ype Iv procuctroep o s B
Change
[~ Cost price New value [ Cast price =] + % [~ Status New value | Active 2
[ Item group Newvaue| @] [ Description Newvale[ ]
I~ unit New value €l I Type New value [ Standard |+
IS Stack controlled New value | Ves - I Requires approved supplier  New value
I~ Classification EsL New value - ™ Commissionable New value
= Commission method  New value [ Margin % = 0.00]%
Type |~ ‘ |~ ‘ Sm“‘ [ |
shomtot. ||
e ———

To update item details in batches:

1. Go to Manufacturing - Setup - Items.

2. Click Batch updates. The Update items - Maintain screen will be displayed.

3. Inthe Range section, define the relevant criteria of the items to be updated.

4. Inthe Change section, select one or more check boxes to update the selected details. For example, to
increase the cost price of the items by 10%, select the Cost price check box. The New value, and % fields
will then be enabled. In the New value field, select Cost price, and type “10.00” in the % field.

S. Click Show list and a report of the items to be updated with the new details will be displayed in Microsoft
Excel.

6. InMicrosoft Excel, click '@ Exact Globe Next: Update (under the Add-Ins menu bar) to update the

changes. A message “Save changes?” will then be displayed.

Click OK, and a message “Completed: Update items” will be displayed.

8. Click OK.

N

1.6.6 Related procedures

Suppliers section

To add suppliers to items:

1. Go to Manufacturing - Setup = Items.

2. Select the item that you want to add a supplier to, and then click Open.
3. IntheItems screen, click the Purchase/ Sales tab.

4. Click 5= Add. The Items by supplier screen will be displayed.




v

o N

10.

11.
12.
13.
14.
15.
16.

At Supplier, type or select a supplier for the item. This is mandatory.

Type the code of the item that is used by the supplier at Supp. item code. By default, the item code
defined under the Basics tab of the item maintenance is automatically filled in.

At Warranty period, type the number of days that the item is under warranty.

Type the bar code of the item used by the supplier at Bar code. This field can be left blank.

In the Purchase section at Purchase unit, type or select the unit of measurement of the item that is
purchased from the selected supplier.

Type the purchase price of the item at Price. This amount will be displayed at Purchase price under the
Basics tab.

Type or select the tax code at Tax if tax is applicable to the item.

Type an amount at PO size to specify the minimum purchase order quantity from the supplier at one time.
At Time of delivery, type the number of days that the supplier will take to deliver the items ordered.
At Country of origin, type or select the country where the item comes from.

Click Save to save the changes.

Click Close to exit.

To edit details of items by suppliers:

N Uk wN =

Go to Manufacturing - Setup - Items.

Select the item for which you want to edit the details by supplier, and then click Open.
In the Items screen, click the Purchase/_§ales tab.

Select the supplier to be edited and click =0 Edit.

In the Items by supplier screen, make the necessary changes.

Click Save.

Click Close to exit.

To delete suppliers from items:

S

Go to Manufacturing - Setup - Items.

Select the item that you want to remove its linked supplier from, and then click Open.

In the Items screen, click the Purchase/ Sales tab.

Select the supplier to be removed and click = Delete. A message “Supplier Delete?” will be displayed.
Click Yes to delete the supplier from the item.

Click Close to exit.

To select main suppliers for items:

1.

2.
3.
4

u

Go to Manufacturing - Setup > Items.

Select the item for which you want to select a main supplier, and then click Open.

In the Items screen, click the Purchase/ Sales tab.

Select a supplier, who is E;rently not the main supplier (no green check mark displayed under the Main
sup. column), and click Select: Main supplier. This supplier will then have a green check mark

displayed under the Main sup. column.
Click Save to save the changes.
Click Close to exit.
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Warehouses section

To add warehouses to items:

N Uk wN =

©

10.

11.
12.
13.
14.

Go to Manufacturing - Setup - Items.
Selectan existing item and click Open.

Define the general and basic details of the item and click the Inventory tab.

In the Warehouses section, click “+= New to link a warehouse to the item.

In the Items per warehouse screen, type or select the warehouse at Warehouse. This is mandatory.

Type or select a defaultlocation of the selected warehouse at Default: Location.

In the Stock section, type the minimum purchase order quantity that can be accepted in the warehouse at

Minimum PO level.

Type the maximum quantity of item that can be accepted in the warehouse at Maximum.

Type the number of days for the counting cycle at Counting cycle.

Select how the advice quantity will be calculated for production and purchase at Order policy code.

Selectany one of the following:

- Fixed — This option means the advice quantity is calculated based on the shortage quantity
including batch size (make or production) or PO size (purchase).

- Period order — Selecting this enables the Period field. The advice quantity is calculated based
on the shortage quantity including batch size (production) or PO size (purchase) for the number of
days defined at Period.

- Reorder point — This means the advice quantity is calculated based on the shortage quantity
including batch size (produce) and PO size (purchase), and also including the maximum stock level
per linked main warehouse. Selecting this will require defining the maximum stock level at
Maximum.

In the Sales section, type the number of days that will be taken for delivery at Time of delivery.

Type or select the person who is the planner at the warehouse for the item at Planner.

Click OK to save.

Click Close to exit.

To edit details of items by warehouses:

N Uk wN =

Go to Manufacturing - Setup > Items.

Select the item for which you want to edit the details by warehouse, and click Open.
In the Items screen, click the Inventory tab.

Select the warehouse to be edited and click =& Edit.

In the Items per warehouse screen, make the necessary changes.

Click OK to save and exit from the screen.

Click Close to exit.

To delete warehouses from items:

1.

2.
3.
4

o u

Go to Manufacturing - Setup > Items.

Select the item for which you want to remove its linked warehouse from, and then click Open.

In the Items screen, click the Inventory tab. _

Select the warehouse to be removed and click =® Delete. A message “Deleting a warehouse for this item
will result in recoding of all item transactions to the main warehouse. Continue?” will be displayed.
Click Yes to delete the warehouse from the item.

Click Close to exit.




To select main warehouses for items:

1.

2.
3.
4

Go to Manufacturing - Setup - Items.

Select the item for which you want to select a main warehouse, and then click Open.

In the Items screen, click the Inventory tab.

Select a warehouse, which is currently not the main warehouse (no green check mark displayed in the
Main wrh. column), and click ¥5 Select: Main warehouse. This warehouse will then have a green check
mark displayed under the Main wrh. column.

Click Close to exit.

To view warehouse maintenance:

1.

2.
3.
4

v

Go to Manufacturing = Setup > Items.

Select the item for which you want to view the details of the warehouse, and then click Open.

In the Items screen, click the Inventory tab.

Selecta warehouse, and click Warehouse. The Maintain warehouses screen will be displayed. You can
view the warehouse information, such as address and contact information, warehouse locations, purchase
orders and sales orders in the warehouse, incoming and outgoing logistics transactions, all items linked

to the warehouse, serial and batch numbers linked to the warehouse, and manage roles and rights for the
warehouse.

Click Close to exit from the Maintain warehouses screen.

Click Close to exit.

To transfer items within warehouses:

© 0N Uk wN

12.
13.
14.
15.
16.
17.
18.
19.

Go to Manufacturing - Setup - Items.

Select the item for which you want to transfer within warehouses, and click Open.

In the Items screen, click the Inventory tab.

Click "= Warehouse: Move and the Warehouse transfers screen will be displayed.
Select the relevant warehouses at Issuing warehouse and Receiving warehouse.
Type or select the relevant project code at Project.

Type a description at Description.

Type or select the appropriate dates at Reference date and Fulfillment date.

Select Sales unit or Purchase unit at Unit to indicate the unit of measurement used for the warehouse
transfer.

Under the Item column, type or select the item code (by pressing the F2 key).

. Specify the quantity to be transferred in the Move column. However, if the Warehouse locations option

is used (in the Fulfillment section at System - General - Settings, under Inventory Settings) you must
click '=junder the Loc. column to specify the quantity to be transferred for each listed location. Then,
click OK to return to the Warehouse transfers screen.

Click Save to save the changes.

Click Fulfilled. The Print screen will be displayed.

Define the document layout for the warehouse fulfillment slip at Layout.

Click Start to print the warehouse fulfillment slip.

Click Received and define the document layout for the warehouse receipt slip at Layout.

Click Start to print the warehouse receipt slip.

Click Close to exit from the Warehouse transfers screen.

Click Close to exit.
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To view item transactions:

N R 0N

Go to Manufacturing - Setup > Items.

Select the item for which you want to view the transactions, and click Open.

In the Items screen, click the Inventory tab.

Select a warehouse, and click Lt Item transaction card.

The Item transaction card screen will be displayed, showing the list of financial transactions of the item.
Click Close to exit from the Item transaction card screen.

Click Close to exit.

Serial/batch numbers section

To create serial/batch numbers for items:

N R 0N

10.
11.

12.

13.

14.

15.

16.
17.
18.
19.
20.
21.
22.

Go to Manufacturing - Setup > Items.

Selectan existing item and click Open.

Click the Serial/batch tab.

Click == Add to display the Serial/batch numbers screen.

Type a serial or batch number at Number. This information is mandatory.

Type a description at Description.

To block the serial or batch number from being used in any planning, select the Blocked check box.
Otherwise, clear the check box.

The item code at Item code in the General tab will be automatically pre-filled based on the item code in
the item maintenance.

Type or select alot number at Lot number.

By default, the current date is displayed at Start date. Type or select the relevant date, if required.

The date at End date is left blank by default. Type or select an end date for the serial or batch number, if
required.

By default, the main supplier of the item is selected at Supplier. Type or select another supplier, if
required.

By default, the main warehouse of the item is selected at Warehouse. Type or select another warehouse, if
required.

The location of the item at Location will be pre-filled with the default location in the selected warehouse.
To change to a different location, type or select the appropriate location.

The Quantity received, Quantity used, and Quantity available fields cannot be edited but will
respectively display the received quantity of the serial item as per purchase receipt, the used quantity
of the serial item as per internal use requests, and the available quantity of the serial item as per current
available stock quantity excluding requests such as sales orders quantities that are yet to be delivered.
Click ™= next to Picture to selecta picture for the serial or batch number.

Click 2 next to Notes to type notes to the serial or batch number.

Click & next to Attachment to attach a document to the serial or batch number.

Define extra information for the serial or batch number of the item under the Extra tab.

Click Save to save the defined serial or batch number for the item.

Click Close to exit from the Serial /batch numbers screen.

Click Close to exit.




To edit serial or batch number information for items:

1. Go to Manufacturing - Setup = Items.

2. Selectan existing item, and click Open.

3. Click the Serial /batch tab.

4. Inthe Ser_igl numbers or Batch numbers section, select the serial or batch number that you want to edit,
and click =£ Edit.

5. Inthe Serial/batch numbers screen, make the relevant changes.

6. Click Save.

7. Click Close to exit.

BOM section

To delete BOMs from items:

Gk e

6.

Go to Manufacturing - Setup - Items.

Selectan existing item, and click Open.

Click the Manufacturing tab.

In the BOM section, selecta BOM and click L4 Delete to remove the BOM from the item.

A message “BOM Delete?” will be displayed. Click Yes to delete the BOM, or No to cancel the deletion.
If the BOM that you want to delete is already used in the production, then you cannot delete the BOM. A
message “Can’t delete: In production” will be displayed. Click OK to close the message or E-mail to send
an email of the message to notify the relevant person in charge.

Click Close to exit.

To select main BOM versions for items:

1.

2.
3.
4

Go to Manufacturing - Setup > Items.

Selectan existing item, and click Open.

Click the Manufacturing tab.

In the BOM section, select the relevant BOM and click - Select: Main version to set the selected BOM as
the main BOM version.

Click Close to exit.

Where-used section

To edit where-used BOMs:

NG 0N

Go to Manufacturing - Setup - Items.

Selectan existing item, and click Open.

Click the Manufacturing tab.

In the Where-used section, select a where-used BOM and click @ Edit to display the BOMSs screen.
Make the relevant changes and click Save.

Click Close to exit from the BOMsS screen.

Click Close to exit.
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To replace items in where-used BOMs:

Go to Manufacturing - Setup - Items.

Selectan existing item, and click Open.

Click the Manufacturing tab. .

In the Where-used section, click 3’ Replace.

In the Change data section, type or select the item at Item code. This is mandatory.

Type or select another item at Replacement.

By default, the value at Factor is set to “1”. You may change this to an appropriate factor.

In the BOM section, type or select an item group or a range of item groups at Item group. Select the All

check box to include all item groups.

9. Type or selectan item or a range of items at Item.

10. Click Show list to display the Replace items screen and select the BOM that you want to use to replace
the item.

11. Click Replace to replace the current selected item with the replacement item. A message “Confirm?” will
be displayed. Click Yes to confirm and a message “Delete Part [item code|” will be displayed.

12. Click OK and the Replace - Item: Results screen will be displayed to show results of the replacement
process.

13. Click Close to exit from the Replace items screen.

14. Click Close to exit

O NG

1.7 Creating and Maintaining Labor Hour Iltems

Labor hours are used extensively in production processes. Labor hours are hours taken by the employees of an
organization to execute and complete various tasks related to the production processes. These labor hours must
be recorded and taken into account when issuing or fulfilling the production orders. To record these labor hours
for various tasks, labor hour items can be created in Exact Globe Next.

Exact Globe Next allows you to record labor hour items for various tasks. You can define many kinds of labor
hour items according to the types of tasks being executed in the organization. For example, the tasks executed
by employees, such as planning can be defined as the planning labor hour item, and painting as the painting
labor hour item.

You can create labor hour items by recording details of labor hours, such as price, cost price, sales unit, linking
employees who use the labor hour items, and linking business units from which the labor hours are executed
from.

When the production order is issued or fulfilled, the labor hours are realized by registering the total number of
labor hours taken to complete the task, the cost price, and the total amount incurred in the usage of the total
labor hours. This information is registered in the respective general ledger accounts that you can define in the
labor hour item maintenance under the Financial tab.

The following topics are relevant to this section:
- Creating, editing, recoding, and deleting labor hour items
- Copying labor hour items




1.71 Creating labor hour items

You can create labor hour items at Manufacturing - Setup - Hours.

file Edit Help
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Hour code

Type a code for the labor hour item. This is mandatory.

Description
Type the description for the labor hour item. This is mandatory.

Type

Select Labor hour from the drop-down list.

Status

Select any one of the following status:

—  Active — This status refers to labor hour items that can be used in sales, purchase, or production.

—  Blocked — This status refers to labor hour items that can be used in the BOM structure, but blocked for all
the standard transactions.

— Discontinued — This status refers to labor hour items that can be used in sales and the BOM structure,
but cannot be used in purchase.

—  Inactive — This status refers to labor hour items that cannot be used in logistics, financial transactions,
and in the BOM structure.

—  Future — This status refers to labor hour items used internally and in the future.
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From, to

Type or select the dates in the From and to fields to define when the selected status of the labor hour item is
activated. For example, if the status of the labor hour item is Active from September 1, 2007 to December 31,
2007, this indicates that the labor hour item is in an active status during the specified period. However, itis not
necessary to define the end date unless the inactive or discontinued date of the item is known.

Basics tab
Sales section

Price lists

This is pre-filled with Default(Price list). If there is more than one price list available for the item, then you
can select the price list that you want to use for the labor hour item.

=

4= New

Click this to define the sales price for the labor hour item. In the Sales prices screen, type or select the validity
date range for the specified sales price. Click Save, and then Close to exit. This defined sales price will be filled
under the Price column in the price list table.

=L Edit
Click this to make changes to the sales price of the labor hour item under the Price column in the price list
table.

= Delete
Click this to delete the selected sales price for the labor hour item.

Taxes
Type or select the tax code thatapplies to the labor hour item. This tax will be used in the cost calculation for
the labor hour item during production issue or fulfillment.

Cost price
Type the cost price of the labor hour item.

Sales unit
Type or select the sales unit of measurement for the labor hour item.




Assortments section

Assortment 1/2/3

Select the assortment(s) that the labor hour item is linked to. You can use this function to group or categorize
different types of labor hour items that have certain properties in common. With this, you can sort and update
groups of labor hour items based on the various assortments assigned.

Business unit section

When you create a labor hour item and click Save, the main business unit (warehouse) will be automatically
added to the business units for the labor hour item. You can still add, make changes, and delete the business
units (warehouse) using the following buttons:

=
= New

Click this to add a new business unit (warehouse) for the labor hour item.

=L Edit

Click this to make changes to the selected business unit (warehouse) of the labor hour item.

=¥ Delete
Click this to delete the selected business unit (warehouse) of the labor hour item.

Project (Where-used) section

This section will display the projects that use the labor hour item. This section is available only if you have the
Projects module in your Exact Globe Next license.

=L Edit
Click this to make changes to the project which is linked to the labor hour item.

L5 Project card
Click this to display the financial transaction card of the selected project which is linked to the labor hour item.

Text section

Text
Type the extra description of the labor hour item.
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Description NL/DE

You can type descriptions of the labor hour item in up to a maximum of four other languages. These languages
are set in the Description in list boxes section at System - General > Settings, under General settings. In
this example, you would type the description in English at Text, in Dutch at Description NL and in German at
Description DE.

People tab

In the People tab, you can link people who are using the labor hour item to execute their tasks to the labor hour
item. You can link as many people to the labor hour item as required.

=

= Add

Click this to link a person to the labor hour item. Select a person and click Select to link the selected person to
the labor hour item.

>
* Add:All
Click this to link all available people to the labor hour item.

= Edit
Click this to make changes to details of the people. You can make changes to the details such as Purchase unit,

Currency, Price, PO size, and Country of origin.

=
= Delete
Click this to remove the selected person from the labor hour item.

5= Person Card
Click this to display the financial transactions of the corresponding person.

1.7.2 €&diting labor hour items

Once the labor hour items have been created, it is possible to make changes to the information of the labor hour
items, such as changing the cost and sales prices, adding or removing business units to or from the labor hour
items, and other modifications in the labor hour item maintenance.

To edit labor hour items:

Go to Manufacturing - Setup - Hours.

Select the labor hour item to be edited, and then click Open.
In the Hours screen, make the necessary changes to the item.
Click Save.

Click Close to exit.

1.
2.
3.
4.
S.




1.7.3 Recoding labor hour items

Once the item has been defined and saved, it is not possible for you to make changes to the labor hour item
code. With the Recoding functionality, it is now possible for you to rename (recode) the labor hour item code.
Changes to the labor hour item code can only be done with the Recode button at Manufacturing - Setup >
Hours.

To recode labor hour items:

1. Go to Manufacturing = Setup = Hours.

2. Select the labor hour item to recode, and then click Recode. A message “This process may take some time.
Continue?” will be displayed. Click Yes to continue and the Recode screen will be displayed.

3. Next, type the new code at New and click Recode to recode the labor hour item code.

Upon completion, a message “Completed successfully: Recode” will be displayed. Click OK.

5. Click Close to exit.

ha

1.7.4  Deleting labor hour items

Itis possible to delete a labor hour item that has been created, provided that the labor hour item is not in use in
any pending logistics and financial transactions. If the item is in use, then it is not possible to delete the labor
hour item until you clear the pending transactions. Once the labor hour item is deleted, then it is not possible to
retrieve the labor hour item from the system.

To delete labor hour items:

1. Go to Manufacturing - Setup = Items.

2. Select the item to be deleted, and then click Delete. A message “Depending on the size of the company,
this function may take a long time because all files will be checked. Delete?” will be displayed in the Hours
box. Click Yes to delete the item.

3. Theresult of the process will be displayed in the Delete: Hours screen. Click Print to print the displayed
results.

4. Click Close to exit.

1.7.5 Copying labor hour items

To create a labor hour item which contains the same details as an existing labor hour item, it is possible for you
to copy the details of an existing labor hour item to create another labor hour item. This process makes creating
alabor hour item faster and easier as it saves you time from filling in the same information all over again.

To copy labor hour items:

1. Go to Manufacturing - Setup = Hours.

2. Select the labor hour item to be copied, and then click Copy.

3. Inthe Hours - Copy screen, type the labor hour item code and description for the new labor hour item at
New: Item code and Description respectively. These are mandatory. Once the new labor hour item code
is defined, the code at Search code will be automatically defined. Type a new search code, if required.

In the Copy section, select the check boxes to copy the selected information to the new labor hour item.
Click OK to save the new labor hour item code.

In the Hours screen, make the necessary changes.

Click Save.

Click Close to exit.

4.
S.
6.
7.
8.
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1.8 Creating and Maintaining Machine Hour Items

Machine hours are hours that are taken up by machines to execute jobs, such as assembling, fixing, molding,
mounting, and others. Thus, machine hours are hours consumed by the machines to operate on the production
floor of a manufacturing organization. Machine hours are used extensively in the production environment.
These machine hours of various jobs can be recorded in Exact Globe Next.

You can create a machine hour item by recording details of the machine hours, such as price, cost price, sales
unit, linking of machines which use machine hours, and employees who handle the machines or who are
responsible for the machines, and linking business units from which the machine hours are executed from.

When the production order is issued or fulfilled, the machine hours are realized by registering the total number
of machine hours taken to complete the task, the cost price, and the total amount incurred in the usage of the
total machine hours. This information is registered in the respective general ledger accounts that you can define
in the machine hour item maintenance under the Financial tab.

The procedures for creating, editing, recoding, copying, and deleting machine hour items are the same as for
labor hour items. For more information, see 1.7 Creating and Maintaining Labor Hour Items.

Machines tab

The Machines tab (at Manufacturing - Setup - Hours, click New) allows you to link the machine hour item
to the machines that use the machine hour item. The Machines tab is enabled when you select Machine hour

at Type.

Machines section

INVENTARIS ONDo02 Reparatie tegen garantie
INVENTARIS BOQHS2] DELL OPTIPLEX GX520

-
4| | 3

=

= Add
Click this to link a machine to the machine hour item. Select a machine and click Select to link the selected
machine to the machine hour item.

=
=* Delete
Click this to remove the selected machine from the machine hour item.




1.9 Creating and Maintaining Extra Charges Items

Extra charges are not physical items or parts. Extra charges are a kind of “phantom” that cannot be seen or
produced but they serve as charges for miscellaneous cost during production or sales.

Extra charges can be payment conditions, shipping methods, or just phantom items that must be taken into
account within the production and sales environment. These various kinds of extra charges must be maintained
and accounted for accordingly for cost calculations within the sales and production environment.

For instance, the payment conditions must be maintained for usage in the sales environment as extra charges
to the customers. Payment conditions include sales payment collections which will include discounts,
prepayment amount, and payment term conditions for the customers. Likewise, the shipping methods are
used for collections of shipping costs that are charged by the shipping company. The phantom items are used to
take into account miscellaneous cost that incur during the production process. These extra charges items can be
recorded in the sales order lines and in the BOM structures. The extra charges items which are recorded in the
BOM structures will then be populated in the planning of the production order lines when a main make item is
selected for production.

The following topics are relevant to this section:

- Creating, editing, recoding, and deleting extra charges items
- Copying extra charges items

- Updating details of extra charges items in batches

1.9.1 Creating extra charges items

You can create extra charges items at Manufacturing = Setup - Extra charges.

#° 001 Phantom - Exact =101 x|
Eile Edit Actions Help

HxH|2 |4 MC |2 v|s|=|e

I Item code | consuLT ] Status | Active |~
| Description \mnsulratim \
1 Search code \ CONSULT \ From | 19/03/2012 g| to | E|

I|ﬁ, Financial |@ Activity |W Inventory |‘1= Manufacturing |anc. |eAnatys's |f=-§ Extra |E|Lng |

» Sls. unit, Price B @ [ 0.000 | EUR
| Sales VAT code E [5[BTW 19% excl. |
" cont e
parap —
Product Line \ |- | 1 ¥ Text [~ Payment condition
Market Segment \ |~ | I [ Sales [~ Environmental tax
Target Group \ |- | [ Print (Order)
Internal products [ |=| Text
Assortiment & [ |~ =
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Item code
Type the code for the extra charges item. This code will be automatically copied and entered at Search code.
This is mandatory.

Description
Type the description for the extra charges item. This is mandatory.

Search code
Type a code of up to 13 alphanumeric characters for the extra charges item. By default, the search code follows
the item code filled in.

Status

Select one of the following options:

—  Active — This status refers to extra charges items that can be sold, purchased, and manufactured.

- Blocked — This status refers to extra charges items that can be used in stock counts, creating BOMs, and
budget scenarios, but cannot be used in sales, purchase, and financial transactions.

- Discontinued — This status refers to extra charges items that can be used in stock counts, sales, creating
BOM:s, and budget scenarios, but cannot be used in purchase.

- Inactive — This status refers to extra charges items that can be used in stock counts, but cannot be used in
sales, purchase, financial transactions, creating BOMs, and budget scenarios.

—  Future — This status refers to extra charges items that have not been made active.

From, to

Type or select the dates in the From and to fields to define when the status of the extra charges item is
activated. For example, if the status of the extra charges item is active from January 1, 2012 to December 31,
2012, this indicates that the extra charges item is in an active status during the specified period. However, it is
not necessary to define the end date unless the inactive, blocked, or discontinued date of the extra charges item
is known.

Basics tab

Sls. unit, Price

Type or select the unit of measurement of the extra charges item at Sls. unit, which refers to the sales unit.

The unit of measurement can be created and modified at System > Logistics > Unit. Type the sales price of

the extra charges item at Price. The default currency will be shown next to it. The default currency, defined at
Default currency in the Standard section at System = General - Settings, under General settings, cannot be
changed once it has been defined.

Sales VAT code

Type or select the value-added tax (VAT) code if tax is applicable to the extra charges item. If the extra charges
item is not taxable, you can create a tax code with zero percentage. This is mandatory. You can create and
maintain tax codes at System = General > Countries = Tax codes.




Cost price
Type the standard cost price of the extra charges item. A cost price is usually lower than a sales price so that you
have a positive profit margin.

Markup/Margin

With only the E-Invoice license, Markup will be automatically displayed. The amount in this box will be
automatically calculated by using the markup calculation (gross profit divided by the cost price) and displayed.
This information cannot be edited. If you have the E-Sales Order license, Markup is replaced by Margin if
you have selected Margin at Profit calculation at System > General - Settings, under Order settings. If you
have both the E-Sales Order and E-Invoice licenses, then Markup is displayed.

Assortments section

Assortment 1/2/3

Select the assortment(s) that the extra charges item is linked to. You can use this function to group or categorize
different types of extra charges items that have certain properties in common. With this, you can sort and
update groups of extra charges items based on the various assortments assigned.

Attributes section

Text

Select this check box to allow the text entered in the Text section to be displayed under the Long description
column when the extra charges item is selected in the invoice. The text will then be printed in quotations,
orders, or invoices.

Sales
Select this check box to allow the extra charges item to be sold. Hence, the extra charges item can be used in
sales transactions.

Print (Order)

Select this check box to allow printing of the extra charges item in the sales order confirmation. The Payment
condition check box will be automatically selected when you use the extra charges item in the payment
condition of a sales order. This check box is not enabled.

Payment condition
This check box will be automatically selected when you use the extra charges item in the payment condition of
a sales order. This check box cannot be edited.
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Text section

If you have additional text description for the item, you can type the text description in the box to be displayed
in the Long description column in quotations, orders, or invoices. This additional text will also be printed

in quotations, orders, or invoices (replacing the text entered at Description for the item at Invoice - Items >
Maintain) if the Text check box is selected.

Description NL/DE

Type the description of the item in other languages in the respective fields, if necessary. You can type the
description of the item in up to a maximum of four other languages. For example, you would type the item
description in Dutch at Description NL, and German at Description DE.

1.9.2 Editing extra charges items

Once the extra charges item has been created, it is possible to make changes to the information of the extra
charges items, such as changing the cost or sales price of the extra charges item, adding to or removing pictures
to or from the extra charges item, and other modifications at the extra charges item maintenance.

To edit extra charges items:

Go to Manufacturing - Setup - Extra charges.

Select the extra charges item to be edited, and click Open.

In the Phantom screen, make the necessary changes to the extra charges item.
Click Save.

Click Close to exit.

Gk LN

1.9.3 Recoding extra charges item

Once the extra charges item has been defined and saved, it is not possible for you to make changes to the
extra charges item code. With the Recoding functionality, it is now possible for you to rename (recode) the
extra charges item code. Changes to the extra charges item code can only be done with the Recode button at
Manufacturing = Setup - Extra charges.

To recode extra charges items:

1. Go to Manufacturing - Setup - Extra charges.

2. Select the extra charges item to recode, and then click Recode. This button will not be available if you
select an item which is of type Payment condition or Shipping method. A message “This process
may take some time. Continue?” will be displayed. Click Yes to continue and the Recode screen will be
displayed.

3. Type the new code at New.

4. Click Recode to recode the extra charges item code. Upon completion, a message “Completed
successfully: Recode” will be displayed.

5. Click OK.

6. Click Close to exit.




1.9.4 Deleting extra charges items

Itis possible to delete extra charges items that have been created. When you perform this action, the extra
charges items will be deleted permanently and cannot be retrieved from the system. Extra charges items that
are in use in invoices or pending production orders that have been created and Authorised cannot be deleted.

To delete extra charges items:

1. Go to Manufacturing - Setup > Extra charges.

2. Select the extra charges item to be deleted, and then click Delete. The Extra charges screen will be
displayed.

3. Click Yes to delete the extra charges item.

4. Click Close to exit.

1.9.5 Copying extra charges items

To create an extra charges item which contains the same information as another existing extra charges item,
itis possible to copy the details of an existing extra charges item to the new extra charges item. This process
makes creating an extra charges item faster and easier as it saves you time from filling in the same information
repeatedly.

To copy extra charges items:

1. Go to Manufacturing - Setup - Extra charges.

2. Select the extra charges item to be copied, and then click Copy.

3. Inthe Phantom - Copy screen, type the extra charges item code and description of the new extra charges
item at New: Item code and Description respectively. These are mandatory. Once the extra charges item
code is defined, the code at Search code will be automatically defined.

4. Click OK to save the new extra charges item code.

5. Inthe Phantom screen, make the necessary changes.
6. Click Save.

7. Click Close to exit.

1.9.6 Updating details of extra charges items in batches

The details of extra charges items can be updated in batches, whereby the details of more than one extra charges
item can be updated at the same time. However, this function is used only to update the extra charges items
with the same details.

To update details of extra charges items in batches:

1. Go to Manufacturing - Setup - Extra charges.

2. Click Batch updates. The Update items - Extra charges screen will be displayed.

3. Inthe Range section, define the relevant criteria of the items to be updated.

4. Inthe Change section, select one or more check boxes to update the selected details. For example, to
increase the cost price of the extra charges items by 10%, select the Cost price check box. The New value
and % fields will then be enabled. At New value, select Cost price, and type “10.00” in the % box.

5. Click Show list and a report of the extra charges items to be updated with the new updated details will be
displayed in Microsoft E)%l.

6. In Microsoft Excel, click ™= Exact Globe Next: Update (under the Add-Ins menu bar) to update the
changes. A message “Save changes?” will then be displayed.

7. Click OK and a message “Completed: Update items” will be displayed.

8. Click OK.
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1.10 Creating and Maintaining Outsourced Items

Outsourced items are items that can be used to define an outsourced operation in a production process. This
item type enables planners to generate purchase orders on the outsourced item when buying outsourcing
service from defined suppliers. The outsourced item has the characteristics of a normal item but only the
relevant data for the outsourced process is maintained.

Generally, outsourced items are used as standard items throughout Exact Globe Next. However, since an
outsourced item is not a stock item, it does not require extra production issues, internal machineries, and
resource planning. Due to this, outsourced items will be excluded from search results at the following
functions of the Manufacturing and Projects modules:

-  Manufacturing - Entries - Issue

—  Project > Entries > Realizations

- Project > Entries > Labor hours

—  Project > Entries - Hours per cost center

- Project > Entries > Additional costs

1.10.1 Creating outsourced items

You can create outsourced items at Manufacturing = Setup - Outsourced items. This function is available
only if the Operations check box is selected under the Operations section at System = General - Settings,
under Manufacturing settings.

You can configure an outsourced item similar to a normal item. However, take note of the differences for these

two tabs:

—  Purchase/ Sales tab— You can define the information in this tab similarly to a normal item. However,
since you will outsource the operation, at least one supplier must be linked.

- Financial tab— An outsourced item is treated as a cost item. This helps you to avoid unwanted planned
stock, as well as avoid any impact on your resource planning. Because of this, you can only link an expense
account of type profit & loss as the Stock account.

1.10.2 €Editing outsourced items

You can change the information on the outsourced item, such as changing the cost or adding more suppliers.
You can edit outsourced items from Manufacturing - Setup = Outsourced items or Manufacturing - Setup
- Items. The editing operation is similar to normal items and Exact Globe Next will ensure the outsourced
attribute of the item remains unchanged.

1.10.3 Recoding outsourced items

The item code of an outsourced item cannot be changed once the item has been created and saved. In order
to change the item code, you need to use the Recode function. For outsourced items, this can be done at
Manufacturing = Setup - Outsourced items.




To recode outsourced items:

1. Go to Manufacturing - Setup = Outsourced items.

2. Select the outsourced item to recode. Then, click Recode. This button is not available if the selected item
is of type Payment condition or Shipping method. A message “This process may take some time.
Continue?” will be displayed. Click Yes to continue and the Recode screen will be displayed.

3. Type the new code at New and click Recode. Upon completion, the message “Completed successfully:
Recode” will be displayed.

4. Click OK.

5. Click Close to exit.

1.10.4 Deleting outsourced items

You can delete outsourced items. When you do this, the outsourced items will be permanently deleted and
cannot be retrieved from Exact Globe Next. However, outsourced items currently being used in invoices or
pending production orders that have been Authorised cannot be deleted.

To delete outsourced items:

1. Go to Manufacturing = Setup = Outsourced items.

Select the outsourced item to be deleted and click Delete. The Outsourced screen will be displayed.
Click Yes to delete the outsourced item.

Click Close to exit.

Ll S

1.10.5 Copying outsourced items

You can copy details of an existing outsourced item to a new outsourced item. This makes it easier to create
outsourced items that are almost similar to existing outsourced items.

To copy outsourced items:

1. Go to Manufacturing - Setup = Outsourced items.

2. Select the outsourced item to be copied and click Copy.

3. Inthe Phantom - Copy screen, type the outsourced item code and description of the new outsourced
item at New: Item code and Description. These are mandatory. The code at Search code will be filled
automatically.

4. Click OK to save the outsourced item code.

5. Inthe Phantom screen, make the necessary changes.
6. Click Save.

7. Click Close to exit.

1.10.6 Updating outsourced items in batches

Outsourced items can be updated by clicking Batch updates at:
— Inventory - Items - Maintain

—  Manufacturing - Setup - Items

—  Manufacturing = Setup - Outsourced items
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To update outsourced items in batches:

Go to Manufacturing - Setup - Outsourced items.

Click Batch update.

In the Range section, define the relevant criteria of the items to be updated.

In the Change section, select one or more check boxes to update the selected details.

Click Show list and a report of the extra charges items to be updated with the new updated details will be
displayed in Microsoft Excel.

In Microsoft Excel, click # Exact Globe Next : Update (under the Add-Ins menu bar) to update the
changes. A message “Save changes?” will then be displayed.

7. Click OK and a message “Completed: Update items” will be displayed.

8. Click OK.

A

o

When any of the attribute changes causes the item to cease becoming an outsourced item, a message will be
displayed for you to confirm the update. Click Yes to update the item anyway and turn the item into a normal
item. To skip the item from the batch update, click No.

1.11 Creating and Maintaining Operations

To produce the finished goods, a manufacturing organization may require one or more operations involving
machines and labor within the number of production processes. Operations are steps taken within the
production processes in order to produce the finished goods. Operations will determine the machines,
machine hours, work centers, people, labor hours, cost centers, operating time, labor and machine hour ratios,
labor hour setups, and operating time setups, which will be used in the production process.

Operations are basically activities that take place on the shop floor or production floor in a manufacturing
company. These activities are to be attached to the BOM structure. Operations are the steps taken to produce
a product. All required resources are attached to these operation steps in a BOM. These can be machines,
employees, tools, or raw materials. Operations can be set in relationship to one another. The setting of
relationship between operations is called routing of a production process. This relationship differs for

each finished goods or product. Thus, the relationships are stored in the BOM structure for each product.
Operations can depend fully on batch quantity, but and also partly on setup activities. It is possible to have
different skill requirements and tools for setting up a machine for a specific job. It is also possible to combine
jobs of different production orders to save setup time. Operations and setup operations are combined in order
to keep the dependency clear.

The following topics are relevant to this section:
- Creating, editing, recoding, and deleting operations
—  Copying operations




1.11.1 Creating operations

You can create operations at Manufacturing - Setup = Operations.
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To create operations:
Go to Manufacturing - Setup - Operations.
Click New. The Operations screen will be displayed.
Type the code for the operation at Operation. This is mandatory.
AtDescription, type a description for the operation. This is mandatory.
In the General section, type or selecta layout at Layout.

Gk e
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6. Select the Block check box to block the operation from being used in the BOM.

Select the Print check box to allow printing of the operation in the operation slip.

8. Inthe Machine section, type or select the asset group and machine at Work center and Machine
respectively.

9. Type or select the machine hour at Machine hour. This is mandatory.

10. In the Labour section, type or select the cost center and employee ID at Cost center and Person
respectively.

11. Type or select the labor hour item at Labour hour. This is mandatory.

12. In the Time section, type the number of hours taken by the operation and the labor and or machine hour
ratios at Operating time and Labour/machine ratio respectively. The Labour/machine ratio field is
enabled if you have selected both Machine hour and Labour hour.

13. In the Setup section, type or select the labor hour item at Labour hour (Setup).

14. Next, type the number of hours for operation setup at Operating time (setup).

15. Click Save to save the defined operation.

16. Click l=l Instructions to type remarks in the Operations: Instructions screen. Click OK to save and
close the screen.

17. Click Save.

18. Click Close to exit.

N

1.11.2 €diting operations

Once the operation has been created, it is possible to make changes to the information of the operation, such
as changing the descriptions, layouts, block and print attributes, work centers, machines, machine hours, cost
centers, people, labor hours, operation’s operating time, labor hour and machine hour ratios, operation setup’s
labor hour items, and operation setup’s operating time.

To edit operations:

Go to Manufacturing > Setup - Operations.

Select the operation to be edited, and then click Open.

In the Operations screen, make the necessary changes to the operation.
Click Save.

Click Close to exit.

Gk LN

1.11.3 Recoding operations

Once the operation has been defined and saved, it is not possible to make changes to the operation code. With
the Recode functionality, it is now possible for you to rename (recode) the operation code which is defined at
Operation in the operation maintenance screen. Changes to the operation can only be done with the Recode
button at Manufacturing - Setup - Operations.




To recode operations:

1. Go to Manufacturing - Setup = Operations.

2. Select the operation to recode, and then click Recode. A message “This process may take some time.
Continue?” will be displayed. Click Yes to continue and the Recode screen will be displayed.

3. Next, type the new code at New.

4. Click Recode to recode the operation code. Upon completion, a message “Completed successfully:
Recode” will be displayed.

5. Click OK.

6. Click Close to exit.

1.11.4 Deleting operations

Itis possible for you to delete the existing operations in the system. When you delete an operation, the
operation will be deleted permanently from the system and cannot be retrieved from the system. Operations
thatare in use within pending production orders that have been created and Authorised cannot be deleted.

To delete operations:

1. Go to Manufacturing - Setup - Operations.

2. Select the operation to be deleted, and then click Delete. A message “Depending on the size of your
company, this function may take a long time because all files will be checked. Delete?” will be displayed.

3. Click Yes to delete.

4. Click Close to exit.

1.11.5 Copying operations

You may have a situation where you need to repeatedly create more than one operation with similar
information. To save time and effort, it is possible for you to create an operation by copying the details of an
existing operation to the new operation. This makes it faster and easier to create operations because you avoid
filling in the same information repeatedly for every operation.

To copy operations:

1. Go to Manufacturing = Setup = Operations.

2. Select the operation to be copied, and then click Copy.

3. Inthe Copy: Operation screen, type the operation code and description of the new operation at New and
Description respectively.

Click OK to save the new operation.

In the Operations screen, make the necessary changes.

Click Save.

Click Close to exit.

4.
S.
6.
7.
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1.12 Creating and Maintaining BOMs (Bills of Materials)

A BOM (Bill of Materials) is a recipe structure of all the involved components for a parent item which is the end
product. The BOM defines the components, such as raw materials, subassembly items, labor hours, machine
hours, and the corresponding activities (operations) within each process performed to make the parent item.
For each of these components in the BOM, you can define the conditions and step relations.

A BOM is defined by specifying the parent item, BOM version, effective date, lead time, batch quantity,
information such as sales price that is derived from the item maintenance, and cost price that is automatically
calculated from the cost price of the components that you attach in the BOM. There are five tabs required to
define a BOM. The Operations tab defines all the activities that take place on the production floor in order to
complete the finished goods. The Step relation tab defines the relationship between each operation within the
production process in completing the finished goods (parentitem). The BOM tab defines the raw materials,
subassemblies, parts, by-products, and bulk issues with the related conditions and step relations within the
BOM. The Extra charges tab defines phantom items and extra charges items that will incur in completing the
parent item. The Production tab displays the list of production orders that use the BOM. The Extra tab allows
you to define extra information to the BOM.

The following topics are relevant to this section:
-  Creating, editing, and deleting BOMs
—  Copying BOMs

1.12.1 Creating BOMs

You can create BOMSs at Manufacturing - Setup > BOM.
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To create BOMs:

1. Go to Manufacturing > Setup > BOM.

2. Click New. You will see the BOMS screen.

3. Type or select the parent item code at Item. This is mandatory.

4. Type the version number of the BOM at Version. By default, the next number in sequence number of for

the existing version will be filled upon item selection.

Select the Main version check box to indicate that the current version being created is the main version.

Type or select the effective date of the BOM at Effective date. By default, this is the current date of the

BOM creation.

7. Type the number of days taken to complete the parentitem at Lead time. This will also be automatically
calculated based on the details defined in the Operations and Step relation tabs.

8. Type the quantity of the parent item which will be produced in batch per production order at Batch
quantity. By default, thisis set to “1”.

9. Selectawarehouse in which the BOM is used at Warehouse. Select All to enable usage of the BOM in all
warehouses.

10. Click @ next to Instructions to attach a document with instructions to the BOM which will be used in

o v

the production process.
11. Define the relevant information in the respective tab screens and click Save to save and exit.

Operations tab

The Operations tab stores information about the processes or activities of the BOM. These processes represent
the steps and involve machine and labor hours of the BOM that should be followed in the production order

in order to produce the end product (make item or parent item). Each operation is linked to a step number.

The step number is unique within each BOM. Two same step numbers are not allowed within a single BOM.
However, the same operation with a different step number within a single BOM is allowed. Each operation step
will display the smallest activities in ascending order within the BOM.

To add an operation: —

1. Inthe Operations tab, click “+= Add.

2. Type the step number at Step. By default, an initial value of “10” will be pre-filled when adding the first
operation. By default, for the next step number, the system will increase the next value by 10. However,
itis possible to edit the step number while adding an operation. Once saved, you can make changes to the
step number by clicking i Recode under the Operations tab.

3. Type or select the operation at Operation. By adding an operation, the required machine hours and
labor hours are populated to the spread below based on the operation maintenance which is defined at
Manufacturing - Setup - Operations. If the selected operation is removed and another operation is
selected, then the machine hours and labor hours are re-populated in the spread based on the defined
operation maintenance of the selected operation.
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4. Under the Condition column, select the condition for the item such as Always, or Once per
production order to define other machine hours and labor hours besides the data that is being populated.

S. Type or select the relevant item, such as part item, labor hour item, or machine hour item under the Item
column by pressing F2. Only active hour items are allowed for selection.

6. Select the Backflush check box in the Backflush column to indicate whether the selected item should
be backflushed when there is an extra receipt of production order. This is defined by default at System >
General - Settings, under Manufacturing settings.

7. Select the check box in the Plan Automatically column to indicate whether the labor hour item is
planned automatically or planned manually by assigning a relevant person. If this is selected, then the
Person column cannot be edited and is automatically assigned with ID “-3”.

8. Type the required quantity of the selected item under the Quantity column. By default, this will be
pre-filled with the quantity based on the defined Operating time in the operation maintenance at
Manufacturing - Setup - Operations.

9. Type or select the relevant information in the Warehouse, CCtr., Person, Machine, and Work center
columns respectively by pressing F2.

10. Type the number of days which the item is used in the From day and To day columns.

11. Type the position number of the BOM line for the item in the Pos. no. column.

12. Click » under the Extra column to type extra descriptions to the item.

13. Click the Attachment column to attach a document to the item.

14. Type or select the asset group and machine at the Work center and Machine columns respectively by
pressing F2. If you have selected a labor hour item, then the Work center and Machine columns will be
disabled and the Person column will be enabled. If you have selected a machine hour item, then the Work
center and Machine columns are enabled and the Person column is disabled.

15. Click Close to save the defined operation.

=L
Edit
Select an operation and click this to make changes to the operation details in the edit mode screen. At least one

single hour item must remain in the operation. An operation without an hour item (regardless of machine
hours or labor hours) is considered invalid.

=

= Delete

Select an operation and click this to remove the operation from the BOM. This is enabled only when you select
an existing operation.

Note:  The From day and To day of the current operation step will be recalculated based on the
dependency type of the step relation and the From day and To day of the predecessor step.

i Recode

Select an operation and click this to make changes to the step number of the operation that exists within the
BOM. This is enabled only when you select an existing operation. Recoding the operation step to another
existing step number is not allowed.




£ Maintain
Select an operation and click this to view the Operations screen via Manufacturing - Setup - Operations.
You may make changes in the operation maintenance.

y Replace
Select an operation and click this to display the detailed view whereby the breakdown of hour items within the
operation is displayed.

& Outsource

An organization that does not have the required machinery, capacity, or knowledge to perform an operation can
outsource the work to another organization. To define an operation as outsourced, select an operation, and then
click this. The Outsourced items screen will be displayed. Select an outsourced item, and then click Select.

Step relation tab

Under the Step relation tab, you can define the relations between operations that are within the BOM.
Defining step relation ensures that sequences of processes are followed accordingly in the production floor to
produce the end product. Define the following to set up the relations between operations:

Step

Click this column and a drop-down list will be displayed. This drop-down list displays a list of all existing
operation steps that exist within the BOM as defined in the Operations tab. Select the appropriate operation
step.

Predecessor

Click this column and a drop-down list will be displayed. This drop-down list displays all existing operations
within the BOM as defined in the Operations tab. Select an operation which is the predecessor of the
operation specified in the Step column.

Dependency type

Select the type of dependency between the operations specified in the Step and Predecessor columns. The

dependency type determines the start and end of a step compared to its predecessor step. There are four types

of dependencies:

—  FS:Finish-to-Start — This means the step cannot start until the predecessor step finishes. The From day
of the current operation step must be equal or greater than the To day of the predecessor step.

—  SS:Start-to-Start — This means the step cannot start until the predecessor step starts. The From day of
the current operation step must be equal or greater than the From day of the predecessor step.

—  FF:Finish-to-Finish — This means the step cannot end until the predecessor step finishes. The To day of
the current operation step must be equal or greater than the To day of the predecessor step.

—  SF:Start-to-Finish — This means the step cannot end until the predecessor step starts. The To day of the
current operation step must be equal or greater than the From day of the predecessor step.

Lag

Type the number of hours that will be consumed in between the operation steps. This is the queue time taken
in between the operation steps. The lag hours do not affect the lead time calculation but can be further used in a
third party Advanced Planning Schedule (APS) to perform complex recalculation.
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Lagtype
Select Hour or % from the drop-down list to define lag by hour or percentage respectively. This is the unit of
measurement for the queue time.

BOM tab

By defining the Operations and Step relation tabs, the necessary machine hours and labor hours are already
defined for the BOM. Within the BOM tab you can define standard items, such raw materials, subassemblies
(partitems), by-product items, and bulk issue items, to the respective operation step. Define the following
information to set up the BOM tab:

Step
Selectan existing operation step which you want to link the standard item to.

Condition
Select the condition of item which is used within the operation in the BOM. You can select Always, Once per
production order, Phantom, or Phantom zero lead time accordingly.

Item
Type or select the item code to be used within the operation in the BOM by pressing F2.

Item description
This column displays the description of the item as per item maintenance, which is defined at Manufacturing
- Setup = Items. This cannot be edited.

Status
This column displays the status of the item as per item maintenance, which is defined via Manufacturing >
Setup - Items. This cannot be edited.

Make
This column displays whether the item is a make item. A make item can be selected as the parentitem in the
BOM. A make item can also be a subassembly item. This cannot be edited.

Buy
This column displays whether the item is a purchase item. Buy items can be purchased and quoted in the
purchase order.

Backflush
Select this check box to enable backflushing of the item when performing extra receipts of production order.

By-product

Select this check box to define this part item as a by-product of the finished product. By-products are materials
of value that are produced as a result of manufacturing the finished product. The quantity of by-products is
usually predictable, and it can either be used for other purposes or sold. In Exact Globe Next, by-products are
received together with the finished product at the end of the production process.

Quantity
Type the quantity of part items to be used in producing the parent item (end product).




Unit
This column displays the unit of measurement for the partitem as per item maintenance which is defined at
Manufacturing - Setup - Items.

Waste %
Type the percentage of waste which will incur for this part item in producing the parentitem (end product).

Cost price
This column displays the cost price of the item as per item maintenance which is defined via Manufacturing >
Setup >Items.

Manual cost price
If the cost price is different, define another cost price manually here. This is optional.

Total cost price
This column displays the total cost price of the item. This is automatically calculated based on the cost price and
quantity of the item.

Cur.
This column displays the price currency of the item. This is derived from the item maintenance defined at
Manufacturing - Setup - Items.

Warehouse
Type or select the relevant warehouse for the item by pressing F2.

CCtr.
Type or select the relevant cost center for the item by pressing F2.

From day
Type a number for the day which the item will be used in the production process. This is mandatory.

Pos. no.
Type the position number of the item in the BOM line which will be used in the production process.

Extra
Click to open the Extra - BOMs screen. Define any extra information to the item and click Save to save and exit
from the screen.

Attachment

Click this column to open the Attachment screen. Select a document to attach to the item at File name in the
Source file section, and type the description for the document at Description in the Extra data section. These
are mandatory. Click Save to attach the selected documentand close the Attachment screen.

Note
Click this column to open the Note screen. Type any remark to the item and click Timestamp. Click Save to save
the note and close the Note screen.
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Extra charges tab

Under the Extra charges tab, you can define phantom items, miscellaneous cost charges, and other extra
charges that will incur during the production process to produce the end product. Prior to specifying the extra
charges in the Extra charges tab, you must first define the various extra charges item at Manufacturing >
Setup - Extra charges.

Step
Click this column and a drop-down list will display a list of all the step operations which you have defined for
the BOM in the Operations and Step relation tabs. Select the appropriate step operation. This is mandatory.

Item
Type or select an extra charges item that will incur in the step operation which you have selected by pressing
F2. This is mandatory.

Item description
This column displays the description of the extra charges item as defined in the extra charges item maintenance
at Manufacturing - Setup - Extra charges. This information cannot be edited.

Status
This column displays the status of the extra charges item as defined in the extra charges item maintenance at
Manufacturing = Setup - Extra charges. This information cannot be edited.

%

This column displays the percentage of the extra charges item as defined at Percentage 1 in the Percentages
section under the Extra tab of the extra charges item maintenance at Manufacturing - Setup - Extra charges.
This information cannot be edited.

Total cost price
The total cost price is automatically calculated based on the total cost price of the hour items involved in the
step operation multiplied by the percentage of the extra charges item. This information cannot be edited.

CCtr.
This column displays the cost center of the extra charges item as defined in the extra charges item maintenance
at Manufacturing - Setup - Extra charges. This information cannot be edited.

Extra
Click m to define extra information to the extra charges item.

Attachment
Click this column to select and attach a document to the extra charges item.

Note
Click this column to type notes to the extra charges item.




Production tab

The Production tab displays a list of all production orders. Only production orders which use the BOM to
produce the parent item (end product or finished goods) will be listed here. It is possible for you to view or
make changes to the production orders from the Production tab by clicking =¢ Edit. This will display the
production order entry screen.

Extratab

Under the Extra tab, you can define extra information, which refers to the BOM for which you are defining.
Prior to defining extra information, the extra free fields from Structures: freefield1 to Structures:
freefield20 must be defined into meaningful fields. You can do this at System = General - Free fields, and
define the name for the free fields under the Structures table.

There are numeric free fields in this tab. These fields are Structures: freefield1 to Structures: freefield3
and Structures: freefield13 to Structures: freefield15. You can define whether to enter amount, quantity,
percentage, prices, and others.

The alphanumeric free fields are Structures : freefield4 to Structures: freefield10, which you can use to
define field names that can store extra description or criteria about the BOM.

The free fields for dates are Structures: freefield11 and Structures: freefield12, which you can use to
indicate a certain kind of date, such as validity date, production date, planning date, and others.

The free fields for check boxes are Structures : free field 16 to Structures : freefield20. You can use the fields
to define the “yes” or “no” criteria of the BOM.

These extra free fields serve only as a piece of extra information to the BOM and do not affect the technical

aspects or the logical flow of the BOM. The Extra tab provides value in areas of information that you may want
to define in which you cannot define in other tabs.

Log tab

Alogwill be created whenever a BOM line is edited. This tab will display the log report for all changes to the
BOM lines.
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1.12.2 €Editing BOMs

Once the BOM has been defined, you can still make changes to the details of the BOM, such as changing

the operation, deleting an operation or adding another operation, redefining the step relation, removing or
adding partitems in the BOM tab, adding more extra charges items in the Extra charges tab, or defining more
descriptions about the BOM in the Extra tab.

To edit BOMs:

1. GotoManufacturing > Setup > BOM.

2. Select the BOM to be edited, and then click Open.

3. Inthe BOMs screen, make the necessary changes.

4. Click Save to save the changes.

S. Ifyouhave selected the Use engineering change management check box in the Engineering change

section at System > General - Settings, under Manufacturing settings, then the Activities screen will
be displayed. Define the relevant information and type a brief reason to change the BOM details at Reason
for changing. This is mandatory. Type a detailed reason for the change at Reason, if necessary. Click Save
to save the changes and Close to exit.

6. Click Close to exit.




1.12.3 Deleting BOMs

It is possible to delete BOM structures that you have created. When you delete the BOM, it will be permanently
deleted from the system and you cannot retrieve the BOM. Make sure that the BOM which you want to delete is
not used anywhere in pending logistics transactions, such as the production order. Otherwise the BOM cannot
be deleted.

To delete BOMs:

1.  Go to Manufacturing > Setup > BOM.

2. Selectthe BOM to be deleted, and then click Delete.

3. Inthe BOMs - Delete screen, select the version of the BOM you want to delete, and then click Delete.
A message “Delete?” will be displayed. Click Yes to delete the BOM. If the BOM is not in use in any
production, then it will be immediately deleted.

4. Ifthe BOMisin use in the production, then a message “Can’t delete: In production” will be displayed.
Click OK to close message or E-mail to send the error message to notify the relevant person in charge of
the BOM.

S. Click Close to exit.

1.12.4 Copying BOMs

In a manufacturing organization, usually a number of end products would be similar with only minor
differences. Thus, the BOMs for most of the end products may be similar. In this case, you may have to define
similar BOM structures repeatedly. This can be repetitive and time consuming. To eliminate this, you can create
a BOM quickly by copying the information of an existing BOM.

To copy BOMs:

Go to Manufacturing > Setup > BOM.

Select the BOM to be copied, and then click Copy.

In the BOMs - Copy screen, select the version of the BOM that you want to copy at Version.

At Copy, select the tab(s) which you want to copy.

Type the description of the new BOM at Description.

Click Copy to copy the BOM and the new BOM will be displayed as a new version.

Make the necessary changes for the new BOM and click Save.

If you have selected the Use engineering change management check box at System > General >
Settings, under Manufacturing settings, then the Activities screen will be displayed. In this case,
copying a new version of BOM is considered a change in the BOM. Specify the reason for the change in the
Activities screen. Click Save to save to save the changes, and then Close to close the Activities screen.
9. Click Close to exit.

O NG
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1.13 Creating and Maintaining Scenarios

Scenarios are templates which are used to calculate the actual cost price for each end product. Taking into
consideration the various factors of costs for the end product, such as the sales price per item, cost price per
item, pricing per part item, calculated cost price in the BOM, total cost price per batch quantity, purchase price
per supplier, total pricing per exploded BOM, and others, it is difficult to determine the actual cost price of the
end product.

To eliminate deviations of the actual cost price, scenarios are used at Manufacturing - To be processed
- Calculate to determine the actual cost price. Scenarios are master templates which can be defined at
Manufacturing - Setup > Scenarios.

You can create more than one scenario with different configurations which can be used to calculate the same
end product. This means it is possible for you to define the different criteria that you intend to account for the
actual cost price calculation of the BOM.

The following topics are relevant to this section:

- Creating, editing, and deleting scenarios

—  Copying scenarios

1.13.1 Creating scenarios

You can create scenarios at Manufacturing - Setup = Scenarios.

r‘ Calculation scenario: BOM

File Edit Help

sHI2 |40 |a~|8 @

>|Soenario | | |

» Description |
Maximum number of levels
Explode: Stock controlled I
Round off to: Batch guantity il
Round off to: Purchase order None -
Make [ Buy Produce hd
Item price: Buy Cost price hd
Item price: Make Cost price -
Margin % 0.00




To create scenarios:

I .

10.

11.

12.
13.
14.

Go to Manufacturing - Setup - Scenarios.

Click New.

Type a code for the scenario at Scenario. This is mandatory. Once saved, this code cannot be edited.

Type a description to the scenario at Description. This is mandatory.

Select one of the following options at Maximum number of levels:

- All — Select this option to include all levels of BOM in cost calculation.

- 1 — Select this option to include only the first level of BOM in cost calculation.

Select the Explode: Stock controlled check box to explode stock-controlled items in the BOM in cost

calculation.

Select the Round off to: Batch quantity check box to round up the quantity of items corresponding to

batch quantity in cost calculation.

Select one of the following options at Round off to: Purchase order:

- None — Select this option if you do not want to round off to any purchase order criteria in cost
calculation.

- Purchase unit — Select this option to round off quantity of items to the purchase unit in cost
calculation.

- Purchase order size — Select this option to round off quantity of items to the default purchase
order size in cost calculation.

Select one of the following options at Make / Buy to determine the type of items to account for when

calculating cost for the end product:

- Produce — Select this option to account for make items (items which are produced).

- Purchase — Select this option to account for purchase items (items which are bought from the
supplier).

Select one of the following options at Item price: Buy to determine the pricing factor for the bought

items when calculating cost for the end product:

- Cost price — Select this option to use the cost price of the purchase item.

- Purchase price(Main supplier) — Select this option to use the main supplier’s purchase price of
the purchase item.

- Sales price — Select this option to use the sales price of the purchase item.

Select one of the following options at Item price: Make to determine the pricing factor for produced

items when calculating cost for the end product:

- Cost price — Select this option to use cost price of the make item.

- Calculated cost price(Main version) — Select this option to use the calculated cost price as per
main BOM version of the make item.

- Sales price — Select this option to use the sales price of the make item.

Type the percentage of margin at Margin % to markup the new calculated cost price of the end product.

Click Save to save the newly-defined scenario.

Click Close to exit.
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1.13.2 Editing scenarios

After creating scenarios, you can still make changes to the configurations in the scenarios, such as making
changes to the description of the scenarios, the number of BOM levels to account for, the pricing factors to
consider for make or buy items, the margin percentage to markup the cost price calculation, and others.

To edit scenarios:

1. Go to Manufacturing - Setup = Scenarios.

2. Select the scenario to be edited, and then click Open.
3. Make the necessary changes.

4. Click Save to save the changes.

5. Click Close to exit.

1.13.3 Deleting scenarios

As time passes, certain scenarios used in the past may become obsolete, as organizations tend to make changes
in methods and strategies in accounting for cost price calculation. In this case, housekeeping of obsolete
scenarios is required. You can delete the unused scenarios by using the Delete button.

To delete scenarios:

1. Go to Manufacturing - Setup = Scenarios.

2. Select the scenario to be deleted, and then click Delete. A message “Delete the data selected?” will be
displayed. Click Yes to delete the scenario from the system.

3. Click Close to exit.

1.13.4 Copying scenarios

You may want to create similar scenarios with different scenario codes and descriptions for use and as
indications to be used in the cost price calculation for another end product. Creating similar scenarios can be
repetitive and time consuming. To eliminate this, you can create scenarios by copying the configurations of an
existing scenario.

To copy scenarios:

1. Go to Manufacturing = Setup = Scenarios.

2. Select the scenario to be copied, and then click Copy.

3. Inthe Save as: Scenario screen, type the new code and description at Scenario and Description
respectively.

4. Click Save to complete the copying process.

5. Click Close to exit.




1.14 Creating and Maintaining Reason Codes

Reason codes are used to indicate the reasons for return of items and for scrap of items in the production order.
Within the production order, you can specify items as scrap by clicking the Scrap button in the production
order entry screen. In the Scrap screen, you need to type the quantity of items being recorded as scrap and to
quote the reason code as to why the items are recorded as scrap. Reason codes can be defined for faulty items,
broken parts, and others. Reason codes can be maintained at Manufacturing - Setup = Reason codes.

The topics relevant to this section include creating, editing, and deleting reason codes.

1.14.1 Creating reason codes

You can create reason codes at Manufacturing = Setup - Reason codes.

J oot Reasm ket ES

gle Edt el

:aamwmal‘vm@

- I Code | FACULTY |
| Reason | Itern disfunction
Used in

| RMA orders ~
| RTW orders ~

1[Serap |
Description AE | |
B |
To create reason codes:

Go to Manufacturing - Setup - Reason codes.

Click New. The Reason codes screen will be displayed.

Type a code for the reason code being created at Code. This is mandatory.

Type the reason for the reason code at Reason. This is mandatory.

In the Used in section, select one or more of the following check boxes:

- RMA orders — Select this check box to enable selection of this reason code in the RMA orders.

- RTV orders — Select this check box to enable selection of this reason code in the RTV orders.

- Scrap — Select this check box to enable selection of this reason code in the scrap functionality.

6. Type the description for the reason code being created at Description. This is optional. If you have defined
multiple language descriptions in the Descriptions in list boxes section at System = General - Settings
under General settings, then these foreign language description fields will be enabled.

7. Click Save to save the new reason code, and Close to exit.

I .
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1.14.2 €Editing reason codes

You can still make changes to the details of the reason code after you have saved the details. You must first
retrieve the intended reason code and then make the changes you want in the Reason codes screen.

To edit reason codes:

Go to Manufacturing - Setup - Reason codes.

Select the reason code to be edited, and then click Open.
Make the necessary changes.

Click Save to save the changes.

Click Close to exit.

Gk LN

1.14.3 Deleting reason codes

Obsolete reason codes are basically unused. You may not want to keep these unused reason codes in your
system. Housekeeping of these obsolete reason codes can be performed to ensure that your system stores only
up to date records and not obsolete records, which in return speeds up the searching for the intended records.

To delete reason codes:

1. Go to Manufacturing - Setup - Reason codes.

2. Select the reason code to be deleted, and then click Delete. A message “Delete: Items [Code - Reason]?
Depending on the size of your company, this function may take a long time because all files will be
checked. Delete?” will be displayed. Click Yes to delete the reason code permanently from the system.

3. Ifthereason code is being used in any pending transactions, such as RMA orders, RTV orders, or Scrap,
then the Delete items screen with an error message will be displayed. Click Print to print the error
message, or Close to close the error message.

4. Click Close to exit.




1.15 Inventory Settings

In Exact Globe Next, you can define various settings to manage your inventories. These settings will affect
your logistics operations from the inventory valuation method to issues related to warehouses, internal use,
and interbranch transfers. To set up inventory settings, go to System - General - Settings, and then click
Inventory settings.

Inventory settings
ﬂ Entry
[valuation methad per item r
Valuation method | Average purchase price D
Stock valuation as from last revaluation -
Cost price and stock valuation per warehouse -
Stock valuation: Update make item cost price. -
oo |55 | e |-

Valuation method per item
Select this check box to use different valuation methods for different items.

Valuation method

Select Standard cost price, Standard cost price (Classic), Average purchase price (APP), FIFO, LIFO,
or Real time APP to define the valuation method to be used in the administration. By default, the valuation
method is set to Standard cost price.
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2. Cost Calculation

It is not easy to determine the cost of production, both in the planning and actual transactions, especially when
the populated Bill of Materials (BOM) within the production order is adjusted to suit production requirements.
Nevertheless, effort must be put forth to calculate the cost of production to be used for the financial reporting
of your production. In any manufacturing organization, the production cost calculation is very important.

The production cost calculation determines the incurred costs in producing the end product and therefore,
enables management to decide on the percentage of margin to markup on the end products that will be sold to
customers. This ensures that profitable revenue is made when selling the end product.

Sales prices of end products determine the production revenue while the cost prices of the components, which
are used in producing the end products, such as raw materials, subassembly parts, labor hours, machine hours,
and others make up the production cost. The production profit margin is determined based on the production
revenue and production cost.

The actual cost of production orders must be determined to ensure that proper financial balances are reflected in
the financial reports, such as profit and loss statements and balance sheets. Actual cost calculations will enable
actual cost transactions to take place in the production process and thus, eliminating deviations from the exact
figures in the financial reports.

The following topics are relevant to cost calculation:

- Calculating cost for BOMs
- Calculating cost for production orders

2.1 Calculating Cost for BOMs

You can select the end product for which you want to calculate its total cost. It is possible for you to calculate the
cost for all existing BOM versions for the selected end product.

You can also update the calculated cost price of the BOM based on the scenario calculation and markup
percentage. Prior to the batch update of the BOM, the scenario must be defined. The scenario can be defined at
Manufacturing - Setup > Scenarios.




To calculate cost of BOMs:

¥ 001 Calculate - Exact Ol x|
File Edit Help
2400 e
» Item code | cvotoos-111 (3 |cvoto0s-111 | [version T =
Quantity ‘ 1 | - |v | Batch quantity Main version ol
|Type | |Cor\drtinn |1tem |Des=cri ion |0pelat\on =
CY01009-111
E Ttems b |
=)+ Machines |
E| Labor hours b |
P Always STANDAARDUUR Standaard uur 10 - DFOPOO1
[ b e DWEYS STANDAARDUUR Standaard uur 20 - DFOPOO1
[=]- Extra charge b =
4 | »
Sales price 0.000 EUR Ttems 0.000 EUR
Total costs 0.000 EUR Machines 0.000 EUR
Labor hours 0.000 EUR
Extra cha 0.000 EUR
Margin 0.000 EUR 0 TTAree
By-product 0.000 EUR
Total costs 0.000 EUR /1 -

ENr-N

1. Go to Manufacturing = To be processed - Calculate.

Select an end product, and then click Calculate. You will see the Calculate screen.

3. Selecta different version of BOM at Version to display the cost price calculation for the selected BOM
version. You can select a different version only when there is more than one version of BOM for the make
item.

4. Type the quantity of the end product at Quantity to calculate the total cost price of BOM for the selected
number of end products.

S. Click Produce to create a production order for the calculated BOM, otherwise click Close to exit.
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To update cost prices of BOMs:

E 001 Update: Calculated cost price _L

Calculation

Range

* Summary (™ Details

Item code | @l
B & a
Person @l |
Recipe versions (« Main ¢ All ~ Select I:I
Scenario

Maximum number of levels |:|

Explode: Stock controlled [T
Round off to: Batch quantity [~
Round off to: Purchase n'rd-er| 0

Make /[ Buy |

Itern price: Buy |

Item price: Make |

pergin %

1. Go to Manufacturing - To be processed - Calculate.

Click Batch updates. You will see the Update: Calculated cost price screen.

3. Inthe Calculation section at Scenario, type or select the scenario to use for the new cost price calculation.
This is mandatory. You can define scenarios at Manufacturing - Setup = Scenarios. Selecting a scenario
will populate the scenario configuration information in the Scenario section. The Scenario section
cannot be edited.

4. Inthe Range section at Item code, type or select an item code or a range of item codes of the end
product(s) to update the calculated cost price for the selected item(s) in a batch. To update the calculated
cost price for all items (end products) in a batch, select the All check box.

S. Type orselecta person at Person to batch update the calculated cost price for make items handled by the
selected person.

6. AtRecipe versions, select Main, All or Select to specify the BOM version of the selected end product for
which you want to batch update the calculated cost price. If Select is selected, the box next to this option
will be enabled. Type the number of BOM version which you want to update the calculated cost price.

7.  Click Show list to display the calculated cost price in Microsoft Excel.

8. InMicrosoft Excel, click # Exact Globe Next: Update (under the Add-Ins menu bar) to update the
changes. A message “Save changes?” will then be displayed. Click OK to update the BOM cost price of the
end product into Exact Globe Next. A confirmation message “Completed: Update items” will be displayed.
Click OK to close.

9. In Microsoft Excel, go to File and click Exit to close Microsoft Excel.

10. In the Update: Calculated cost price screen, click Close to exit.




To adjust cost prices based on calculated cost prices:

Data i
( Stockdata  (~ Items by supplier
Range
Item code [ | wf A 7 oan
Attributes I" sales [ Stock [T Make [~ Buy
T Part [~ Batch [~ Serial [~ Service
Item group [ @] o Al P oan
Main warehouse @] o [N
Last sale = tof =| 7oAl
Main supplisr a| |
Status Active [=]  Tvpe|al |-
et e S — o] o n E
Internal products Assortiment & |~
Change
™ Cost price New value | Cost price | — % [~ status New value | Active
™ Item group Newwvalue| @] I Description Newvalue| ]
I unit Newwvalue| @] ™ Type New value
[T Stock contralled Newvalue[Yes |7 ™ Requires approved supplier  New valus | Yes
I™ Classification ESL Newvalie| ¢ ™ Commissionable New value
= Commission method  New value [ Margin % =] | 0.00 | %
Product Line Markst Segment | || Target Group| |-
Internalproducts| |« iment6 | [=] [ Prics Jist sssortments
P
e s——

Go to Manufacturing - Setup > Items.

Click Batch updates and you will see the Update items - Items screen.

In the Data selection section, select Item data to make selections and update on item details.

In the Range section, type or select an item or a range of items at Item code for which you want to adjust
the cost price to calculated cost price. Select the All check box to adjust the cost price for all items.

In the Change section, select the Cost price check box to update the cost price of the item(s). Selecting the
Cost price check box will enable New value.

Select Calculated cost price at New value to update the current cost price with the calculated cost price.
To markup the cost price to certain percentage, type the percentage at %.

Click Show list to display item(s) with the new updated calculated cost price in a Microsoft Excel report.
In Microsoft Excel, click # Exact Globe Next: Update (under the Add-Ins menu bar) to update the
changes. A message “Save changes?” will then be displayed. Click OK to update the cost price of the item
in the item maintenance to the new updated cost price. A message “Completed: Update items” will be
displayed.

10. Click OK to close message.

el e
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2.2 Calculating Cost for Production Orders

Upon completion of the production order, the actual cost price of the production order will be automatically
obtained. You can view the actual costs of production orders at Manufacturing - Reports - Actuals. You may
also obtain a comparison view between the planned costs and actual costs of production orders at Projects

- Projects - Maintain projects. An overview of production orders that are completed and which are still in
process can be viewed at Manufacturing - Reports - Production orders.

It is important that you note that the actual costs of production orders are only obtained once the production
orders are completed because when a certain production order is not completed, it is possible to return items
and make changes to the cost of finished goods which are received in the warehouse. Once a production order
is completed, it means that there are no more pending steps to take and all relevant steps of processing are
completed. Once a production order status is set to completed, it is not possible to revert or make changes to
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the production order. Thus, the actual cost of a production order is extracted from the completed production order as it
assures that there will not be any changes to the actual cost of the production order.
To display actual costs of production orders:

il Manufacturing / Reports / Actuals

Parent project | B tof Al = al
Production order ‘ al tol @_‘ I Al
Status [T open [~ Authorised [ Released [ Printed [~ Finished ¥ Completed

Start date [ = tof = P Al
End date [ = tof = Al
Order type ‘ All [ |

Display

e Group by item 7

Header

Cost centres ‘ al tol @_‘ ¥ Al

Parson [ B ©f [

Debtor \ B tof Al = an

Including Children [~

Make item [ B ©f [l

Item status ¥ Active I~ Blocked ™ Discontinued ™ Future [T Inactive

Item group [ Bl [ElRC
Lines

Operation \ B tof Al = al

Work centre ‘ al tol @_‘ W Al

Type [¥ Standard [¥ Labour hour ¥ wmachine hour ¥ Fhantom ¥ Bulk issue

Show ¥ Quantity ¥ Preduction Costs [¥ Preduction Revenue ¥ Result [V sSales Revenue ¥ Operaticn

it | s | cioe |

1. Go to Manufacturing - Reports = Actuals to define the criteria for displaying the actual costs of required
production orders. You will see the Header and Lines sections only if you click Advanced.

2. Inthe General section, click Warehouses. Select one or more warehouses and click Select to display the actuals
for production orders which belong to the selected warehouse(s).

3. Type or select a parent project or a range of parent projects at Parent project to display the actuals for production
orders which belong to the selected parent project(s). Select the All check box to display the actuals for production
orders which belong to all parent projects.

4. Type orselecta production order or a range of production orders at Production order to display the actuals for the
selected production order(s). Select the All check box to display the actuals for all production orders.

S. Selectthe Open, Authorised, Released, Printed, and/or Completed check boxes at Status to display the
actuals for production orders with the respective status(es).

6. Type orselecta date or arange of dates at Start date and End date respectively to display the actuals for
production orders with the selected start date(s) and end date(s). Select the All check box to display the actuals for
production orders with any start date and end date.

7. AtOrder type, select All, Production order, or Production order: Disassemble to display the actuals for
production orders that are of the respective type.

8. Inthe Display section, type the number of decimal places to be displayed in the actuals report at Precision.

9. Select the Group by item check box to display the actuals for production orders by grouping production orders by
item codes.

10. In the Header section, type or select a cost center or range of cost centers at Cost centers to display the actuals
for production orders belonging to the selected cost center(s). Select the All check box to display the actuals for
production orders belonging to all cost centers.




11. Type or select an employee ID or a range of employee IDs at Person to display the actuals for production
orders which are entered by the selected people. Select the All check box to display the actuals for
production orders which are entered by anyone.

12. Type or select a customer code or a range of customer code at Debtor to display the actuals for production
orders which are derived from the sales orders of the selected customer(s). Select the All check box to
display the actuals for production orders which are derived from the sales orders of all customers.

13. Select the Including Children check box to display production order actuals that include the children
production orders.

14. Type or select a make item or a range of make items at Make item to display the actuals for production
orders with the defined make items. Select the All check box to display the actuals for production orders
for all make items.

15. Select the Active, Blocked, Discontinued, Future, and/or Inactive check boxes at Item status to
display the actuals for production orders with the respective status(es).

16. Type or select an item group or a range of item groups at Item group to display the actuals for production
orders belonging to the defined item groups. Select the All check box to display the actuals for production
orders for all item codes.

17. Click Assortments, select one or more assortments, and then click Select to display the actuals for
production orders which belong to the defined assortments.

18. Click Selection code, select one or more selection codes, and then click Select to display the actuals for
production orders which belong to the defined selection codes.

19. Inthe Lines section, type or select an operation code or a range of operation codes at Operation to display
the actuals for production orders with the defined operation codes. Select the All check box to display the
actuals for production orders for all operation codes.

20. Type or selecta work center or a range of work centers at Work center to display the actuals for
production orders with the defined work centers. Select the All check box to display the actuals for
production orders for all work centers.

21. Select the Standard, Labour hour, Machine hour, Phantom, and/or Bulk issue check boxes at Type to
display the actuals for production orders with the respective type(s).

22. Select the Quantity, Production Costs, Production Revenue, Result, Sales Revenue, and/or
Operation check boxes at Show to display the actuals for production orders by showing the respective
information.

23. Click Display to display the overview of the actual costs for the selected production orders.

24. Click Close to exit from the Actuals screen.

25. Click Close to exit.

To display planned costs of production orders:

In certain cases, you may need to calculate production cost based on production order data instead of BOM
data. In these situations, you can calculate the planned cost by attaching a scenario to the production order. This
is useful in several situations, such as when:

-  producing products based on customer requirements, or

- thelack of materials or resources requires that the BOM be adjusted in the production order.
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The outcome of a production order cost calculation will not influence the actual cost price of the end product
received as the end cost is dependent on the cost price defined in the item master. However, the scenario can be
used as a tool to calculate expectations of the production results.

. _'Calculation scenario: Production order
Eile Edit Help
NgE|2 |00 |a>|8 @
» Description |
Include: Suborders u
Maximum number of levels All -
Explode: Stock controlled -
Round off to: Batch quantity i
Round off to: Purchase order None -
Make [/ Buy Produce -
Item price: Buy Caost price -
Item price: Make Cost price -
Margin % 0.00
] xX |

Go to Manufacturing - Setup - Scenarios.

Select Production order at Used in.

Click New.

Define the scenario variables in the calculation scenario similar to the BOM calculation scenario.

Select or clear the Include: Suborders check box:

- If the check box is selected, the subassembly item cost price will be calculated using the calculated
suborder cost price. Item price: Make will be disabled and will default to calculated cost price.

- If the check box is cleared, the subassembly item cost price is calculated based on the main order
only, and the suborders are excluded. You can select Cost price or Sales price at Item price: Make.

6. Click Save.

Click Close.

8. Go to Manufacturing - Entries - Production orders and open the production order you want to calculate.
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9. IntheProduction orders screen, click Calculate. The Update: Calculated cost price screen will be

shown.
g 932 Update: Calculated cost price |
Calculation
|]|Sﬂer\ariu| FRO @_|1u% standard production margin |

FRODO0010012.002

Scenario
Include: Suborders ¥
Maximum number of levels
Explode: Stock controlled =
Round off to: Batch quantity [~

Round off to: Purchase urder| Mane

Malke / Buy | Produce |
Itemn price: Buy | Purchase price(Main supplier) |
Item price: Make | Calculated cost price{Main version) |

w M
10. AtScenario, selecta production order scenario.

11. Click Show list. Microsoft Excel will open with two spreadsheets containing the production order
summary and details.

12. Make the necessary changes to the spreadsheets.

13. In Microsoft Excel, click # Exact Globe Next : Update (under the Add-Ins menu bar) to update the
changes.

14. Click OK in the Update box to save the changes to Exact Globe Next.

15. Ifthe cost price is updated correctly, Exact Globe Next will display “Updated: Production orders”. Click
OK. Exact Globe Next will also create a CRM document for the summary sheet of the production order.

16. Close Microsoft Excel to free the data for manipulation in Exact Globe Next. You do not need to save the
Microsoft Excel work book.

17. Inthe Update: Calculated cost price screen, click Close. The Production orders screen will be updated
with the new cost price.
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To display comparisons between planned and actual costs of production orders:

#° Maintain projects - Exact =10l x|
File Edit Help

HeBE|2|4dT00|l-a~v|se

Project PRODD0010003 - Productie voorraad regular okt.
Manager Richard Peters
Status Completed

&} Basics | Planning |@ Activities |‘]= Related |. Members |Q Doc. ;g Rates |Q Hours |‘§ Pur. /Inventory | L Inv. |:‘g Extra |E‘ Log |

BZEWN | 0to | 28/10/2010 [ [ Budget Budget scenario [# Planning 7 Actual

S Include: Children [T Show: Weekend O Scale [—J@ Manthly
JQJH Oct Oct = %o-
| Item |v ‘ 2010 2010 Planning Actual =
Blanning Actual =
Revenue =l
Tatals =
=
Casts !J
Bonen Brazilian Regular 106, 106,
ws|MAA, Malen o o
MACH, Machine malen 200 200
[ k| vER0002. Folie 11 11
Etiket voor 7 7
| VER0004, Etiket achter 7 7
Zak Regular 3 3
Totals 334 334
wip 135 135
Result 334 334 o
Result + WIP 135 1:%
| -

1. Goto Projects - Projects - Maintain projects to define the criteria for displaying the comparisons
between the planned and actual costs of production orders.

Select the Production check box at Type to display projects which are of type Production.

Select the Completed check box at Status to display projects which are completed.

Click Search to display projects of type Production which are completed.

Select a production project which is listed, and then click Open to display the project maintenance.
Go to the Planning tab and select the Planning and Actual check boxes. Click Refresh to display
information of the production project for both planning and actual.

7. Click Close to exit.

S




To display the overview of production orders:

£ 932 Production orders - Exact

Eile Edit Help
& e
PRODO0010000 MCB0003 MacBean Dark | 25.00000000 | 25.00000000 135.25 -
PRODO0010001 MCBODD4 MacBean Extra Dark 25.00000000 25.00000000 kg

PRODO0OD10002 MCEB000Z MacBean Mild 25.00000000 25.00000000 kg

FRODO0010003 MCB0001 MacBean Regular 25.00000000 25.00000000 kg

PRODO0D10007 MCBEDEMOPAKKET Demonstratie set 1.00000000 1.00000000 stuk 33.00 33.00

PRODO0010007.001 MCBO001 MacBean Regular 1.00000000 1.00000000 kg 5.41 5.41

FRODO0010008 MCBDEMOPAKKET Demonstratie set 10.00000000  10.00000000 stuk 330.00 330.00

PRODO00D10009 MCB0002 MacBean Mild 10.00000000 10.00000000 kg 54.10 54.10

PRODO0D10011 MCB0001 MacBean Regular 22.00000000 22.00000000 kg 119.02 119.02
PRODO001000 PRODO00D10006.001 MCBO0O01 MacBean Regular 30.00000000 30.00000000 kg 162.30 162.30 -
4 3

~ Budgeted 264 [tems
. Actual 264 Items
Budgeted 1,731.73 EUR

[27;10;1:1]¢[ Ves ]¢[ Ves ]¢[ Ves ]¢[23;10;1q¢[27f10;1q¢[ Ves ]¢[27;10;1:1]¢ Actual 1,731.73 EUR

e, 0 = 0 s T B .z I & I % I & I % |

1.  Go to Manufacturing - Reports - Production orders to define the criteria for displaying an overview of
production orders.

2. Inthe General section, click Warehouses. Select one or more warehouses and click Select to display
production orders which belong to the selected warehouse(s).

3. Type or select a parent project or a range of parent projects at Parent project to display production orders
for the selected parent project(s). Select the All check box to display production orders for all parent
projects.

4. Type orselecta production order or a range of production orders at Production order to display the
selected production order(s). Select the All check box to display all production orders.

S. AtStatus, select the Open, Authorised, Rejected, Released, Printed, and/or Completed check boxes
to display production orders with the respective status(es).

6. Type orselecta date or arange of dates at Start date to display production orders with the selected start
date(s). Select the All check box to display production orders with any start date.

7. AtOrder type, select All, Production order, or Production order: Disassemble to display the
respective type of production orders.

8. Inthe Display section, type the number of decimal places to be displayed in the production orders report
at Precision.

9. Select the Group by item check box to display the report by grouping production orders by items.

10. Inthe Header section, type or select a cost center or a range of cost centers at Cost centers to display
production orders for the selected cost center(s). Select the All check box to display production orders for
all cost centres.

11. Type or select an employee ID or a range of employee IDs at Person to display production orders which
are entered by the selected people. Select the All check box to display production orders which are entered
by anyone.

12. Type or select a customer code or range of customer codes at Debtor to display production orders
which are derived from the sales orders of the selected customer(s). Select the All check box to display
production orders which are derived from the sales orders of all customers.

13. Select the Including Children check box to display production orders that include the children
production orders.

14. Type or select a date or a range of dates at End date to display production orders with the selected end
date(s). Select the All check box to display the production orders with any end date.
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Type or select an item code or a range of item codes at Make item to display production orders for the
selected item code(s). Select the All check box to display production orders for all item codes.

Type or select an item group or a range of item groups at Item group to display production orders with
items belonging to the selected item group(s). Select the All check box to display production orders with
items belonging to all item groups.

Click Assortments, select one or more assortments, and then click Select to display production orders
with items belonging to the selected assortment(s).

Click Selection code, select one or more selection codes, and then click Select to display production
orders belonging to the selected selection code(s).

In the Lines section, type or select an item code or a range of item codes at Item code to display
production orders for the selected item code(s). Select the All check box to display production orders for
all item codes.

Click Warehouses, select one or more warehouses, and then click Select to display production orders
with order lines items which belong to the selected warehouse(s).

Type or select a date or a range of dates at Start date and End date respectively, to display production
orders with order lines with the selected start date(s) and end date(s). Select the All check box to display
production orders with order lines with any start date or end date.

Type or select an operation code or a range of operation codes at Operation to display production orders
for the selected operation code(s). Select the All check box to display production orders with order lines
for all operation codes.

Type or select a work center or a range of work centers at Work center to display production orders for the
selected work center(s). Select the All check box to display production orders with the order lines for all
work centers.

At'Type, select the Standard, Labour hour, Machine hour, Phantom, and Bulk issue check boxes to
display production orders with the respective type(s).

In the Planner section, type or select an employee ID at Planner to display production orders which are
planned by the defined person. Select the All check box to display production orders which are planned by
anyone.

Click Display to display the overview of the selected production orders.

Click Close to exit from the Production orders screen.
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3. Materials Management

Managing materials, such as part items and subassembly items, ensures a consistent supply of materials to the
demands arriving from the production floor. Besides managing materials required by the production floor, you
must also manage items that are demanded by your customers, which are the end products. Before producing or
purchasing materials, the shop floor planner, along with the warehouse staff and the production planner, must
find out whether there are sufficient raw materials, parts, labor hours, machine hours, or even subassembly
items ready to enter the production floor in order to produce the end products. If there is a shortage, then the
shop floor can be planned and the required items can be replenished to avoid delays or disruptions in producing
the end products.

Materials management ensures a smooth flow of all production processes, which prevents the shortage of
required items and hours. Thus, a manufacturing organization that practices proper materials management can
be assured of an efficient completion of the end products and timely delivery of end products to the warehouse.
Timely delivery to the warehouse assures timely delivery to customers. When the customer’s delivery date is
met, then customer satisfaction is guaranteed.

Successful and timely production delivery also ensures that any concerns, such as a faulty item, can be detected
and corrective measures taken even before the delivery of the end products to the customers.

There are two scenarios or types of environments within a manufacturing industry in producing the end
products. The scenarios are make-to-stock and make-to-order. In a make-to-stock environment, materials
management suggests that the planning of item requirements is done at factory level for a certain period of
time. In a make-to-order environment, materials management suggests that the planning of item requirements
is done at item level or at the customer’s order level. These two environments are driven by the business
attributes of the items, which are stock controlled and order controlled. In the make-to-stock environment, the
end products are produced to meet the shortage of the warehouse or factory. This means that the production
requirements are derived from the demands of the warehouses or factories. In comparison, the end products
for the make-to-order environment are produced to meet the demands deriving from sales orders, which are
the customers’ demands.

The following topics are relevant to materials management:
—  Managing materials at factory or warehouse level

—  Managing materials at order or item level




3.1 Managing Materials at Factory or Warehouse Level

Itis important that a manufacturing organization has an overall picture of the planning of materials required in
the production at a factory or warehouse level. In a make-to-stock environment, the complexity of the material
flows is usually high and there is usually low flexibility in adjusting the capacity to the demand. Lead times

are usually long and stock is used to bridge the gap between supply and demand or is a result of producing in
batches to optimize capacity bottlenecks or to reduce set up costs. In order to balance predicted capacity and
demand for a certain period of time, a plan for the whole factory or warehouse is needed. A balanced number
and mix of end products that satisfy the demand and capacity in a certain period is agreed between sales

and production; this is the Master Production Schedule (MPS). This MPS can serve as input for the Material
Requirements Planning (MRP) engine, providing a production and purchase planning that can then be viewed
using the pegging report. Via the production and purchase advice, you can generate the actual production

and purchase orders based on this planning. After this, you can view the actual production planning and
requirements in the MRP overviews.

The following topics are relevant to managing materials at factory level:

- Planning Master Production Schedule (MPS)

- Configuring and generating production requirements with the MRP engine

-  Overview of MRP engine results with the pegging report

- Generating production planning with production advice

-  Overview of Material Requirements Planning (MRP) at factory or warehouse level

3.1.1 Planning Master Production Schedule (MPS)

You can plan and manage your materials at a higher security level view orata 101 view at the factory or
warehouse level using the MPS functionality. Within MPS, you can plan materials requirements for a specific
warehouse within a budget scenario, for a certain period of time, and for a range of items. MPS is a forecast of
what is required in the future within the factory or warehouse.

r‘i Manufacturing / Planning / Master Production Schedule

Layout
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To plan MPS:

1. Go to Manufacturing - Planning - Master Production Schedule to define the criteria for MPS.

In the Layout section, type or select the relevant warehouse for which you want to plan at Warehouse.
This is mandatory.

3. AtBudget scenario, type or select the year for which you want to populate the plan. This is mandatory.
Selecting the budget scenario will automatically define the Plan period.

4. Inthe Range section, define the range of dates, years, months, and weeks at Date, Year, Month, and
Week respectively to plan for materials within the selected period of time. Select the All check box to plan
for all ranges of dates, years, months, and weeks.

S.  Under the Filter section, type or select a range of item groups and items at Item group and Item
respectively to plan materials for items within the selected range of item groups and items. Select the All
check box to plan for items within all ranges of item groups and items.

6. Inthe Show section at Column width, select Standard or 150% to display the Master Production
Schedule screen with the respective column width. You can also click Excel to generate MPS in Microsoft
Excel.

7. Toplan directly in the Exact Globe Next application, click Start. You will see the Master Production
Schedule screen displayed based on the selected criteria.

8. Inthe Master Production Schedule screen, plan for each listed item by typing in the required quantity
in each date column displayed.

9. Click Close to save and exit.

3.1.2 Configuring and generating production requirements with the MRP engine

You can generate production requirements using the MRP engine. Within the MRP engine, you can define

a specific scenario by configuring a number of criteria, such as the range of items, item attributes, to include

or exclude warehouses, consider requirements deriving from various orders and requests, to base on MPS
planning, and whether you want to include labor and machine hours. This defined MRP engine scenario can be
processed and this will generate the production requirements in the back-end which can be used in the pegging
report, production advice, resource planning, and machine planning.




IRP engine : Scenario
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To configure and generate MRP engines:

Go to Manufacturing - Planning - MRP engine. You will see the MRP engine : Scenario screen.

Type a code for the MRP engine scenario at Scenario: MRP. This is mandatory.

Type a description for the MRP engine scenario at Description. This is mandatory.

In the Assortments section at Assortment, click Select. You will see the Assortments screen.

Click on a required assortment to highlight it. You can also highlight multiple assortments by pressing

the SHIFT or CTRL key while clicking on the required assortments. Alternatively, double-click on the

assortment to select the particular assortment. Then, click Select.

Click Close after selecting the required assortments.

7. Inthe Items section, define the following criteria:

- Type or select one or a range of item codes to generate the production planning for the selected items
atItem code. Select the All check box to generate the production planning for all items.

- Select Yes, No, or All at Stock controlled to generate the production planning for only stock

IS .
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controlled items, only order controlled items, or both stock and order controlled items
respectively. This field is enabled if the Requirements only check box under the Additional
criteria section is selected.

- Select Yes, No, or All at Sales to generate production planning for sales items, non-sales items, or
all types of items respectively.

8. Inthe Warehouses section, define the following criteria:

- AtInclude, click Select and select the warehouse that you want to include in generating the
production planning. You can highlight multiple warehouses simultaneously by pressing SHIFT or
CTRL while clicking on the required warehouses. Alternatively, double-click on the warehouse to
quickly select the warehouse. Then, click Select. Click Close after selecting the required
warehouse(s) that you want to include.

- At Exclude, click Select and select the warehouse that you want to exclude in generating the
production planning. You can highlight multiple warehouses simultaneously by pressing SHIFT or
CTRL while clicking on the required warehouses. Alternatively, double-click on the warehouse to
quickly select the warehouse. Then, click Select. Click Close after selecting the required
warehouse(s) that you want to exclude.

9. Inthe Requirements section at Sales order, Internal use, Purchase orders, Quotations, and
Production orders, select Authorised, Not Authorised, or All to generate the production planning
based on the respective requirements. Select None at the respective requirement if you do not want to use
the requirement.

10. Inthe Master schedules section, click the Select button at Schedule to select a budget scenario to
generate the production planning for the selected budget scenario.

11. Inthe Additional criteria section, define the following:

- AtMake/Buy, select Buy or Make to generate the production planning for items that are bought or
produced.

- At Capacity, select either Plan or Buy to generate the production planning for planning capacity or
purchasing capacity. This field is enabled if the Include: Labor hours and/or Include: Machine
hours check boxes are selected.

- Select the Total on main warehouse check box to sum the total of all orders and requirements
of the selected warehouses into the main warehouse. If there is a shortage, advice is provided at the
main warehouse of the item. Other factors that will have an impact on the advice, such as the
order policy code, purchase order size, and production batch size, will be based on the settings of the
main warehouse of the item.

- Select the Allow planning prior to today check box to allow the advice date to fall on a date thatis

before today’s date.

- Select the Requirements check box to generate the production planning based on requirements
only.

- Select the Purchase order level check box to generate the production planning based on purchase
order level.

- Select the Include: Labour hours check box to generate the production planning that includes
labour hour requirements.

- Select the Include: Machine hours check box to generate the production planning that includes
machine hour requirements.

- Select the Include: Production safety day check box to include the production safety day in the
calculations of the production start and end dates.

- Select the Include: Internal delivery days check box to include the warehouse lead time in the
calculations of the production start and end dates, as well as the purchase order date and delivery
date.




12. Click Save to save the defined MRP engine scenario.
13. Click Process to generate the production planning.
14. Click Close to exit.

Note: Some fields are disabled if the Requirements check box in the Additional criteria
section is not selected.

3.1.3 Overview of MRP engine results with the pegging report

The results of the production requirements that are generated with the MRP engine can be viewed in the
pegging report. The pegging report displays the overview of production requirements based on the production
advice, purchase advice, resource planning, and machine planning. Each of these requirements will be shown
as per item code and total required quantity. It is possible to view the breakdowns of the total required quantity
by choosing to view the single level which derives requirements of the item from one level up in the BOM
structure.

The pegging report can be viewed based on a specific MRP engine scenario and you may choose to view by a
single level or full level. In the overview results, the sources of a requirement are also shown and it is possible
for you to retrieve the requirement, which is the production order itself in the full level view. The pegging
report basically works hand in hand with the MRP engine, which generates the production requirements and
displays the results in the pegging report.

[ /MAG Manufacturing / Reports / Pegging
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To view pegging reports:

1. Go to Manufacturing - Reports - Pegging to define the criteria for the pegging report.

2. Inthe Filter section, click Warehouses and you will see the Warehouses screen. Select one or more
warehouses and click Select to display the production requirements for items belonging to the selected
warehouse(s). Click Close to exit from the Warehouses screen.

3. Next, click Assortments and you will see the Assortments screen. Select one assortment or more, and
then click Select to display the production requirements for items belonging to the selected assortment(s).
Click Close to exit from the Assortments screen.
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Type or select an item code or a range of item codes at Item to display the production requirements for the
selected item(s). Select the All check box to display the production requirements for all items.
Type or select a date or range of dates at Required to display the production requirements for items
required by the selected date(s). Select the All check box to display the production requirements for items
required by any date.
Type or select an employee ID at Planner to display the production requirements for items planned by
the selected person. Select the All check box to display the production requirements for items planned by
everyone.
Select Make, Buy, or All at Make/Buy to display the production requirements for items that are
produced, purchased, or both.
Select one of the following options at Stock controlled:
- Order controlled — This option displays the production requirements for items that are
produced due to order demands.
- Stock controlled — This option displays the production requirements for items that are
produced due to stock demands.
- All — This option displays the production requirements for items that are produced due to order
demands and stock demands.
In the Options section, select the Based on MRP check box to display the production requirements for
items based on MRP. This will enable MRP engine: Scenario.
Type or select a scenario at MRP engine: Scenario to display the production requirements for items based
on the selected MRP scenario.
Select the Show: Serial/batch numbers check box to display the production requirements for items by
displaying the serial or batch numbers. This check box will be disabled if you select the Based on MRP
check box.
At Output, select Single level or Full level to display production requirements for a single level BOM
structure or a full level BOM structure.
Type the number of decimal places between zero and eight at Precision to display production
requirements for items by showing the quantity with the entered precision.
Click Display to display the overview of pegging report. You can also click Excel to display the pegging
report in Microsoft Excel.
Click Close to exit.




3.1.4 Generating production planning with production advice

You can generate production orders (planning) based on the suggested production advice which is derived
from the MRP engine generation of production requirements. The production advice allows you to calculate
the production requirements based on either MRP or stock positions. In relation with managing materials

at the factory level, you should view the production requirements based on the MRP calculations which are
derived from the generated production requirements by the MRP engine at Manufacturing - Planning > MRP
engine. As more than one scenario is used in running the MRP engine, you can define the specific scenario in
the production advice application, which will then display your intended production requirements.

From here, you can choose to produce the requirements of items from a suggested list of BOM structure
versions for the items. In the advice or suggestion screen, you can select one or more variances of versions
and enter the quantity that you want to produce, and then choose to produce, whereby depending on your
selection, one or more production orders will be automatically generated.

The generated production orders can then be accessed for the next consecutive steps; authorization, release,
print, issue, receive, and completion at Manufacturing = Entries » Production orders.
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To generate production orders with production advice:

1. Go to Manufacturing - To be processed - Production advice, and then define the criteria for generating a
production order with production advice.

2. Select MRP at Calculation to display the production requirements which are calculated with the MRP
engine.

3. Inthe Selection section, click Warehouses and select one or more warehouses to display the production
requirements for the selected warehouse(s).

4. Click Assortments and select one or more assortments to display the production requirements for items
belonging to the selected assortment(s).

S. Type orselecta scenario at MRP engine: Scenario to display the production requirements based on the
selected MRP engine scenario. This information is mandatory.

6. Typeorselectan item orarange of items at Item, to display the production requirements for the selected
item(s). Select the All check box to display the production requirements for all items.
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7. Type or selectan employee ID at Planner to display the production requirements for items which are
planned by the selected person.

8. Click Display to display the production requirements. You will see the Item management: Planning
screen. The requirements for the end products on the date that the end products are needed will be
displayed.

9. Selectarequirement cell which you want to fulfill and click Produce. You will see the Generate
production orders screen. A list of BOM versions of the item will be shown with the shortage quantity
and advice quantity.

10. Under the Selected column, double-click on the BOM version to select the BOM version which you want
to produce. Type the quantity which you want to produce under the Advice column. By default, this
quantity is automatically defined.

11. Click Produce to generate the production order(s) for the selected BOM version with the entered advice
quantity.

12. The generated production order(s) will be displayed in the Created: Order screen. Select the production
order and click Open to view or modify the production order.

13. Click Close to exit.

3.1.5 Overview of MRP at factory or warehouse level

You can obtain the actual planning and requirements of production orders and purchase orders using MRP.
Within MRP, it is also possible to obtain the available stock levels of items that are tracked from the incoming
and outgoing stock of items, derived from transactions such as quotations, sales, internal requests, material
issues, purchases, and inter-branch transfers.

[} 932 item management: Planning - Exact
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To display MRP planning:

1.  Go to Manufacturing - Planning - MRP. You will see the Item management: Planning screen.

2. Click Advanced to define the advanced filter criteria to display the required information about MRP. For
more information, see Defining advanced criteria for MRP following this procedure.

3. Click Warehouses to select one or more warehouses to display MRP for the selected warehouse(s), and
then click Close to close the Warehouses screen.

4. Type the number of days at View to display MRP for the defined number of days.

Type or select a date or range of dates at From and to, to display MRP for the selected date or range of dates.

6. Click[™lor@/at Scale to switch the display modes between Daily, Weekly, Monthly, and Yearly.

u




Selectany one of the following at Content:

Orders/ Requirements — Select this option to display MRP based on the production order
requirements. Then, at View, select Quantity or Amount to display MRP by showing the quantity
oramount.

Available — Select this option to display available stock movements derived from incoming and
outgoing transactions for items.

Purchase — Select this option to display MRP based on the purchase order requirements.

Pegging — Select this option to display an overview of pegging. This option is available only at
Manufacturing - Planning - MRP, Inventory - Item management - MRP, and Projects >
Planning > MRP

Click Refresh to display MRP based on the defined criteria.
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Defining advanced criteria for MRP

You can define advanced selection criteria for the Item management: Planning screen by clicking Advanced
as described in the procedure. After defining the advanced selection, click Select to save the defined selections
and close the selection screen. You can also click Close to exit without making any changes to the advanced
selections or click Default to revert to default criteria.

The various selection criteria can be saved as separate templates to be reused. The templates can also be shared
with other users. You can create, edit, open, delete, import, and export templates from the File menu.
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Filter section
Assortments

Click Select, and then click on an assortment to highlight it. You can highlight multiple assortments
simultaneously by pressing SHIFT or CTRL while clicking on the required assortments. Alternatively, double-
click on the required assortment to quickly select the assortment. Then, click Select. The Select button will be
checked when an assortment is selected.

Item
Type or select an item code or a range of item codes to display MRP for the selected item code(s). Select the All

check box to display MRP for all items.

Planner
Type or select a person to display MRP which was planned by the selected person. Select the All check box to

display MRP which are planned by anyone.

Sales
Select Sales, Internal, or All to display MRP for sales items, internal use items, or both sales and internal use

items respectively.




Make/ Buy
Select Buy, Make, or All to display MRP for items that are bought, made, or both bought and made
respectively.

Stock
Select Order controlled, Stock controlled, or All to display MRP for items that are order controlled, stock
controlled, or both order and stock controlled.

Person
Type or select an employee ID or a range of employee IDs to display MRP for the selected people. Select the All
check box to display MRP for anyone.

Type (drop down list)
Select All, Quotations, Sales orders, or Internal use to display MRP for all types of transactions, quotations,
sales orders, or internal use requests respectively.

Project
Type or select a project code or a range of project codes to display MRP for the selected project(s). Select the All
check box to display material requirements planning for all projects.

Order

Type or select a sales order number or a range of sales order numbers to display MRP for the selected sales
order(s). Select the All check box to display MRP for all sales orders. By default this is disabled. To enable this,
select Sales orders at Type (drop-down list).

Supplier
Type or select a supplier code or a range of supplier codes to display MRP for the selected supplier(s). Select the
All check box to display MRP for all suppliers.

Customer
Type or select a customer code or a range of customer codes to display MRP for the selected customer(s). Select
the All check box to display MRP for all customers.

Type (check boxes)
Select the Standard, Machine hour, Labour hour, and/or Bulk issue check boxes to display MRP for
standard items, machine hour items, labor hour items, and bulk issue items respectively.

Transactions section

Quotations

Select the Not Authorised and/or Authorised check boxes to display MRP for quotations that are not
authorised and/or authorised. Select the Exclude Expired check box to exclude expired quotations in the
MRP view. Click Select to activate one or more selection codes to display MRP for quotations that are within
the activated selection codes.

Sales orders

Select the Not Authorised and/or Authorised check boxes to display MRP for sales orders that are not
authorised and/or authorised. Click Select to activate one or more selection codes to display MRP for sales
orders that are within the activated selection codes.
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Internal use

Select the Not authorised and/or Authorised check boxes to display MRP for internal use requests that are
notauthorised and/or authorised. Click Select to activate one or more selection codes to display MRP for
internal use requests that are within the activated selection codes.

Production orders

Select the Not authorised and/or Authorised check boxes to display MRP for production orders that are
notauthorised and/or authorised. Click Select to activate one or more selection codes to display MRP for
production orders that are within the activated selection codes. Select the Released check box to display
production orders which are already released.

Purchase orders

Select the Not Authorised and/or Authorised check boxes to display MRP for purchase orders that are not
authorised and/or authorised. Click Select to activate one or more selection codes to display MRP for purchase
orders that are within the activated selection codes.

Forecast

Select the Authorised check box to display MRP for authorised forecasts (such as the MPS). This will enable
Budget scenario. By default this is disabled. To enable the Forecast check box, in the Item management:
Planning screen, select Items in the first column drop-down list which is enabled when you select Orders/
Requirements at Content.

Budget scenario
Type or select the budget scenario to display MRP for forecasts which are planned in the budget scenario. This
check box is enabled only if the Forecast check box is selected.

View section

Adjust the vertical bar to the respective colored boxes to display MRP for transactions which are completed, at
fulfillment proposal, fully allocated, or for purchase advice.

Show section

Fulfillment date<Date

Select this check box to display a column for the quantity of items with a fulfillment date before the “from date”
in the MRP view. With this setting disabled, the unfulfilled requirements before this date are no longer taken
into account, such as in calculation of free stock.

Fulfillment date>Date

Select this check box to display a column for the quantity of items with a fulfillment date after the “to date” in
the MRP view. With this setting disabled, the unfulfilled requirements after this date are no longer taken into
account, such as in the calculation of free stock in MRP.

Requirements only
Select this check box to display MRP that shows requirements only. Clear this check box to show all items in
the selection.




Include: Completed<Date
Select this check box to display MRP that includes requirements which are completed before the current date.
This is enabled only if the Fulfillment date<Date check box is selected.

Stock: Unallocated
Select this check box to display a Free stock column for the quantity of items which are not allocated to any
requirements.

Discontinued: Items
Select this check box to display MRP that includes discontinued items.

Time of delivery
Select this check box to display a column for time of delivery for each item.

PO: Unallocated
Select this check box to display a column for the quantity of items which are not allocated to purchase orders.

PrO: Unallocated
Select this check box to display a column for the quantity of items which are not allocated to production orders.

Precision
Type a decimal number to display the quantity of items according to the defined decimal number.

Unit
Select Sales unit to display the quantity of items in sales unit of measurement. Select Purchase unit to display
the quantity of items in purchase unit of measurement.

Column: Width
Select Standard to display the columns in standard width. Select 150% to display columns 50 percent wider.
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3.2 Managing Materials at Order or Item Level

The Customer Order Decoupling Point (CODP) defines the typology of a manufacturing environment:

Before the customer order decoupling point (CODP), the items are generally stock controlled and after the
CODP, the items are order controlled. To perform correct order acceptation and meet the demands from
accepted sales orders, you have to order the order controlled items and check the stock controlled items to
determine whether there are sufficient stock quantities. After having checked for the availability of stock for
these items, any insufficient quantity can be purchased or produced accordingly. This ensures stocks of items
are continuously replenished and orders are fulfilled at the required quantity and time.

The following topics are relevant to managing materials at order or item level:
- Overview of production requirements

- Overview of gross requirements

—  Overview of production capability

-  Overview of MRP at order or item level

3.2.1 Overview of production requirements

In production requirements, you can obtain the items requirements at the level of a specific production order. It
is possible for you to obtain the report based on specific criteria, such as items that are purchased, items that are
produced, or for all items that are quoted within the production order.




Another possibility is that you can define the intended items requirements based on specific warehouses by
considering the BOM structure levels and waste percentage which is defined for the item in the BOM structure.
Any shortage of quantity for the items within the production order will be shown in this report. Upon
obtaining this report, you can choose to produce make items and purchase the buy items, in order to fulfill the
production order requirements.

E Manufacturing / Planning / Production requirements
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To display production requirements:

1. Go to Manufacturing - Planning - Production requirements, and then define the criteria for displaying
the production requirements.

2. Inthe Filter section, type or select the production order number at Production order. This is mandatory.

3. AtMake/Buy, select All, Make, or Buy to display the production requirements for items which are
produced and purchased, produced only, or purchased only.

4. Inthe Transactions section, click Part warehouse. You will see the Part warehouse screen.

5. Click on a warehouse to highlight it or double-click on a warehouse to select it. You can highlight
more than one warehouse simultaneously by pressing SHIFT or CTRL and clicking on the intended
warehouse(s). Then, click Select.

6. Click Close to exit from the Part warehouse screen.

7. Select the level of BOM for the make item at Explode: Maximum number of levels to display
production requirements for the make item based on the selected BOM level.

8. Select the Include: Waste check box to include waste percentage of the BOM part item of the production
order when calculating production requirements.

9. Select the Show only: Shortage check box to display only part items with shortage quantity in the
production requirements results.

10. Type the number of decimal places between zero and eight at Precision to display the shortage quantity
which will be displayed in the production order requirements.

11. Click Display to display the production requirements results based on the selected criteria.
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Note:  Based on the shortage quantity, you can choose to produce or buy the items by clicking
Produce or Purchase in the Production requirements screen. To export the displayed
results to Microsoft Excel, click Excel.

3.2.2 Overview of gross requirements

The gross requirements report allows you to obtain a list of materials, such as part items, subassembly items,
and raw materials that are required for a certain number of end products. You can specify one or more end
products for which you want to obtain the gross requirements. It is possible that you filter the kind of items
that you want to obtain the requirements for, such as items that are purchased, produced, or all items within
the BOM structure of the specified end products. You can also define the filters to take into consideration the
requirements of items for a certain level of BOM and include the waste percentage defined for the items in the
BOM for the end products.

Any shortage of these required materials for the end products will be displayed in the results of this report.
Based on the results, you can decide to define purchase orders for buy items and/or define production orders
for make items. Besides this, you can also export the entire list of reports to Microsoft Excel for further data
analysis and data manipulation.

EB Manufacturing / Reports / Gross requirements
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To display gross requirements:

1.  Go to Manufacturing - Reports > Gross requirements, and then define the criteria for displaying the
gross requirements.

2. Inthe Filter section, type or select one or a range of make item codes at Make item to display the gross
requirements for the selected make items. Select the All check box to display gross requirements for all
items.

3. AtMake/Buy, select All, Make, or Buy to display the gross requirements for items which are produced
and purchased, produced only, or purchased only.

4. Type orselecta warehouse code at Warehouse to display the gross requirements for items belonging
to the selected warehouse. By default, the All check box will be selected if no warehouse code has been
defined.




o

Type or select a date at End date to display the gross requirements for items with the selected end date.

6. Type the required quantity of items at Quantity required to display the gross requirements for items

with the entered required quantity. This is mandatory.

In the Transactions section, click Part warehouse. You will see the Part warehouse screen.

8. Click on a warehouse to highlight it or double-click on a warehouse to select it. You can highlight
more than one warehouse simultaneously by pressing SHIFT or CTRL and highlighting the intended
warehouse(s). Then, click Select.

9. Click Close to exit from the Part warehouse screen.

10. Select the level of BOM for the make item at Explode: Maximum number of levels to display the gross
requirements for the make item based on the selected BOM level.

11. Select the Include: Waste check box to include waste percentage of the BOM make item when calculating
the gross requirements.

12. Select the Show only: Shortage check box to display the gross requirements for only items with shortage
quantity.

13. Select the To be delivered: Not allocated and To be received: Not allocated check boxes to display the
columns in the gross requirements results.

14. Type the number of decimal places at Precision to display the shortage quantity which will be displayed
in the gross requirements.

15. Click Display to display the gross requirements results based on the selected criteria.

N

3.2.3 Overview of production capability

Within the production capability report, you can obtain a report on whether or not certain end products

are ready to be manufactured. This is a report to see whether it is possible to manufacture an end product

by considering its requirements of items, such as raw materials, part items, and subassembly items. You can
choose to obtain the production capability for one or more end products that belong to a specific warehouse or
all warehouses. You can also indicate a certain criteria, such as the end date of the item to consider only items
for the specified end date when generating the production capability.

Similarly with other reports that are at order and item levels, you can define the level of BOM which Exact
Globe Next should derive the requirements of items from and also whether to include the percentage of waste
defined for the items in the BOM structure of the end product. You can generate this production capability
whenever there is a request from customers requesting for an end product at a certain time. Then, upon
obtaining the results of this report, you can advise the customers the possibility of meeting their requirements.




Filter
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Manufacturing / Reports / Production capability

Make item | @_| I:o| @_| ¥ Al

Make/Buy
W’arehnuse| @_l | v Al End date

ctions

Explode: Maximum number of levels

Include: Waste I~
Show only: Production capability = 0 [~

To be delivered: Not allocated I~
To be received: Not allocated I~

oy choe

To display production capability:

1.

10.

11.
12.

Go to Manufacturing - Reports > Production capability, and then define the criteria for displaying the
production capability.

In the Filter section, type or select an item code or a range of item codes at Make item to display the
production capability for the selected make item(s). Select the All check box to display the production
capability for all make items.

AtMake/Buy, select All, Make, or Buy to display the production capability for items which are produced
and purchased, produced only, or purchased only.

Type or select a warehouse code at Warehouse to display the production capability for items belonging to
the selected warehouse.

Type or select an end date at End date to display the production capability for items with the selected end
date.

Under the Transactions section, select the level of BOM for the make item at Explode: Maximum
number of levels to display the production capability for the make item based on the selected BOM level.
Select the Include: Waste check box to include waste percentage of the BOM make item when calculating
production capability.

Select the Show only: Production capability > O check box to display only items with the production
capability.

Select the To be delivered: Not allocated and To be received: Not allocated check boxes to display the
columns in the production capability results.

Type the number of decimal places at Precision to display the production capability with numeric values
by the defined decimal numbers.

Click Display to display the production capability results based on the selected criteria.

Click Close to exit.




3.2.4  Overview of MRP at order or item level

Within MRP, you can obtain the requirements per production order at an item level. To obtain requirements
atan order level, you must choose to view orders or requirements in the content. You can choose to view

the results of the orders or requirements in the MRP overview as per item, person, project, supplier, order,
and customer. Each of the requirements for the end product shown as per order can be expanded to view the
detailed requirements, such as the quantity fulfilled, allocated order quantity, and allocated stock or reserved
stock quantity across the required dates.

2 Item management: Planning - Exact
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To display MRP:

1.  Go to Manufacturing - Planning - MRP. You will see the Item management: Planning screen.

2. Click Advanced to define the advanced filter criteria to display the required information about MRP. For
more information, see 3.1.5 Overview of MRP at factory or warehouse level - Defining advanced criteria for
MRP.

3. Click Warehouses to select one or more warehouses to display MRP for the selected warehouse(s), and
then click Close to exit from the Warehouses screen.

4. Type the number of days at View to display MRP for defined number of days.

S. Type orselecta date or a range of dates at From and to to display MRP for the selected date or range of
dates.

6. Select Orders/ Requirements at Content to display orders and requirements in MRP. When this option

is selected, the View field will be enabled.

AtView, select Quantity or Amount to view either orders or requirements in MRP.

8. Click[=/or @ at Scale to switch the display modes between Daily, Weekly, Monthly, or Yearly.

N
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3.2.5 Overview of date exceptions

Exact Globe Next can advise on realistic fulfillment dates when generating production orders. However, certain
circumstances can occur during production, such as the delay in receiving materials, machines breaking down,
or changing of plans due to a rushed order. In these circumstances, the fulfillment dates may no longer be
realistic although the orders are still allocated. Using the Date exceptions overview, users can see which orders
have unrealistic fulfillment dates or are causing other orders to have unrealistic dates.

E 932 Date exceptions - Exact
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To display the overview of date exceptions:

1. Go to Manufacturing - To be processed > Date exceptions.

2. Select one of the order types at Type and define the other filter criteria as necessary.

3. Click Display. The Date exceptions screen displayed shows an overview of all orders of the selected type
with unrealistic fulfillment dates, or are causing unrealistic fulfillment dates to linked orders. To view the
report in Microsoft Excel with advised fulfillment dates based on linked orders, click Excel.

4. Selectaline, and then click Details to zoom into the selected order for further details on the production
order and allocated order.

S. Selectaselected or linked order and click one of the buttons to perform relevant actions, such as changing
the delivery date of the order to the advised fulfillment date (Change) or breaking the allocation of the
selected order and allowing the fulfillment via other means, such as from free stock (Unallocate). You can
also open and modify the selected or linked order by clicking Order or Linked order.

Note:  The date exceptions overview looks only at problems in allocated orders. Other issues,
such as stock issues or generation of orders, can be checked from other functions such as
Manufacturing - Planning > MRP.
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4. Planning

Prior to the production of an end product, the required hours, such as labor hours and machine hours must
be planned to ensure a smooth flow of the production process. Planning of hours and allocation of available
capacity of hours to the required production floor prevent disruptions and delays in the production process.
Any shortage or fallback can be encountered earlier and corrective measures can be taken. These corrective
measures include swapping or allocating available people and machines to orders that have a requirement.

Planning and allocation of hours for both labor and machines can be done at two levels, namely the order level
and factory or warehouse level.

The following topics are relevant to planning:
—  Planningat factory or warehouse level
—  Planningat order level

4.1 Planning at Factory or Warehouse Level

You can plan labor hours and machine hours at the factory or warehouse level to obtain a higher level view of
the planning schedule and requirements.

The following topics are relevant to this section:

—  Planning labor hours at factory or warehouse level

—  Planning machine hours at factory or warehouse level

4.1.1 Planning labor hours at factory or warehouse level

You can plan labor hours at Manufacturing = Planning - Resource planning. To plan labor hours, you must
obtain the overview of planning and requirements of the labor hours. To obtain this view and planning, the
following procedures are required:

- Defining the Resource planning section

- Defining the Tasks / Requirements section

-  Allocating planning of labor hours to requirements

=
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To define the Resource planning section:

1.
2.
3.

10.

11.

12.

Go to Manufacturing - Planning - Resource planning. You will see the Person: Planning screen.

In the Resource planning section, click Advanced. You will see the Selection screen.

In the Filter section, click Select at Project, Job groups, Person, Assortment, and Activity to display

the intended capacity of labor hours of people belonging to the selected projects, job groups, people,

assortments, and activities respectively. In the respective screens, click on the required item to highlight

it. You can also highlight multiple items by pressing SHIFT or CTRL while clicking on the required codes.

Alternatively, double-click on the item to select the particular item. Then, click Select to select the item(s),

and Close to exit. Selecting all items or none will display the intended capacity of labor hours of people for

any project, job group, person, assortment, and activity.

At Planning: Status, select one of the following options:

- All — Select this option to display all statuses of planning.

- Realized — Select this option to display the realized planning.

- Incomplete — Select this option to display the incomplete planning.

Type or select a budget scenario at Budget scenario to display the planning of labor hours, which is

derived from the selected budget scenario. Budget scenario can be defined at System - Finance >

Budget scenarios. Planning of hour items within the defined budget scenario can be done at Manufacturing

- Planning - Master Production Schedule.

Select the Show: Weekend, Show: Details, Show: Activity, and Show: Time check boxes to display

the planning of labor hours during weekends, by showing information about the labor hour item, by

showing activities (orders) linked to the labor hour item, and by showing the time schedule of the

planning respectively.

Click OK to save the defined criteria and close, or Close to exit without saving.

Select Cost center at Group by 1. By default, Person is selected. To plan at the factory level or warehouse

level, you can select Cost center or Project.

Select one of the following options at Group by 2:

- None — Select this option if you do not want to group the available capacity of labor hours of
people.

- Cost center — Select this option to group the available capacity of labor hours of people by cost
center.

- Person — Select this option to group the available capacity of labor hours of people by individual
employee ID and name.

- Project — Select this option to group the available capacity of labor hours of people by project.

- Activity — Select this option to group the available capacity of labor hours of people by activity.

- Hours — Select this option to group the available capacity of labor hours of people by hour item
code.

Type or select an employee ID at Manager to display the planning of labor hours for this person’s

subordinates. Leaving this field blank will display the planning of labor hours for all managers’

subordinates.

Select the reporting level of people to the selected manager at Level. Select one of the following options:

- 1: Direct — Select this option to obtain the capacity of labor hours for people who are directly
reporting (atlevel 1) to the selected manager.

- 2 — Select this option to obtain the capacity of labor hours for people, up to the second level, who
are reporting to the selected manager.

- 3 — Select this option to obtain the capacity labor hours for people, up to the third level, who are
reporting to the selected manager.

- 4 — Select this option to obtain the capacity labor hours for people, up to the fourth level, who are
reporting to the selected manager.

Type or select a cost center at Cost center. Leaving this field blank will display the planning of labor hours

for everyone in any cost center.
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13. Type or select a date or a range of dates at Date and to to display the planning of labor hours that falls on
the selected date or within the date range.

14. AtShow, select the Capacity check box to display the capacity of the hour item. Select the Planning
check box to display the planning of the hour item. Select the Actual check box to display the actual
realized hour item. Select both Planning and Actual check boxes to display both planning and actual
realization of the hour item. At least one of the three check boxes must be selected. However, when
Project is selected at Group by 1, the Capacity check box is disabled.

15. Click ™ or@/at Scale to switch the display mode for the planning of labor hours between Daily,
Weekly, Monthly, or Yearly.

To define the Tasks / Requirements section:

1. Go to Manufacturing - Planning - Resource planning. You will see the Person: Planning screen.

2. Inthe Tasks / Requirements section, click Advanced. You will see the Selection screen.

3. Inthe Filter section, click Select at Warehouse, Job groups, Person, Assortment, Activity, and
Project to display the intended requirements for labor hours belonging to the selected warehouse, job
groups, people, assortments, activities, and projects respectively. In the respective screens, click on the
required item to highlight it. You can also highlight multiple items by pressing SHIFT or CTRL while
clicking on the required codes. Alternatively, double-click on the item to select the particular item. Then,
click Select to select the item(s), and Close to exit. Selecting all items or none will display the intended
requirements for labor hours for any warehouse, job group, people, assortment, activity, and project. Job
groups, Person, and Project are not used and disabled if the Based on scenario check box is selected.

4. Select the Show: Planned check box to display the requirements for labor hours by including the planned
labor hours. This is not used and is disabled if the Based on scenario check box is selected.

S. Select the Based on scenario check box to display the requirements for labor hours based on the MRP
scenario. Selecting this check box disables the Select buttons at Job groups, Person, and Project, the
Show: Planned, Sales orders, and Production orders check boxes, while enabling the Scenario: MRP
field.

6. Ifthe Based on scenario check box is selected, type or select a scenario at Scenario: MRP to display the
requirements for labor hours based on the selected MRP scenario. This is mandatory.

7. Ifthe Based on scenario check box is not selected, you can select the Not Authorised and/or
Authorised check boxes at Sales orders to display the sales orders requirements for labor hours that are
not Authorised and/or Authorised. Click Select to select one or more sales order numbers to display the
requirements for labor hours for the selected sales order(s).

8. Ifthe Based on scenario check box is not selected, you can select the Not Authorised and/or
Authorised check boxes at Production orders to display the requirements of the production orders
for labor hours that are not Authorised and/or Authorised. Click Select to select one production order
number or more to display the requirements for labor hours for the selected production order(s).

Click OK to save the defined criteria and close, or Close to exit without saving.

10. Type or select a cost center at Cost center to display the requirements for labor hours for the selected cost
center. Leaving this field blank will display the requirements for labor hours for any cost center.

11. Type or select a date or a range of dates at Date and to to display the requirements for labor hours that fall
on the selected date or within the date range.

12. Select Projects at the drop-down list in the left corner of the Tasks / Requirements section to view the
requirements for labor hours at a factory level.

After defining the filter criteria in the Resource planning section and Tasks / Requirements section, click
Refresh to display the planning people and requirements for labor hours.




To allocate planning of labor hours to requirements:

Select an unplanned cell with the quantity of labor hour in the Resource planning section.
Select an unplanned cell with the quantity of labor hour in the Tasks / Requirements section.
Click Plan. The Plan screen will be displayed.

At Start date, type or select a date to start the allocation of labor hours.

At Start time, type a time to start the allocation of labor hours.

At Number of hours, type the number of hours taken for the allocation of labor hours.

By default, the employee ID of the person who has been allocated the labor hour requirements is displayed
at Person.

Click OK to save the allocation of labor hours for people to the requirements for labor hours.

9. Click Close to exit.
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4.1.2 Planning machine hours at factory or warehouse level

You can plan machine hours at Manufacturing - Planning - Machine planning. To plan machine hours,
you must obtain the overview of planning and requirements of the machine hours. To obtain this view and
planning, the following procedures are required:

- Defining the Machine hours section

-  Defining the Tasks / Requirements section

- Allocating the capacity of machine hours to requirements

[, 932 Machine: Planning - Exact
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To define the Machine hours section:

1. Go to Manufacturing - Planning - Machine planning. You will see the Machine: Planning screen.

2. Inthe Machine hours section, click Advanced. You will see the Selection screen.

3. Inthe Filter section, click Select at Project, Machine, Assortment, and Activity to display the
intended capacity of machine hours belonging to the selected projects, machines, assortments, and
activities respectively. In the respective screens, click on the required item to highlight it. You can also
highlight multiple items by pressing SHIFT or CTRL while clicking on the required codes. Alternatively,
double-click on the item to select the particular item. Then, click Select to select the item(s), and Close
to exit. Selecting all items or none will display the intended capacity of machine hours for any project,
machine, assortment, and activity.




Chapter 4 | Planning

Type or select an asset group at Asset group to display the capacity of machine hours belonging to the
selected asset group. Leaving this field blank will display the capacity of machine hours belonging to any
asset group.

Type or select a cost center at Cost center to display the capacity of machine hours belonging to the
selected cost center. Leaving this field blank will display the capacity of machine hours belonging to any
cost center.

Type or select a date or a range of dates at Date and to to display the capacity of machine hours that falls on
the selected date or within the date range.

At Show, select the Weekend check box to display capacity of machine hours during weekends in a
weekend column. Select the Actual check box to display the actual realization of the machine hours.
Click =/ or [ at Scale to switch the display modes of results between Daily, Weekly, Monthly, and
Yearly.

To define the Tasks / Requirements section:

1.
2.
3.

Go to Manufacturing - Planning - Machine planning. You will see the Machine: Planning screen.

In the Tasks / Requirements section, click Advanced. You will see the Selection screen.

In the Filter section, click Select at Warehouse, Machine, Assortment, Activity and Project to

display the intended requirements for machine hours belonging to the selected warehouses, machines,

assortments, activities, and projects respectively. In the respective screens, click on the required item

to highlight it. You can also highlight multiple items by pressing SHIFT or CTRL while clicking on

the required codes. Alternatively, double-click on the item to select the particular item. Then, click

Select to select the item(s), and then Close to exit. Selecting all items or none will display the intended

requirements for machine hours for any warehouse, machine, assortment, activity, and project.

Select the Show: Planned check box to display the requirements for machine hours by including the

planned machine hours.

Select the Based on scenario check box to display the requirements for machine hours based on a

scenario, which has the schedule of the required machine hours. Selecting this check box will enable

Scenario:MRP and disable all the check boxes in the Transactions section.

If the Based on scenario check box is selected, type or select a budget scenario at Scenario:MRP to

display the requirements for machine hours based on the selected budget scenario.

In the Projects section, define the following criteria:

- Select the Make items check box to display the requirements for machine hours for make items.

- Select the Customers check box to display the requirements for machine hours deriving from the
requests or orders of customers.

If the Based on scenario check box is not selected, you can define the following criteria in the

Transactions section:

- At Sales orders, select the Not Authorised and/or Authorised check boxes to display the
requirements for machine hours deriving from unAuthorised and/or Authorised sales orders. Click

Select to select one or more sales order numbers to display the requirements for
machine hours deriving from the selected sales order(s).

- AtInternal use, select the Not Authorised and/or Authorised check boxes to display the
requirements for machine hours deriving from unAuthorised and/or Authorised internal use
requests. Click Select to select one or more internal use request numbers to display
the requirements for machine hours deriving from the selected internal use request(s).

- AtProduction orders, select the Not Authorised and/or Authorised check boxes to display

the requirements for machine hours deriving from unAuthorised and/or Authorised

production orders. Click Select to select one or more production order numbers to display
the requirements for machine hours deriving from the selected production order(s).




9. Click Select to save the defined criteria and close, or Close to exit without saving.

10. Type or select a cost center at Cost center to display the requirements for machine hours belonging to the
selected cost center. Leaving this field blank will display the requirements for machine hours belonging to
any cost center.

11. Type or select a date or a range of dates at Date and to to display the requirements for machine hours that
fall on the selected date or within the date range.

12. Select Projects at the drop-down list in the left corner of the Tasks / Requirements section to view the
requirements for machine hours at a factory level.

After defining the filter criteria in the Machine hours and Tasks / Requirements sections, click Refresh to
display the capacity and requirements of the machine hours.

To allocate available capacity of machine hours to requirements:

1. Selectan unplanned cell with the quantity of machine hours in the Machine hours section.

Selectan unplanned cell with the quantity of machine hours in the Tasks / Requirements section.
Click Plan. The Plan screen will be displayed.

Type or select the dates to start and end the allocation of machine hours at Start date and End date
respectively.

At Start time, type a time to start the allocation of machine hours.

AtNumber of hours, type the number of hours taken for the allocation of machine hours.

Click OK to save the allocation of the capacity for machine hours to the requirements for machine hours.
Click Close to exit.
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4.2 Planning at Order Level

You can plan labor hours and machine hours at the order level to obtain a detailed view of the planning
schedule and requirements.

The following topics are relevant to this section:

—  Planning labor hours at order or item level

—  Planning machine hours at order or item level

4.2.1 Planning labor hours at order or item level

You can plan labor hours at Manufacturing = Planning - Resource planning. To plan labor hours at an order
or item level, you must obtain the overview of planning of labor hours and requirements for labor hours atan
order level or item level. To obtain this view and planning, the following procedures are required:

— Defining the Resource planning section

-  Defining the Tasks / Requirements section

- Allocating planning of labor hours to requirements
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To define the Resource planning section:

1. Go to Manufacturing - Planning - Resource planning. You will see the Person: Planning screen.

2. Inthe Resource planning section, click Advanced. You will see the Selection screen.

3. Inthe Filter section, click Select at Project, Job groups, Person, Assortment, and Activity to display
the intended capacity of labor hours belonging to the selected projects, job groups, people, assortments,
and activities respectively. In the respective screens, click on the required item to highlight it. You can also
highlight multiple items by pressing SHIFT or CTRL while clicking on the required codes. Alternatively,
double-click on the item to select the particular item. Then, click Select to select the item(s), and Close to
exit. Selecting all items or none will display the intended capacity of labor hours for any project, job group,
person, assortment, and activity.

4. AtPlanning: Status, select one of the following options:

- All — Select this option to display all statuses of planning.
- Realized — Select this option to display the realized planning.
- Incomplete — Select this option to display the incomplete planning.

S. Type or selecta budget scenario at Budget scenario to display the planning of labor hours, which are
derived from the selected budget scenario. Budget scenario can be defined at System - Finance >
Budget scenarios. Planning of hour items within the defined budget scenario can be done at Manufacturing
- Planning - Master Production Schedule.

6. Select the Show: Weekend, Show: Details, Show: Activity, and Show: Time check boxes to display
the labor hour planning during weekends, by showing information about the labor hour item, by showing
activities (orders) linked to the labor hour item, and by showing the time schedule of the hour planning
respectively.

7. Click OK to save the defined criteria and close, or Close to exit without saving.

8. Select Hours at Group by 1. By default, Person is selected. To plan at the order or item level, you can
select Activity or Person.

9. Select one of the following options at Group by 2:

- None — Select this option if you do not want to group the available capacity of people labor hours.

- Cost center — Select this to group the available capacity of people labor hours by cost center.

- Person — Select this option to group the available capacity of people labor hours by individual
employee ID and name.

- Project — Select this option to group the available capacity of people labor hours by project.

- Activity — Select this option to group the available capacity of people labor hours by activity.

- Hours — Select this option to group the available capacity of people labor hours by hour item code.




10. Type or selectan employee ID at Manager. Leaving this field blank will display the planning for any
manager.
11. Select the reporting level of people to the selected manager at Level. Select one of the following options:
- 1: Direct — Select this option to obtain the capacity of labor hours for people who are directly
reporting (atlevel 1) to the selected manager.

- 2 — Select this option to obtain the capacity of labor hours for people, up to the second level, who
are reporting to the selected manager.

- 3 — Select this option to obtain the capacity of labor hours for people, up to the third level, who are
reporting to the selected manager.

- 4 — Select this option to obtain the capacity of labor hours for people, up to the fourth level, who
are reporting to the selected manager.

12. Type or select a cost center at Cost center. This is optional. Leaving this blank will display the resource
planning for any cost center.

13. Type or select a date or a range of date at Date and to to display the resource planning that falls on the
selected date or within the date range.

14. AtShow, select the Capacity check box to display the capacity of the hour item, the Planning check box
to display the planning of the hour item, and/or the Actual check box to display the actual realized hour
item. Select both the Planning and Actual check boxes to display both planning and actual realization of
the hour item. At least one of the three check boxes must be selected. When Project is selected at Group
by 1, the Capacity check box is disabled.

15. Click[= or @l at Scale to switch the display modes for the people hour item planning between Daily,
Weekly, Monthly, or Yearly.

To define the Tasks / Requirements section:

1. Go to Manufacturing - Planning - Resource planning. You will see the Person: Planning screen.

2. Inthe Tasks / Requirements section, click Advanced. You will see the Selection screen.

3. Inthe Filter section, click Select at Warehouse, Job groups, Person, Assortment, Activity, and
Project to display the intended labor hour requirements belonging to the selected warehouse, job groups,
people, assortments, activities, and projects respectively. In the respective screens, click on the required
item to highlightit. You can also highlight multiple items by pressing SHIFT or CTRL while clicking on
the required codes. Alternatively, double-click on the item to select the particular item. Then, click Select
to select the item(s), and Close to exit. Selecting all items or none will display the intended labor hour
requirements for any warehouse, job group, person, assortment, activity, and project.

4. Select the Show: Planned check box to display the requirements for labor hours by including planned
labor hours.

S. Select the Based on scenario check box to display the requirements for labor hours based on the MRP
scenario. Selecting this check box disables the Select buttons at Job groups, Person, and Project, the
Show: Planned, Sales orders, and Production orders check boxes, while enabling the Scenario: MRP
field.

6. Ifthe Based on scenario check box is selected, type or select a scenario at Scenario: MRP to display the
people labor hour requirements based on the selected MRP scenario. This is mandatory.

7. Ifthe Based on scenario check box is not selected, select the Not Authorised and/or Authorised check
boxes at Sales orders to display the requirements for labor hours for sales orders that are not Authorised
and/or Authorised. Click Select to select one sales order number or more to display the requirements for
labor hours for the selected sales order(s).

8. Ifthe Based on scenario check boxis not selected, select the Not Authorised and/or Authorised check
boxes at Production orders to display the requirements for labor hours for production orders thatare not
Authorised and/or Authorised. Click Select to select one production order number or more to display the
requirements for labor hours for the selected production order(s).




9. Click OK to save the defined criteria and close, or Close to exit without saving.

Type or select a cost center at Cost center to display the requirements for labor hours belonging to the
selected cost center. Leaving this blank will display the requirements for labor hours for any cost center.
Type or select a date or a range of dates at Date and to to display the requirements for labor hours that fall
on the selected date or within the date range.

Select Items or Request at the drop-down list in the left corner of the Tasks / Requirements section to
display requirements for labor hours at an order level or item level respectively.

After defining the filter criteria in the Resource planning and Tasks / Requirements sections, click
Refresh to display the planning and requirements of the labor hours.

11.
12.

13.

To allocate available capacity of labor hours to requirements:

Selectan unplanned cell with the quantity of labor hours in the Resource planning section.
Selectan unplanned cell with the quantity of labor hours in the Tasks / Requirements section.
Click Plan. The Plan screen will be displayed.

At Start date, type or select a date to start the allocation of labor hours.

At Start time, type a time to start the allocation of labor hours.

Type the number of hours taken for the allocation of labor hours at Number of hours.

By default, the employee ID of the person who has been allocated to the labor hour requirements is
displayed at Person.

Click OK to save the allocation of labor hours to the requirements.

Click Close to exit.
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4.2.2 Planning machine hours at order or item level

You can plan machine hours at Manufacturing = Planning - Machine planning. To plan machine hours, you
must obtain the overview of planning of machine hours and requirements for machine hours. To obtain this
view and planning, the following procedures are required:

- Defining the Machine hours section

- Defining the Tasks / Requirements section

- Allocating the available capacity of machine hours to requirements

[ 932 Machine: Planning - Exact
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To define the Machine hours section:

1.
2.
3.

Go to Manufacturing - Planning - Machine planning. You will see the Machine: Planning screen.

In the Machine hours section, click Advanced. You will see the Selection screen.

In the Filter section, click Select at Project, Machine, Assortment, and Activity to display the
intended capacity of machine hours belonging to the selected projects, machines, assortments, and
activities respectively. In the respective screens, click on the required item to highlight it. You can also
highlight multiple items by pressing SHIFT or CTRL while clicking on the required codes. Alternatively,
double-click on the item to select the particular item. Then, click Select to select the item(s), and Close
to exit. Selecting all items or none will display the intended capacity of machine hours for any project,
machine, assortment, and activity.

Type or select an asset group at Asset group to display the capacity of machine hours belonging to the
selected asset group. Leaving this field blank will display the capacity of machine hours belonging to any
asset group.

Type or select a cost center at Cost center to display the capacity of machine hours belonging to the
selected cost center. Leaving this field blank will display the capacity of machine hours belonging to any
cost center.

Type or select a date or a range of dates at Date and to to display the capacity of machine hours that falls on
the selected date or within the date range.

At Show, select the Weekend check box to display capacity of machine hours during weekends in a
weekend column. Select the Actual check box to display the actual realization of the machine hours.
Click = or [ at Scale to switch the display modes of results between Daily, Weekly, Monthly and
Yearly.

To define the Tasks / Requirements section:

1.
2.
3.

Go to Manufacturing - Planning - Machine planning. You will see the Machine: Planning screen.
In the Tasks / Requirements section, click Advanced. You will see the Selection screen.
In the Filter section, click Select at Warehouse, Machine, Assortment, Activity, and Project to
display the intended machine hours requirements belonging to the selected warehouses, machines,
assortments, activities, and projects respectively. In the respective screens, click on the required item
to highlight it. You can also highlight multiple items by pressing SHIFT or CTRL while clicking on
the required codes. Alternatively, double-click on the item to select the particular item. Then, click
Select to select the item(s), and then Close to exit. Selecting all items or none will display the intended
requirements for machine hours for any warehouse, machine, assortment, activity, and project.
Select the Show: Planned check box to display the requirements for machine hours by showing the
planned machine hours.
Select the Based on scenario check box to display the requirements for machine hours based on a
scenario, which has the machine hour items requirements schedule. Selecting this check box will enable
Scenario:MRP and disable all the check boxes in the Transactions section.
Type or select a budget scenario at Scenario:MRP to display the requirements for machine hours based on
the selected budget scenario.
In the Projects section, define the following criteria:
- Select the Make items check box to display requirements for machine hours for make items.
- Select the Customers check box to display requirements for machine hours deriving from
customers’ requests or orders.
If the Based on scenario check box is not selected, define the following criteria in the Transactions
section:
- At Sales orders, select the Not Authorised and/or Authorised check boxes to display the
requirements for machine hours deriving from unAuthorised and/or Authorised sales orders. Click
Select to select one sales order number or more to display the requirements for
machine hours deriving from the selected sales order(s).




11.

12.

- AtInternal use, select the Not Authorised and/or Authorised check boxes to display the
requirements for machine hours deriving from unAuthorised and/or Authorised internal use
requests. Click Select to select one internal use request number or more to display the requirements
for machine hours deriving from the selected internal use request(s).

- AtProduction orders, select the Not Authorised and/or Authorised check boxes to display

the requirements for machine hours deriving from unAuthorised and/or Authorised
production orders. Click Select to select one production order number or more to display the
requirements for machine hours deriving from the selected production order(s).

Click Select to save the defined criteria and close.

Type or select a cost center at Cost center to display the requirements for machine hours belonging to the
selected cost center. Leaving this field blank will display requirements for machine hours belonging to any
cost center.

Type or select a date or a range of dates at Date and to to display the requirements for machine hours that
fall on the selected date or within the date range.

Select Items or Request at the drop-down list in the left corner of the Tasks / Requirements section to
view the requirements for machine hours at an order or item level respectively.

After defining the filter criteria under the Machine hours section and Tasks / Requirements section, click
Refresh to display the capacity of machine hours and requirements of the machines.

To allocate available capacity of machine hours to requirements:

1.

hal N

S.
6.
7.
8.

Selectan unplanned cell with the quantity of machine hours in the Machine hours section.
Selectan unplanned cell with the quantity of machine hours in the Tasks / Requirements section.
Click Plan. The Plan screen will be displayed.

Type or select the dates to start and end the allocation of machine hours at Start date and End date
respectively.

At Start time, type a time to start the allocation of machine hours.

AtNumber of hours, type the number of hours taken for the allocation of machine hours.

Click OK to save the allocation of the capacity of machine hours to the requirements.

Click Close to exit.
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5. Production Management

In Exact Globe Next, you can manage your production order throughout the entire manufacturing process. A
generic manufacturing process consists of the following stages: creation of a production order, authorization of
the production order, release of the production order to the shop floor, printing the production order, issuing
the materials required by the production order, receipt of the finished goods, and finally, the completion of the
production order. The process for production orders in Exact Globe Next is displayed in the following:

| Ordered ||Authorised|| Released || Printed Issued || Received || Finished ||Completed|

BT EEE

(24/9/13 W | L % K| % X X %

To start the production process, you need to create a production order to specify what you want to produce,
how much you need to produce, and when you expect to receive your finished goods. You can define the
information about the items, such as the items that you are requesting, the quantity of items to be produced,
the date the work will start for the production order and the date the finished goods will be ready for receipt.

After creating the production order, you can send the production order for authorization. Authorization is an
important step because it allows you to confirm the production order before releasing the production order to
the production shop floor. This step allows you to verify the sales order requesting the production order, the
available-to-promise production capacity, the ability to meet the customer’s requested delivery date, and the
validity of the Bill of Materials. Authorization is mandatory only if the Use authorise check box is selected in
the Production order status section at System - General > Settings > Manufacturing settings. If the Use
authorise check box is not selected, you may skip the authorization step.

If the production is approved, the production order is then released to the production shop floor to start work
on the production order. The release step is mandatory only if the Release: Required check box is selected in
the Production order status section at System - General > Settings > Manufacturing settings. The release
step can be used as an additional step to determine which production orders to release to the production shop
floor first according to the priority and the availability of materials and capacity. Therefore, this step is useful to
determine the sequence in which the production orders are processed.

The production order is then printed and distributed to the relevant members of the production team so

that they are aware of the incoming production order. The production team may use the printed production
order to track the progress of the production order work in progress (WIP). The printing of production orders
is mandatory only if the Print: Required check box is selected in the Production order status section at
System > General - Settings > Manufacturing settings.

Before work can commence on the production order, the raw materials and the subassembly items defined in
the Bill of Materials for the items need to be issued to the shop floor. When the raw materials and subassembly
items have been transformed into finished goods, the finished goods are then sent and received into the
warehouse and location (if applicable) indicated in the production order.




Once the production order has been completed logistically, it will be set to the Finished status. This status

is available only if the Use finish check box is selected in the Production order status section at System —>
General > Settings > Manufacturing settings. The production order is considered complete and closed when
all related production activities are finalized, the final product is completed and delivered to the requestor, and
the financial entries have been successfully registered.

5.1 Creating Production Orders

The following topics are relevant to this section:
- Creating production orders

- Creating suborders

-  Creating production orders automatically

- Changing production order details

5.1.1 Creating production orders

The production order screen consists of five sections:
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- Production order header — This section displays the general description, such as the description of
the production order, the warehouse in which the finished goods will be received, the parent project (if
applicable) and the cost center.

- Production order lines — This section displays the requirements of the production order, such as the
item requested by the production order, the quantity to be produced, the date the work on the production
order will start, and the date the receipt of the finished goods is expected.

- Production order details — This section displays the production process information, such as the
operation details, the Bill of Materials, and extra charges that are relevant to the production order.

- Production order process flow — This section displays the stages in the process flow of the production
order and shows which stage has been completed. Process stages that are relevant to the production order
process are authorization, release of the production order, printing of the production order, issuance of
production materials, the receipt of finished goods, the completion of the production order logistically,
and the completion of the production order from the financial viewpoint.

- Information panel — This section displays an overview of the financial cost related to the production
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order, such as the standard cost price to manufacture the end product (Total: End product), the standard
cost price of all the items in the BOM (Total: BOM), and the difference between the standard cost of the
end product and the cost of the BOM items (Total: Value added).

To create production orders:

Go to Manufacturing - Entries = Production orders.

Click New. The Production orders screen will be displayed.

At Warehouse, select a warehouse in which you want to receive the completed production order.

AtDescription, type a description for the production order.

In the production order entry lines at Item, type or select the item you want to produce.

Type or select the location of the warehouse, in which you want to receive the completed production

order under the Location column. This column is available only if the Warehouse locations check box is

selected at System > General - Settings, under Inventory settings in the Fulfillment section.

Type the quantity of items you want to produce under the Planned column.

8. Type or press F2 to select the start date in the Start date column and the end date in the End date column.
By default, the start date is the current system date and the end date is calculated based on the lead time
defined in the header of the BOM maintenance of the item.

9. Type or select a person under the Person column to indicate the person who is requesting the finished
goods.

10. The amount for the item is displayed under the Amount column.

11. Repeat the process steps until all the items you want to produce are defined.

12. Click Close to save and exit.

S
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5.1.2 Generating suborders

The Bill of Materials for finished goods can consist of raw materials and subassembly items. Raw materials
are items that can be used directly without having to go through additional processing or assembly, whereas
subassembly items have their own Bill of Materials and require processing before these can be issued after the
defined processing lead time.

If a subassembly item is defined in the Bill of Materials for the production order item, you need to generate a
suborder to produce the subassembly items for the production order.

& 932 Suborders - Exact x|
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To generate suborders:

Go to Manufacturing - Entries = Production orders.

Define the criteria to search for the relevant production orders, and then click Search.

Select the production order you want to create suborder(s) for, and then click Open.

Click Generate suborders in the Production orders screen.

You will see a list of suborders suggested for the subassembly items required by your production order.
Click the Include: Stock controlled check box to also display stock controlled items. Stock controlled
items are items that can only be issued for sales orders and productions if there is sufficient quantity
available in stock.

A




6. Double-click under the Selected column to select the relevant subassembly items you want to generate
the suborders for. By default, the main version of the Bills of Materials for the subassembly items is

selected.

N

Click OK.

©

Click OK to generate the suborders. A message “Suborders: Generated” will be displayed.

9. Toview alist of suborders already created, click Suborders. If suborders have already been generated for
the production order, you will see the suborders listed in the screen with details, such as the start date,

production order number, and quantity.

Note:  Stockallocation between different warehouses will be blocked. You can proceed with
generating the orders without performing stock allocation or stop generating the orders.

5.1.3 Creating production orders from the MRP

In Exact Globe Next, you can create production orders from the material requirements planning (MRP).
The MRP is an overview generated based on requirements derived from confirmed sales orders, internal use
requests, forecasted sales orders, and replenishment of stock controlled items. For more information on the
MRP, see 3.1.2 Configuring and generating production requirements with the MRP engine.

You can use the following methods to create production orders from the MRP:

- Using the MRP tool to generate the MRP, and then create production orders from the MRP.

—  Using the MRP engine to generate the MRP scenario, and then create production orders from the

production advice thatis based on the MRP scenario.
The differences between the two methods are as follows:

Manufacturing = Planning - MRP

The MRP reflects the current material requirements

Manufacturing = Planning - MRP engine

The MRP captures the material requirements at the
point the MRP engine processes the specific planning
scenario.

The MRPis generated based on the
requirements of confirmed orders and requests.

The MRP can be generated based on the
requirements of forecasted orders.

when these are required.

The MRP displays the standard items that are required and

In addition to the MRP of standard items, you

can also view the production or purchase advice
and the labor and/or machine hour planning. The
production and purchase advices prompt the user
to produce subassembly items or purchase materials
thatare facing a shortage in stock level.

Planning is generated for the first level of a BOM.

Planning can be generated for all levels of a BOM.
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Creating production orders using the MRP tool

Exact Globe Next generates the MRP for manufactured items based on the requests from sales orders and
internal use requests. The MRP allows you to identify the items to be manufactured, the quantity needed for
the respective items, and when the items will be completed. From the MRP, you can create the production
orders to fulfill the demand for the items.
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To create production orders from MRP:

Go to Manufacturing - Planning - MRP.

In the header of the screen at Content, select Orders/ Requirements.

Select the start date and end date at From and to to define the period for which you want to view the MRP.
Choose a time scale at Scale to view the MRP report.

Click Advanced.

In the Selection screen, define the relevant criteria for the MRP, and then click Select.

Click Refresh to view the MRP.

Click on the box that contains the quantity of items requested by open orders, and then click Produce.

0N UL

Note:  You can also create production orders from MRP at Manufacturing - To be processed
- Back to back order. In this screen, Orders/ Requirement is displayed at Content by
default.




Creating production orders using the MRP engine

In order to generate a MRP using the MRP engine, you need to first define the MRP scenario. The MRP scenario
contains the criteria that will be taken into consideration when the system generates the MRP. The MRP is
then used to calculate the production advice. A production advice contains suggestions about the items, the
quantity for each item, and the date the items will be available, in order to meet the fulfillment dates for the
requests. From the production advice you can create production orders to manufacture the requested items.
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To generate the MRP from the MRP engine:

Go to Manufacturing - Planning - MRP engine.

Click New.

AtScenario: MRP, type a code to identify the MRP scenario. This is mandatory.

AtDescription, type a description for the MRP scenario. This is mandatory.

In the Items section at Item code and to, you can specify the range of items you want to plan for. These
are mandatory.

S .
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12.
13.
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At Stock controlled and Sales, define the relevant options, either to include or exclude only stock
controlled or sales items respectively.

In the Requirements section, define the requirements that you want to consider in the MRP scenario,
such as sales orders, internal use requests, purchase orders, quotations, and production orders.

In the Additional criteria section, define other criteria, such as whether to plan for the manufacturing or
purchase of the subassembly items, and whether to include the machine and labor hour requirements in
the MRP.

Click Save to save the MRP scenario.

Click Process to generate the MRP. You will see the following screen

€ MRP engine o ] |
Elapsed time: 00:00:23
| 2%
1. Initialize 6/7
2. Levels
3. Requirements
4. MRP calculations

Generated 0
[# Exit automatically (3 cancel |

Click Close when the processing is complete.
Click Save to save the results in the MRP.
Click Close to exit.

To create production orders from the production advice:

A .

o

9.

10.

Go to Manufacturing - To be processed - Production advice.

Select MRP at Calculation.

At MRP engine: Scenario, type or select the relevant MRP scenario.

AtItem, type or select the item code or a range of item codes.

Click Display to view the MRP. The quantities displayed under the relevant fulfillment dates are the
quantities of requested items that need to be fulfilled on the dates.

Click the quantity in the relevant fulfillment date column, and then click Produce to view the production
advice. The Generate production orders screen will be displayed.

In the Generate production orders screen, select the items you want to produce by clicking the
Selected column of the relevant lines. By default, one version of each item (if there is more than one
version) displayed in the production advice is selected.

Type the quantity you want to produce for the respective items under the Advice column. By default, the
quantity entered is the total quantity calculated from all the requests that need to be fulfilled on the date.
Click Produce to create production orders for the requests. You will see the production order screen for
the production orders that have been created.

Click Close to exit.

To create purchase orders from the production advice:

Go to Manufacturing - To be processed - Generate purchase orders.

Select MRP at Calculation.

AtMRP engine: Scenario, type or select the relevant MR P scenario. This is mandatory.

AtItem, type or select the item code or a range of item codes.

Click Display to view the MRP. The quantities displayed under the relevant fulfillment dates are the
quantities of requested items that need to be fulfilled on the dates.
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6. Click the quantity in the relevant fulfillment date column, and then click PO to view the production
advice. The Generate purchase orders screen will be displayed.

7. Inthe Generate purchase orders screen, select the items you want to purchase by clicking the Selected
column of the relevant lines. By default, one version of each item (if there is more than one version)
displayed in the production advice is selected.

8. Type the quantity you want to purchase for the respective items under the Advice column. By default, the
quantity entered is the total quantity calculated from all the requests that need to be fulfilled on the date.

9. Click Purchase to create purchase orders for the requests. You will see the purchase order screen for the
purchase orders that have been created.

10. Click Close to exit.

5.1.4 Changing production order information

It is possible that you may want to make changes to the production order after it is created. You may need to
remove, add, or change the items that you have originally entered in the production order, the BOM version
to be used, the quantity of items needed, or the end date of the production order. It is possible to edit the
production order header and lines before the production order is issued or received.

To edit production orders:

1. Go to Manufacturing - Entries » Production orders.

2. Define the criteria to display the relevant production orders, and then click Search.

3. Select the production order you want to edit, and then click Open.

4. Make the required changes, and then click Close. The changes will be saved automatically.
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5.2  Authorizing Production Orders

A production order needs to be approved by a higher authority before it can be released to the production shop
floor to start the manufacturing activities for the production order. Authorization is mandatory only when the
Use authorise check box is selected in the Production order status section at System - General - Settings,
under Manufacturing settings. For more information on the manufacturing settings, see 1 Setting Up.

n Manufacturing / Entries / Authorise production

[ search | [P clear | [ Previous | [ 7 Next | 1[5 Number of rows
Filter (+ starts with ¢~ contains
Warehouse --All-- |+
Start date [ =| to [ = P Al
End date | g| to | g\ Al
Production order | a| Parent project ljl
Order type | Production order |v | Item I:I
Description | |
Show ¢~ Parent project & Al Sales order lﬁl
Status

I~ Open [~ Authorised [~ Rejected I© Released ™ Printed
Check

[ Items [ Stock [ Warehouse [ Salesorders [ Seral/batch [ Budgets copied

[Parent project _[1tem code | Quantity|start date |[End date |wrh. [auth.|
PROD00010030 Production: PROD0O0010030 MCB0004 1.00 24/9/2013 25/9/2013

{PROD00010022.001 |Production: PROD00010029.001 |PROD00010028  [MCBOOO1 1.00 |2 013 |2 2013
PRODO0010027 Production: PROD00010027 AAA 1.00 27/6/2013 27/6/2013
PROD00010026 Production: PROD00010026 AARA 1.00 27/6/2013 27/6/2013
PROD00010025 Production: PROD00010025 MCEOOD4 1.00 27/6/2013 28/6/2013

To authorize production orders:

1.  Go to Manufacturing - Entries - Authorise production.

2. Type orselecta start date or a range of start dates at Start date to display the production orders you want
to authorize.

3. Ifyoualready know the production order number, type or select the production order number at

Production order.

At Order type, select Production order.

In the Status section, click the Open check box.

Define other criteria to display the relevant production orders, and then click Search.

Select the production orders you want to authorize, and then click Auth. Alternatively, select the

production order that you want to authorize, click Open to view the production order information, and

then click Authorised in the production order processes section of the production order.

After the production order has been Authorised, you will see a green check mark under the Auth. column.

9. Click Close to exit.
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5.3  Releasing Production Orders

After the production orders are Authorised, the production orders will be released to the production shop
floor so that the manufacturing operation can begin work on the production orders. The release step can be
used in production planning to control the sequence in which the production orders are processed. Production
planning determines the order in which the production orders are release based on fulfillment dates of the
production orders, the people and materials required, and the priority of the respective production orders.
The release of the production orders is mandatory only if the Release: Required check box is selected in the
Production order status section at System - General = Settings, under Manufacturing settings. Otherwise,

you may skip this step.
Warehouse --All-- |-
Start date | g| to‘ @| V¥ Al
End date [ = to = & Al
Production orderl E| [ all
Order type | Production order |v |
Status ¥ Authorised [ Released
Show (™ Parent project & All
Print r
[parent project |
PROD00010010 Prod feb MCBDEMOPAKKET 6.00 7/2/2011 8/2/2011 Released
PRODO0010012.001 Voorraad productie PROD00010012 MCBO0003 30.00 17/3/2011 18/3/2011 Released 12:00 AM
PRODO0010012.002 Voorraad productie PROD00010012 MCBO004 17/3/2011  18/3/2011 Released 12:00 AM
PROD00010012.004 Voorraad productie PROD0O0010012 MCBO00OL 17/3/2011 18/3/2011 Released

MCB0001 Released

Authorised

Production: PROD00010016
Bottling p <

PRO 110017 ) < 00 y e
Production: PROD00010019 MCB0004 1.00 5/4/2012 6/4/2012 Released

PROD0O0010019
PRODOO010013 Bottling process MCB0001 20.00 8/5/2012 8/5f2012 Authorised 12:00 AM
PROD0OO010026 Production: PROD00010026 ARS 1.00 27/6/2013 27/6/2013 Released 12:00 AM

R A . T2 -3

=
Open Sorting seq Release

To release production orders:

1. Go to Manufacturing - Entries > Release.

2. At Warehouse, select the warehouse to display the production orders that you want to release. The
selected warehouse is the warehouse defined in the production orders and will be the warehouse where
the completed items will be received.

3. Type or selecta date or a range of dates at Start date or End date.

4. Type or select the production order number at Production order to display the production order that you
want to release. Alternatively, you can select the All check box to display all production orders that you
want to release.

S. Select Production order at Order type.

Click Refresh.

7. Select the production orders you want to release, and then click Release. Alternatively, select the
production order that you want to release, click Open to view the production order information, and then
click the Released process step. After the production has been released, you will see “Released” in the
Status column for the corresponding production order.

8. Click Close to exit.
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5.4 Printing Production Orders

You can print the released production orders to inform the production team of the work required for the
production orders. This process is important in order to maintain a copy of the production orders for filing
and audit purposes. Also, the production team may use the printed production orders to track the work in
progress (WIP) for the production orders. The printing of production orders is mandatory only if the Print:

Required check box is selected in the Production order status section at System = General > Settings,
under Manufacturing settings.

Exact Globe Next allows the user to choose between printing the individual production orders only, and
printing the operations in the production orders in addition to the production orders. The layouts for the
production orders and the operation slips are defined at Production order and Operation respectively
at System - General - Settings, under Documents settings. Printing the operations is useful when the

operations involved in the production orders will be handled by different work groups that are located
separately.

{2 932 Print: Production order

File Edit Help

General |

Selection

& @
Process =
Process @ Trial ¢ Final
Output & Printer (Microsoft XPS Document Writer)
Date 25/09/2013 [ Wednesday, 25 September, 2013 ‘
I Layout XNEXACTL [Bl| Production order \
Bar code EAN-8 |~

Selection method  (+ Preduction order  Item  Start date { Pare

1 Warehouse | -All--

[[[] Assortments...
Selection code...

Production order |

=

g

Order type \ Production order

Labour hour [

Planner \ E.| | [ Al

Options

nt project

¥ Selectively

8]

~ Al

[N

I Print operation slip ¥

> Layout \
-

Print: Attachments [~

]

Compress items

Print: Instructions [

I Print production order

Compress hours

~

r

Print: Attachments (BOM line) [

Print: Suborder

Print waste [~

I Level

E 3 2 1
5/4/2012 PROD00D010019 MacBean Extra Dark 1
29/3/2012 PRODO0010016 Production: PROD00010(MCB0001  MacBean Regular il
| 18/3/2011 18/3/2011 PROD00010012.004 Voorraad preductie MCBO001  MacBean Regular 1 PROD00010012 v | a
1

2

Process

- [ .

To print production orders:

1. Go to Manufacturing - Entries - Instructions. The Print: Production order screen will be displayed.
2. Inthe Process section, select one of the following options at Process:

Trial — Select this option to display the preview of the production orders.

Final — Select this option to generate a printed copy of the production orders.

3. Select the method of output at Output. You can select a printer by going to System - General > User
settings. In the Printer section under the Output tab, select Specific, followed by the printer connected
to your network. Then, click Save. The method of output can be in the form of email or printer.

Back in the Print: Production order screen, type or select the date of the printing at Date.




S. AtLayout, type or select the layout ID. The selected layout will be used to format the printed copy of the
production orders. This is mandatory. You can edit the defined layout only if the Print production order
check box is selected in the Options section.

6. Inthe Selection section at Selection method, select Production order, Item, Start date, or Parent
project to search for the production orders that you want to print. For example, to search for the
production orders based on start date, select Start date at Selection method, and then define the range of
start dates at Start date.

7. Click Number of production orders to find out the number of production orders that were selected
based on the criteria. This button is available only if the Selectively check box is not selected.

8. Otherwise, to manually select the production orders, click the Selectively check box to display the results
at the bottom of the screen. Click Search to refresh the results based on the defined search criteria. Select
the production orders you want to printin the results box.

9. Select Production order at Order type.

10. Inthe Options section, you can define the criteria to determine the content of the production orders.

11. Selectthe Print production order check box.

12. To print the operation steps in addition to the production orders, select the Print operation slip check
box, and then type or select a suitable layout at Layout.

13. Click Preview to see a print preview of the production orders.

14. Click Process to start the printing process.

15. After the production order files are sent to the printer, you will see a green check mark under the Printed
column for the corresponding production orders.

16. Click Close to exit.

5.5 Managing Operations

Using operations, you can break down the production into several processes. Exact Globe Next allows you
to define each operation in a production process and set the relationship between each operation. For more
information on setting up operations and using operations in BOM, see 1 Setting Up.

You can also add additional operations to a production order. When a production order involves operations,
you can manage each operation in the production order by setting the status of each operation, starting the
operation, and printing the operation slip.

5.5.1 Setting operation status

You can set the status of an operation at Manufacturing - Entries © Operations control. In this screen, you can
start an operation, set the percentage of completion, and complete the operation. Before controlling operations
related to a production order, the production order must first be released.

In the Operations control screen, define the relevant criteria and click Refresh to show a list of operations of
released production orders.
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¥ Manufacturing / Entries / Operations control
Warehouse —-All-- |~
Start date = to = VoAl
End date 2] to = VoAl
Work centre =} to B oAl
Machine & to B & oan
Production order a to B oan
Parent project =} to B oAl
Operation & to B & oan
Status ¥ Open [¥ Started ¥ Completed  Outsourced All |+
Show ¢ Parent project & All
Visual scheduler
Scheduled Al |+ Approved ops [ All |+
PROD00010010  Prod feb 10 DFOP0O1 Started
PROD00010012.001 Voorraad productie PROD00010012 10 DFOPO01  17/3/2011 12:00AM  17/3/2011 12:00 AM  Started
PROD00010012.002 Voorraad productie PROD00010012 10 DFOPO01  17/3/2011 12:00AM  17/3/2011 12:00 AM  Open
PROD00010012
PROD00010012
E} & W =) = 19t <k & 7] Loy *
Refresh Purchase Outsourced Print Status Calculate p... || Sorting seg... Project Fulfilment Receipts Open Close

To start operations of production orders:

1. Go to Manufacturing - Entries » Operations control.

2. Type or select the production order code or range of codes at Production order and to.

3. AtStatus, select the Open check box and clear the Started and Completed check boxes. You can also
define other criteria to narrow down the operations you want to list.

4. Click Refresh.

S. Select the operation that you want to start and click Status. The Operations control screen will be
displayed.

6. Inthe Operations control screen, select Started at Status in the Operation Status section. By default,
the status is Open.

7. Once Started is selected, you can define the current completion percentage at Percentage complete. You
can type a value from “0” to “100”. Take note that a value of “100” will not automatically complete the
operation.

8. At Quantity completed, type the quantity of the completed item for the operation. This field is enabled
only if Started is selected at Status.

9. Click Save to make the changes effective.

To set percentage of completion for started operations:

1. Go to Manufacturing - Entries - Operations control.

2. Type or select the production order code or range of codes at Production order and to.

3. AtStatus, select the Started check box and clear the Open and Completed check boxes. You can also
define other criteria to narrow down the operations you want to list.

4. Click Refresh.

S. Select the operation for which you want to define the percentage of completion and click Status. The
Operations control screen will be displayed.

6. Inthe Operations control screen, type the current percentage of completion at Percentage complete.
You can type a value from “0” to “100”. Take note thata value of “100” will not automatically complete
the operation.

7. Click Save to make the changes effective.




To complete operations:

1. Go to Manufacturing - Entries > Operations control.

2. Type or select the production order code or range of codes at Production order and to.

3. After defining other criteria to narrow down the operations, click Refresh.

4. Select the operation that you want to complete and click Status. The Operations control screen will be
displayed.

S. Inthe Operations control screen, select Completed at Status in the Operation Status section. This
will automatically set Percentage complete to “100” and disable the field.

6. Click Save to make the changes effective. If the production order has been printed and backflush is enabled
for the production order, Exact Globe Next will ask if you want to backflush based on the operation
completion. Click Yes to backflush based on the completed operation or No to backflush based on
production order instead.

7. For more information on backflushing a production order, see 5.6.2 Issuing production orders with
backflush.

5.5.2 Printing operation slips

You can print operation slips together with the production order or individually for each operation. In order to
print the slips together with the production order, see 5.4 Printing Production Orders.

To print individual operation slips:
Go to Manufacturing - Entries > Operations control.
Type or select the production order code or range of codes at Production order and to.
After defining other criteria to narrow down the operations, click Refresh.
Select the operation that you want to printand click Print. The Print: Operation screen will be displayed.
In the Print: Operation screen, select Trial or Final in the Print section to see a preview of the operation
slip or print the operation slip respectively.
In the Output section, select Printer or E-Mail to output the operation slip to a printer or send it as
an email. If you select E-mail, type the email address of the recipient, the subject line, and a description
(optional) at E-Mail, Subject, and Long description.
7. Type or select the operation slip layout at Layout. You can also define the following options by selecting
the relevant check boxes:
- Compress items — Select this check box to summarize similar items into single lines with
summary quantities instead of in individual lines.
- Compress hours — Select this check box to summarize similar hour items into single lines with
summary hours instead of in individual lines.
- Print waste — Select this check box to include the production waste in the operations slip. If you
also select the Compress items check box, the production waste will be summarized based
on the waste item code.
- Print: Instructions — Select this check box to print the operation instructions together with
the operation slip. You can define the operation instructions when setting up the operation item at
Manufacturing = Setup = Operations.
8. Click Print to preview or print the operation slip.

A .
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5.6 Issuing Production Orders

Before work can commence on the production orders, you need to issue the required items in the production
order BOM to the production floor. The issuance of production materials involves the withdrawal of goods
from the warehouse to be delivered to the production shop floor so that the actual work can be carried out.
Materials, which may consist of raw materials and subassembly items, are issued to the production shop floor
to be converted into the finished product. Besides standard items, the item BOM may also include items, such
as labor hour and machine hour.

Exact Globe Next provides the option of generating a picking list which is useful for retrieving the standard
items (materials and subassembly items) that are issued from their respective locations in the warehouses. A
picking list contains information on the items that need to be issued, the quantity required for each item, and
the order in which it is most convenient to collect all the items from their locations in the warehouses.

Issuing of production order in Exact Globe Next can be done using either of the following methods:

- Issuing production orders without using the backflush function
- Issuing production orders using the backflush function

5.6.1 Issuing production orders without backflush

The following procedure shows you how to manually issue the items for a production order.

& 932 Production - Exact — o1 x|
File Edit Vview Help
g|==|BE|lud 8 e
Person Richard Peters
Fulfillment date 238/3/2012
Entry number 12910005
IOperat\on Item IDeacnption ‘Warehouse | Location | Stockl Free stockl Plannedl Realized| To be realizedl Actualslﬂ
1 10 - DFOPOO1  KOEODODD2 R.P. Grand Café 120 st. 1 ADL -0.5 1.5 3 0 3 o
2 10 - DFOPO01  SERO003  R.P. Kop en schotel koffie 11 ADL o o 6 0 6 o
3 10 - DFOPOO1  THEOO11 R.P. Thee Assorti 12x20x2 1 ADL o o 3] o 3] [}
4 10 - DFOPOO1  VEROOOZ2  Folie 1 ADL 4 4 12 0 12 4
£ -
4| »
Warehouse 1 - Centraal magazijn Total quantity 4
Item R.P. Grand Café 120 st.
"o E-
Set to zero Picking list Fulfillment Cancel

To issue production orders:
1. Go to Manufacturing - Entries - Issue.

2. Select Production order in the Selection section.

3. Click Advanced to display more criteria.

4. To issue materials for a particular production order, type or select the production order code at
Production order.

S. AtOrder type, select Production order.

6. To issue materials for a particular finished product, type or select the item code at Make item.

7. AtTransaction date, type or select the transaction date of the issuance. The transaction date will indicate
the date the materials and subassembly items are issued.

8. AtFulfillment date, type or select a fulfillment date to display the production orders with fulfillment on
or before the selected date.




9. Define other criteria, and then click Refresh.

10. Select the production order you want to issue materials for, and then click Fulfillment. The Production
screen will be displayed.

11. Inthe Production screen, type or select a warehouse location by clicking F2 under the Location column
to choose the location you want to issue the materials from. The Location column is available only if the
Warehouse locations check box is selected in the Fulfillment section at System - General > Settings,
under Inventory settings.

12. Type the quantity to be issued in the Actuals column. By default, the planned quantity defined in the
BOM for the end product is entered.

13. Type or selecta serial or batch number for the materials in the Serial/batch column. If applicable, type or
select a lot number for the serial or batch numbers of the materials in the Lot column. The Serial/batch
and Lot columns are available only when the item is a serial or batch item.

14. Click Picking list to printa copy of the picking list for the standard items to be issued for the production
orders, if required.

15. Click Fulfillment to start processing the issuance of materials. The Print screen will be displayed.

16. Click Start to print the delivery note for the issuance of items. Click Skip to process the issuance of
materials without printing the delivery note. Click Close to exit without processing the issuance of
materials or printing the delivery note.

17. Click Close to exit.

5.6.2 Issuing production orders with backflush

The following procedure shows you how to use the backflush function to issue the items for a production
order. The backflush option serves to shorten the process of issuing materials and all the materials will be
automatically issued upon receiving the end product. The stock movement and costs will be registered in
the same way as in the process of issuing materials without using backflush. The backflush function is useful
in manufacturing environments where the manufacturing lead time is short, the production volume is
large and the BOM and production process are relatively simple and straightforward. In such manufacturing
environments, the manual issuance of materials may not be required due to lack of resources.

You can activate the backflush function using a number of methods. If there is more than one method used, the

order of precedence for the backflush methods are listed as follows:

- Backflush options in the production orders. Select the check box in the Backflush column in the
production order.

—  Backflush options in the BOM maintenance. Select the check box in the Backflush column under the
BOM tab.

- Backflush options in the manufacturing settings. Select the Items, Labour hours, and/or Machine
hours check boxes in the Backflush section at System - General > Settings, under Manufacturing
settings.

When you have received your production orders, the materials, labor hours, and machine hours which are
selected to be issued using the backflush function will be automatically issued. For more information about
receiving production orders, see 5.7 Receiving Production Orders. Items that are not selected to be issued using
the backflush function must be issued before the production is completed. Otherwise, the stock position

and production costs will not be registered in the inventory management and the general ledger. For more
information about completing production orders, see 5.9 Completing Production Orders.
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5.7 Receiving Production Orders

When the end products are ready, you can receive the end products as requested by the production orders in
the warehouse.

i Manufacturing / Entries / Receipts production

@ Search ] [ / Clear ] Ul 5 |Numberofrows
Filter + starts with " contains
‘Warehouse --All-- |=
Start date [ =| to ‘ = oA
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PROD00010012.002 Voorraad productie PROD0O0010012 MCB0004 1
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-
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Print labels Note Al MRP Project Scrap Receipts Open Mew MNew returns Close

To receive production orders:

1. Go to Manufacturing - Entries - Receipts production.

2. At Warehouse, select the warehouse that is expecting to receive the end products for the production
order. By default, all warehouses are selected.

3. Select Production order at Order type.

Type or select the transaction date for the receiving transaction at Transaction date.

S. Define other relevant criteria to search for the production orders you want to receive, and then click
Search.

6. Select the production order you want to receive, and then click Receipts.

7. Inthe Receipt screen, type or selecta location you want to receive the production order under the
Location column. By default, the location code defined in the production order is filled in. The Location
column is available only if the Warehouse locations check box is selected in the Fulfillment section at
System > General - Settings, under Inventory settings.

8. Under the Actuals column, type the quantity of the end products you are receiving into the warehouse.
By default, the quantity requested in the production order is entered.

9. Type or select a serial or batch number for the end product under the Serial/batch numbers column. If
applicable, type or select a lot number for the serial or batch numbers of the end products under the Lot
column. The Serial/batch numbers and Lot columns are available only when the item is a serial or batch
item.

10. Click Process to start processing the receipt of the production order.

11. Inthe Print screen, click Start to print the delivery note for the receipt of the production order end
product. Click Skip to process the receipt of the finished product without printing the delivery note. Click
Close to exit without processing the receipt of the finished product or printing the delivery note.

12. Inthe Complete screen, select the options to complete the production order, and then click OK.
Otherwise, click Cancel to receive the end product without completing the production order. The
following options are available:

ha




- Suggest: Returns — Select this check box to return excess standard items that have been issued but
notused to in the production order.
- Complete: Suborder — Select this check box to complete the suborders (if any) that belong to the
production order, in addition to completing the production order.
- Print report — Select this check box to print a report of the completed production order.

13. Once the receipt process has been completed, it will exit automatically.

5.8  Setting Production Orders to the Finished Status

Once end products have been received, production orders can be set to the Finished status to indicate that
they have been completed from a logistical viewpoint. This is available only if you have selected the Use finish
check box in the Production order status section at System > General > Settings, under Manufacturing
settings.

Once a production order is in the Finished status, you will not be able to modify the header and material lines
or perform any other actions for the order, such as fulfill order, issue order, order receipt, and realize labor
hours. However, in cases where modifications are required, there are ways to reverse the action.

kR Manufacturing / Entries / Finish
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To set production orders to the Finished status:

1.  Goto Manufacturing> Entries - Finish.

2. Type orselecta start date or a range of start dates at Start date to search for the production orders with
the defined start dates.

3. AtOrder type, select Production order.

4. AtShow, select Parent project to display only the orders linked to the parent project, or All to display
the orders for both parent and child.

S. Click Search.

6. Select one production order or more, and then click Finish. The Finish screen will be displayed with the
following options:
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- Suggest: Returns — Select this check box to return the excess materials that were issued for the
order.

- Finish: Suborder — Select this check box to set the suborders of the selected order to the Finished
status simultaneously.

- Complete: PO lines — Select this check box to check the item lines of all purchase orders. These
are item lines linked to the project code. The production order can be completed as long as all items
linked to the project code have been received, even if item lines that are not linked to the project
code have not been received. If the check box is not selected, the checking is done on the header
lines of all purchase orders. These are header lines linked to the project code. The production order
can be completed only if all purchase orders linked to the project code have been received.

7. Click OK. If there are operations in the production order(s) that have not been completed, a message will
be displayed to confirm if you want to set the production order(s) to the Finished status. Click Yes.

To reverse the action of setting production orders to the Finished status:
1.  Go to Manufacturing - Entries - Finish.

2. Select the Show: Finished check box, and then click Search.

3. Select the required production orders, and then click Finish.

Note:  When the reversal of action occurs:
— the status of the production order will be changed from Finished to Printed,
- the status of the project linked to the production order will be set to Active,
and
- the outstanding production order lines will be enabled for editing.




5.9 Completing Production Orders

Productions orders are processed for completion when the production orders have been fulfilled and no further
transactions or changes are expected for the production orders. Completion of production orders can be
executed for the whole production order or per operation line.

Exact Globe Next gives you several options during the process of completing the production orders. For

example, you can choose whether to return the excess materials that were issued for the production:

-  Ifyouare using the operations feature in your manufacturing process, you need to complete the operations
for the production orders at Manufacturing - Entries = Operations control, before you can complete the
production orders.

- You can complete single and multiple production orders even when the receipts, returns, and scraps of
make items are in closed periods if the following conditions are met:

- Stock valuation method at Valuation method in the Entry section under Inventory settings is
set to Average purchase price or Real time APP.

- The Valuation method per item setting in the Entry section under Inventory settings is
enabled, the valuation method of make items at Valuation method is set to Average purchase
price.

- The Receipts: Recalculate APP check box in the Recalculate APP section under Manufacturing
settings is selected. For more information, see 1.1 Manufacturing Settings and 1.14 Inventory
Settings.

Correction entries will be generated in the current period whenever you complete production orders with

receipts, returns, and scraps of make items in closed periods, but only if the following conditions are met:

—  The stock valuation method at Valuation method in the Entry section under Inventory settings is set
to Average purchase price or Real time APP.

—  TheReceipts: Recalculate APP check box in the Recalculate APP section under Manufacturing
settings is selected.

—  Thereisa difference between the calculated APP amount and the value of receipt.

] Manufacturing / To be processed / Complete

[Lgearch ] [ & Clear ] [ & Previous ] [ 7 Next I [|| 5 |Numberafmws

Filter {= starts with ¢~ contains

Warehouse | --All-- |v |

Start date | = to | =
End date | = to | =
Production arder | @_| Parent project | @_|

Order type | Production order |v | Item | a|
Description | |

Show {~ Parent project = All Sales order | |3,|

[~ Show: Completed

:0000010012.004 orraad productie |P 00010012 |MCBOOO1 17/3/2011 011
PRODC00010012.003 Veoorraad productie PRODO0010012 MCBOO0Z2 20.00 17/3/2011 18/3/2011
PRODC00010012.002 Veorraad productie PRODO0010012 MCEBOOO4 20.00 17/3/2011 18/3/2011
PRODC00010012.001 Veoorraad productie PRODO0010012 MCEBOOO3 30.00 17/3/2011 18/3/2011
PROD0O0010010 Prod feb MCEBDEMOPAKKET 6.00 7/2/2011 8&/2/2011
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To complete production orders:

1. Go to Manufacturing = To be processed > Complete.

2. Type orselecta start date or a range of start dates at Start date to search for the production orders with the

start dates.

3. Type or select the production order code at Production order.

Select Production order at Order type.

S. Define other relevant criteria to search for the production orders that you want to complete, and then click
Search.

6. Select the production orders you want to complete, and then click Complete. You will see the Complete
screen with the following options:
- Suggest: Returns — Select this option to register production order returns.
- Complete: Suborder — Select this option to complete suborders (if any) for the production orders.
- Print report — Select this option to print a copy of the production order report.

7. Click OK to complete the selected production orders.

ha

5.10 Outsourcing Production Orders

There may be instances whereby you want to outsource the work to be done for the production orders.
Outsourcing is a process where you have a contract with external vendors to carry outall or only specific
operations in the production process. Production orders may be outsourced to reduce internal capacity
planning or address insufficient capacity and lack of production expertise in most companies.

When a company decides to outsource part of a manufacturing process to an external party, a purchase order
is raised to request for the services of the subcontractors. When the subcontractor receives the purchase order,
capacity planning is done to anticipate the machine and people required to produce the outsourced item. Raw
materials will be shipped to the subcontractor’s warehouse. When the process is finished, the semi-finished
goods will be delivered back to the manufacturer to be used in producing the finished goods.

5.10.1 Outsourcing without operations

Production orders can be outsourced when the following conditions are met:

—  Thelabor hour items are purchase items linked to at least one supplier (subcontractor). The Buy check
box (in the Attributes: Purchase section under the Purchase/ Sales tab in the item maintenance for the
labor hour item) is selected. The Buy check box is automatically selected and is available only when there is
atleast one supplier identified as the contract manufacturer.

— A purchase order is generated for the labor hour item. The Outsourced button is available only in the
production order when a processed purchase order is generated for the labor hour item.




To outsource labor hour items for production orders:

1.
2.

10.

11.

12.

13.

14.

15.

Go to Manufacturing - Entries = Production orders.

Click New. Fill in the information of the finished product that you want to manufacture in the
Production orders screen, and then click Authorised. For more information on creating production
orders, see 5.1 Creating Production Orders.

You can also outsource the subassembly items and operations for existing Authorised production orders.
In the overview of production orders, define the relevant criteria, and then click Search. Select the
Authorised production order you want to outsource, and then click Open.

In the BOM section under the BOM tab of the production order, fill in the labor hour item that you want
to outsource in the production order entry lines.

Select the labor hour item under the BOM tab, and then click Purchase. The Purchase button is available
only if the production order has been Authorised.

You will see the purchase advice (Generate purchase orders) screen. Check that the quantity under the
Advice column equals to the required quantity.

Click Purchase. You will see the purchase order screen. The labor hour item you want to outsource is
automatically displayed in the purchase order entry lines.

Approve and process the purchase order, and then click Close to save and exit the purchase order
automatically.

In the Production orders screen, click Outsourced. The Outsourced button is available only after a
processed purchase order has been generated for the outsourced labor hour item.

In the Outsourced screen, you will see a list of the labor hour items that are being outsourced for the
production order in the Labor section. In the Material section, you will see a list of materials that needs to
be issued to the subcontractor.

Select the Create: Transfer check box to create an interbranch transfer. The interbranch transfer is created
to transfer the materials needed to manufacture the semi-finished goods from your warehouse to the
subcontractor’s warehouse.

Note: Ifyou select the Create: Transfer check box, you need to first transfer the semi-finished
goods to the subcontractor’s warehouse. After the semi-finished goods are completed,
you need to receive the completed subassembly item from the subcontractor’s
warehouse into the receiving warehouse stated in the production order.

Otherwise, if you do not select this option, the receiving warehouse will be
automatically updated with the subcontractor’s warehouse (selected at Receiving
warehouse) in the BOM structure in the production order. This indicates that the
materials will be automatically issued directly from the subcontractor’s warehouse.

AtReceiving warehouse, type or select the subcontractor’s warehouse where the materials for the
outsourced item will be issued to. If you specify the subcontractors’ warehouse, then this warehouse will
be updated in the Warehouse column in the production order lines. This is to enable materials to be
issued to the supplier warehouse.

AtReceiving location, type or select the location in the receiving warehouse where the materials will be
issued to.

At Transaction date, type or select the date the semi-finished goods will be transferred from the
subcontractor’s warehouse to your warehouse.

Click Close to save and exit.
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5.10.2 Outsourcing with operations

When the Operations check box is selected in the Operations section at System - General - Settings, under
Manufacturing settings, you can outsource individual operations by:

- selectinga finished product with an outsourced operation at Manufacturing - Setup > BOM

- selecting an outsourced operation that is maintained at Manufacturing - Setup - Operations

- entering an outsourced item manually into the operation, or

- clicking Outsourced while selecting an operation at Manufacturing - Entries - Operations control.

The first two methods allow the user to set up the BOM with planned operations outsourcing. The last two
methods can be used for incidental operations outsourcing, such as when facing internal capacity shortage for a
particular operation. The outsourcing process can start only on outsourced operation type.

To outsource an operation of outsourced type:

1. Go to Manufacturing - Entries - Operations control.

2. Select Yes at Outsourced.

3. Click Refresh.

4. Selectan outsourced operation of an Authorised production order and click Purchase. The General
purchase orders screen will be displayed with the required quantity shown in the Advice column. You
cannot change the quantity.

S. Click Purchase to open the Purchase order screen with the outsourced item automatically inserted in
the order entry lines.

6. Click Authorised and Processed at the purchase order process flow section, and then click Close.

7. Inthe Production order screen, click Outsourced to display the Outsourced screen. The Operations
section lists the outsourced items of the production order, while the Material section lists the materials
that must be issued to the subcontractor.

8. Select Create: Transfer to create an interbranch transfer to transfer the materials needed to manufacture
the semi-finished goods from your warehouse to the warehouse of the subcontractor.

Monitoring and controlling outsourced processes
You can monitor and control outsourced processes at Manufacturing - Entries - Operations control.
Several columns useful for monitoring outsourced processes can be added to the list of operations.

Outsourced column
This column displays a green check mark to indicate that the operation is an outsourced operation.

Outsourced: PO column
This column displays the linked purchase order number for the outsourced item linked to the outsourced
operation.

Outsourced: PO status column
This column displays the status of the purchase order displayed under the Outsourced: PO column.

Outsourced: PO supplier column
This column displays the supplier for the purchase order displayed under the Outsourced: PO column.

Interbranch transfer column
This column displays the first interbranch transfer number generated for the linked operation.

Interbranch transfer: Status column
This column displays the status of the interbranch transfer displayed under the Interbranch transfer column.
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6. Management Information

In Exact Globe Next, there are reports available that make it easier to manage your production orders from the
point when these are released until completion. There are a number of reports that are already available in Exact
Globe Next, which gives you an overview of your production orders and the current statuses of the production
orders.

The reports available are useful for managing your work in progress, as well as to present an overview of the
production results. For example, you can use the reports to display the margin of revenue generated from the
production orders or the current statuses of your work in progress for your production orders. You may further
define the criteria available for the reports in order to further refine the information specific to you reporting
needs.

6.1  Profit Calculation Reports

The profit calculation report gives you an overview of the margin of revenue generated from the production
orders for the manufactured items.

B Manufacturing f Statistics / Profit calculation

Warehcluse‘ 1 - Centraal magazijn |v |

Date \ = tof

Items @| to|
Assortments...

ALG Algemeen - intern

BONODO1 R.P. Supremo beans
R.P. E =

BONDOO3 R.P. Espresso Mezzo

BONODO7 Bonen Brazilian Regular

BONDOO3 Bonen Brazilian Mild

BONO0O9 Bonen Brazilian Dark

BONDO10 Bonen Brazilian Extra Dark

CACDo02 cas

DIvoo0z Filters 85/245

FREBOOOZ R.P. Rood melange

FRBO0DD3 Celsus Max Havelaar fresh brew

INS Installatie

KM Kilometers

KOEOO0D1 R.P. Café Royale 120 st.

KOEDDDZ R.P. Grand Café 120 st.

KOEODD3 R.P. Stroopwafeltje 120 st.

4

Revenue 462,635.45 EUR Cost price 266,720.300 EUR Purchase price 266,531.636 EUR Margin 195,915.15

< | i

s | s |

To generate profit calculation reports:

1. Go to Manufacturing - Statistics = Profit calculation.

2. Selecta warehouse at Warehouse to display the profit calculation earned for the relevant manufactured
items. By default, all warehouses are selected.

3. Type or selecta date or a range of dates at Date to display the profit calculation of the relevant
manufactured items.

4.  After defining other criteria to display the profit calculation of the relevant items, click Refresh.




6.2  Production Order Status Reports

The production order status report allows you to get an overview of the production orders grouped into the
various production order statuses. With this report, you can have an overview of the status of the production
orders and production statistics that compares planned work in progress with the data of actual production
results. You can obtain key data for the production orders, such as production order status, planned quantity,
actual quantity and the difference between planned and actual quantities.

i Manufacturing / Statistics / Production orders

G 1
Warehouse | @_| I:o| @_| v Al
End date | E| m| g| 7 Al
Order type | All | - |
Show I~ open I~ Authorised [~ Rejected [~ Released I~ Printed [~ Finished [~ Completed
Display
Precision
Ad -
Farent project | @_l |
Production order| @_l | v All
Start date | E| to| E| 7 Al
Item
Item group | @_| I:o| @_| v All
Ttem | B G| = an
Item status [V Active [~ Blocked [~ Discontinued [T Inactive ™ Future
i | s | ite |
—— -1 -1 |

To generate production order statuses reports:

1. Go to Manufacturing - Statistics > Production orders.

2. Click Advanced to see more criteria.

3. Inthe General section, select All or Production order at Order type.

4. Select one check box or more at Show to view the report of the production order with the selected

statuses.
S. After defining other criteria to display the relevant production orders, click Display.
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6.3  Production Waste Reports

Waste is the issuance of excess materials to the production order, compared to the quantities specified in the
BOM. The BOM allows specifying a “Waste %”, which is called planned waste. Planned waste is present in
the production issue screen. It may also happen that the quantity of excess materials is only determined when
entering the production issue, which is called unplanned waste. You can generate the overview of production
waste for the required production orders.

B Manufacturing / Statistics / Waste

|Warehouse || @_| I:n| @| v all

Parent project | @_l |

Production order | @_l |

Show [T Open [~ Authorised [~ Released [~ Printed [ Finished [~ Completed
Display

Precision
Ad ed

Start date | = = P Al
Item

Ttern group | @_| I:n| @| W all

Item | @] tof A & oan

Itemn status ¥ Active [~ Blocked [~ Discontinued [ Inactive [~ Future

R

To generate production order waste reports:

1. Go to Manufacturing - Statistics > Waste.

2. Click Advanced to see more criteria.

3. Inthe Advanced section at Start date, type or select a range of start dates to display the waste as a result
of the production orders that start on or after the date(s).

4. Inthe Item section at Item group, type or select an item group or a range of item groups to display the
waste as a result of manufacturing the items for the relevant production orders.

5. After defining other criteria to display the waste as a result of the relevant production orders, click
Display.




6.4  ABC Analysis Reports

The ABC analysis report provides an overview of the distribution of production order. The analysis is based
on the 80/20 rule, whereby 80% of the revenue is generated by 20% of the items. Depending on the selection
criteria, the ABC analysis will show which items generate the highest revenue or which debtors are your best
customers.

#9 Manufacturing / Statistics / ABC analysis

Show ¢ Deors

Range
Warehnuse| @_| [ Al
Date | E| I:o| E| W Al

» Item | @_| [ all

Item group | @_| hn| @| W All
N T
S

Options

Sort by {+ Revenue {~ Quantities

ABC analysis
A %
B %
& E %

s g

To generate ABC analysis reports:

1. Go to Manufacturing - Statistics > ABC analysis.

2. Selectan option at Show to display the ABC analysis for manufactured items (Items) or debtors
(Debtors) of the production orders. Depending on the selection, different criteria are available.

3. Ifyouchoose Items at Show, you can select an option at Sort by to determine whether you want to sort
the information in the report by revenue (Revenue) or quantities (Quantities).

4. Type the percentage at A, B, and C in the ABC analysis section. A, B, and C refer to the three groups of
items or debtors that can be used to generate the ABC analysis overview. By default, the 20/80 rule is
applied. A refers to the group of items/debtors that generate the highest revenue or items/debtors that
generate the highest production volume, while B and C are items/debtors that make up the rest of the
total revenue or quantities sold. The total of A, B, and C cannot be more than 100.

S.  After defining other criteria to display the ABC analysis for the relevant production orders, click Start.
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6.5 Project Overview Reports

The project overview report provides you with a view of the current statuses of the production order projects.

B Manufacturing / Reports / Projects x
G I

|Warehnuse | @| I:n| @_| v Al

End date | E| m| E| 7 Al

Order type | All | - |
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Itemn status ¥ Active [ Blocked [~ Discontinued [~ Inactive [~ Future
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To generate project overview:

1. Go to Manufacturing - Reports = Projects.

2. Select one or more production order statuses at Show in the General section to display the project
overview for production orders with the selected statuses.

3. Click Advanced to see more criteria. After defining other criteria to display the project overview for the
relevant production orders, click Display.




6.6 Workin Progress (WIP)

The work in progress report allows you to monitor the statuses for production orders that are currently in
progress, plan your production shop floor activities, and take remedial action on any production order changes.

E‘ Manufacturing / Reports / Production orders x

G I
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Lines
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End date \ A to] = P oAl
Operation ‘ @‘ In| @‘ ¥ &l
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Type ¥ Standard ¥ Labour hour ¥ Machine hour I Phantom ¥ Bulk issue
Planner @l | W Al

_!’I ) 3

To generate work in progress reports:

1. Go to Manufacturing - Reports = Production orders.

2. Select one warehouse or more by clicking Warehouses in the General section to display the production
orders that will be received by the selected warehouses. By default, all warehouses are selected. In the
Warehouses screen, click Deselect all, and then click the relevant warehouses in the Select column.
Click Close to exit.

3. Select one check box or more at Status to display the production orders with the selected statuses.

4. AtStart date and to, type or select a start date or a range of start dates to display the production orders
that start on or after the start date(s).

S. Select All or Production order at Order type.

6. You can also define other criteria to display the work-in-progress for the relevant production orders. Click
Advanced to see more criteria.

7. Click Display.
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6.7 Actual Usage and Costs

The actuals report allows you to get an overview of to analyze the production costs and revenue associated with
the production order results. With this report you can study the actual usage and compare that with the cost

of materials for the production orders. In addition to the planned and actual production order costs, the report
also details the information of budgeted and actual costs for labor, machines, and materials for the respective
production orders. You can also use this report to compare the planned revenue with the actual revenue.

EB Manufacturing / Reports / Actuals
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To generate actual usage and costs reports:

1. Go to Manufacturing - Reports > Actuals.

2. Select one or more warehouses by clicking Warehouses in the General section to display the production
orders that will be received by the selected warehouses. By default, all warehouses are selected. In the
Warehouses screen, click Deselect all, and then click the relevant warehouses in the Select column.
Click Close to exit.

3. Select one or more production order statuses at Status to display the production orders with the selected
statuses.

4. Type orselectastart date or a range of start dates at Start date to display the production orders that start
on or after the start date(s).

5. Select All or Production order at Order type.

6. Click Advanced to see more criteria. After defining other criteria to display the actual production results
for the related production orders, click Display.
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